Batch Builder 2 User Guide

This Guide describes how to create and process objects for the New DRS (DRS 2) using Batch Builder 2 - a Java desktop application that creates a DRS 2 batch deposit.

The objects belonging to the following DRS 2 Content Models are supported by this version of Batch Builder 2:

- AUDIO
- COLOR PROFILE
- DOCUMENT
- OPAQUE
- OPAQUE CONTAINER
- PDS DOCUMENT
- STILL IMAGE
- TARGET
- TEXT

This software is intended for use with the New DRS (DRS 2). DRS 1 batches cannot be created using this software.

Need help? To report a problem or ask a question about Batch Builder 2, please contact the LTS Support team: http://nrs.harvard.edu/urn-3:HUL.OIS:drshelp.

If you are reporting a problem, please provide a detailed description of the problem and a copy of the Batch Builder error or warning messages.

Batch Builder is developed and supported by HUIT Library Technology Services (LTS).
Batch Builder 2 User Guide ..................................................................................1
1. Setting Up Batch Builder ...................................................................................5
  1.1 Installing Batch Builder .................................................................................. 5
  1.2 Setting options .................................................................................................. 6
2. User Interface Basics .......................................................................................11
  2.1 BB panels ......................................................................................................... 11
  2.2 BB menus .......................................................................................................... 12
3. Naming Rules for Objects, Files and Directories ..........................................17
4. Object and Batch Directories Structure and Contents ......................................20
5. Creating Still Image Object Batches ...................................................................21
  5.1 Accepted formats ............................................................................................... 21
  5.2 Manually create still image objects from template ............................................. 21
  5.3 Automatically build still image objects from template ......................................... 26
  5.4 Processing images for SHARED SHELF ............................................................ 30
6. Creating PDS Document Object Batches ...........................................................34
  6.1 Accepted formats ............................................................................................... 34
  6.2 File name rules ................................................................................................ 34
  6.3 Procedures to create a batch .............................................................................. 35
7. Creating Opaque Object Batches ......................................................................57
  7.1 Accepted formats ............................................................................................... 57
  7.2 File and directory structure ............................................................................. 57
  7.3 Content files ..................................................................................................... 58
  7.4 DRS documentation files ............................................................................... 59
  7.5 Procedures to create a batch .............................................................................. 59
8. Creating Opaque Container Object Batches ......................................................67
  8.1 Accepted formats ............................................................................................... 67
  8.2 File and directory structure ............................................................................. 67
  8.3 Content files ..................................................................................................... 68
  8.4 DRS documentation files ............................................................................... 69
  8.5 Procedures to create a batch .............................................................................. 69
9. Creating Document (PDF) Object Batches .......................................................76
  9.1 Accepted formats ............................................................................................... 76
  9.2 Manually create document objects from template ............................................. 76
  9.3 Automatically create document objects from template ..................................... 79
  9.4 Depositing a thesis object ............................................................................... 83
10. Creating Text Object Batches .........................................................................87
  10.1 Accepted formats ............................................................................................. 87
  10.2 Manually create text objects from template .................................................... 87
  10.3 Automatically build text objects from template ............................................... 90
10.4 Create and deposit audio playlists as text objects ............................................. 93

11. Creating Color Profile Object Batches ................................................................. 98
   11.1 Accepted formats ........................................................................................... 98
   11.2 Manually create color profile objects from template ..................................... 98
   11.3 Automatically build color profile objects from template .............................. 100

12. Creating Target Object Batches ........................................................................ 105
   12.1 Accepted formats .......................................................................................... 105
   12.2 Manually create target image objects from template .................................... 105
   12.3 Automatically build still image objects from template .................................. 110

13. Creating Audio Object Batches ........................................................................ 115
   13.1 Accepted formats .......................................................................................... 115
   13.2 Manually create audio objects from template .............................................. 115
   13.3 Automatically build audio objects from template ........................................ 119
   13.4 Build an advanced audio batch (command line) ......................................... 124

14. Creating Batches Using Command Line Interface .......................................... 137
   14.1 Basic command line syntax ......................................................................... 137
   14.2 Switches ....................................................................................................... 137
   14.3 Deposit settings properties (batch properties) .............................................. 139
   14.4 Object properties .......................................................................................... 139
   14.5 Directory (file) properties ............................................................................ 147

15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs ................................................................. 150
   15.1 Using mapping.txt file .................................................................................. 150
   15.2 Using object_mapping.txt file ....................................................................... 153

16. Working with URNs .......................................................................................... 155
   16.1 Assigning File URN Resource Name Patterns ............................................. 156
   16.2 Using URNs .................................................................................................. 156

17. Adding Relationships ....................................................................................... 158
   17.1 Still image object relationships ................................................................. 158
   17.2 PDS document object relationships ......................................................... 159
   17.3 Opaque object relationships ....................................................................... 160
   17.4 Opaque Container object relationships ..................................................... 161
   17.5 Document (PDF) object relationships ....................................................... 162
   17.6 Text object relationships ............................................................................. 163
   17.7 Color Profile object relationships .............................................................. 163
   17.8 Target object relationships ........................................................................ 164
   17.9 Audio object relationships ......................................................................... 165

18. Adding Descriptive Metadata ........................................................................ 167
   18.1 Importing an Aleph record ......................................................................... 167
   18.2 Entering descriptive metadata in the BB GUI ............................................ 168
   18.3 Importing descriptive metadata from a MODS file .................................... 168
19. Adding Supporting Content

19.1 Depositing supporting content into the DRS before regular content

19.2 Depositing supporting content into the DRS together with regular content

19.3 Depositing supporting content to DRS after regular content

19.4 Valid content models and roles for rights objects

20. Uploading Batches to DRS

21. Deleting Batches from DRS

22. Interpreting Load Reports

22.1 Successful load reports

22.2 Failure load reports

23. Viewing Your Deposited Objects

24. DRS2 Metadata Reference
1. Setting Up Batch Builder

1.1 Installing Batch Builder

Batch Builder (BB) is a Java-based application compatible with Windows, Mac and Linux operating systems.

The Batch Builder application package includes a Graphical User Interface (GUI) and a separate Command Line Interface (CLI) for automated deposit workflows. The application package is bundled as a zip file, which must be downloaded, unzipped, and installed on your computer. The Batch Builder 2 zip file can be downloaded from: http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip

Recommended System Requirements

- Operating System: Windows XP/Vista/7, Mac OS X 10.5.8 or higher, Linux.
- Processing Power: Intel Core 2/i3/i5/i7; AMD Athlon II/Phenom II
- Physical Memory: 3 GB RAM or higher (requires 64-bit Operating system).
- Java version 1.7.x.
  - Note that Batch Builder is not yet compatible with Java 1.8.

Installation

1. Download the zip file from here:
   http://hul.harvard.edu/ois/systems/drs/BatchBuilder-2-current.zip
2. When prompted, save the BB zip archive to your computer (e.g. a download directory or your desktop)
3. Unzip the archive and extract the files to a directory of your choice (e.g. Program Files or Applications). The installer will create a “batchbuilder-2.x” directory and copy the files to it.
4. To start the GUI, double click the launch (executable) file (look for the BB icon in the batchbuilder-2.x directory). A message “Open File – Security Warning” may appear. If so, click on “Run” to continue.

Note for PC users: on most Harvard PC computers there is a security software called Parity which blocks “unapproved” applications from running. Some users’ configurations allow them to “unblock” the application and allow it to run. Other configurations don’t allow the “unblock” feature. If you see a Parity prompt when trying to run Batch Builder and Parity won’t allow you to unblock Batch Builder, call your HUIT field support and ask them to unblock it for you.

Note for Mac users: on the Mac, the first time you run Batch Builder you will need to press and hold the Control key, and then click the Batch Builder icon. Then click on Open from the shortcut menu. This will save the application as an exception to Mac security settings (which by default only allow...
registered apps from Mac app store to run). Next time you need to run Batch Builder, simply double click on the Batch Builder icon.

If you can’t start BB using the executable, try the following alternative:

- **On Windows:** double click on the file `batchbuildergui.bat`. A command prompt window will open and then BB Graphical User Interface will start up.

- **On Mac or Linux:** open terminal, change directory to the BB home directory and type: `sh batchbuildergui.sh` and then press `Enter`. BB Graphical User Interface will start up.

5. To start the Command Line Interface (CLI):

- **On Windows:** run the command prompt (CMD), change directory to the BB home directory, type `batchbuildercli` with required parameters and press `Enter`. See section 11.00 for examples of required parameters.

- **On Mac or Linux:** run the Terminal, change directory to the BB home directory and type: `sh batchbuildercli.sh` with required parameters and press `Enter`.

### 1.2 Setting options

**1.2.1 General Batch Builder application options**

There are a few Batch Builder features that are controlled by using **View > Options** on the file menu. These options will affect all projects.

![Batch Builder Default Options](image)

**Batch Builder Default Options**
• **Auto-increment new batch directory names.** (Unselected by default.) When selected, if you create a batch directory name that ends with a number, the next time you click Batch->New … Batch Builder will use the same directory name but will increment the number to the next value.

• **Ignore file validation errors.** (Selected by default.) When selected, this option forces Batch Builder to create a batch even when the FITS tool has detected errors in one or more files in the batch.

  Note: this option must be selected when generating PDF Document objects as well as Opaque objects.

• **Open last project on application startup.** (Unselected by default.) When selected, on Batch Builder startup the most recently used project will open automatically.

• **Verbose logging.** (Selected by default.) This option is exposed specifically for testing purposes. Leave it checked during this testing phase so that LTS staff can troubleshoot Batch Builder processing errors.

• **Delete object and directory contents when removing.** (Unselected by default). If this option is checked, the object and directory contents are removed from disk when removed from within BB. This applies to Template directories as well. When this option is not selected, directories will remain on your local computer, but will disappear from the BB project window.

• **Copy files when dragging and dropping onto project tree.** (Selected by default). Batch Builder 2 introduces drag-and-drop functionality for files. If this option is checked, when files are dragged and dropped from a directory on disk onto a file directory in the BB Project Panel the files are copied rather than moved.

1.2.2 File name pattern options for generating file OSNs

Batch Builder allows users to set file name pattern options to be used when either automatically building objects from template or creating objects manually. Note that this option should not be used in conjunction with using external mapping files to supply file OSNs (an alternate method of supplying file OSNs). The following file name patterns can be set, and these will persist for each Batch Builder project.
Derive File OSN from File Name (set by default) – this option, when set, results in Batch Builder using file name for the file owner supplied name according to one of the options checked below:

- Use full file name (minus the extension) as file OSN – results in full file name being used as OSN.
  - For all objects, except PDS Document objects this accomplishes the following:
    - When building objects automatically – this option captures the full file name, including the object name prefix, as file OSN. (e.g.: obj1- -file1.jpg will result in file OSN “obj1- -file1”.)
    - When building objects manually - this option captures the full supplied file name as file OSN. (e.g.: file1.jpg will result in file OSN “file1”.)
  - For PDS Document objects using the file name used as OSN option, this accomplishes the following:
    - When building objects automatically – this option captures the full file name, including the object name prefix and the page sequence number, as file OSN. (e.g.: obj1- -file1__seq1.jpg will result in file OSN obj1- -file1__seq1.)
    - When building objects manually - this option, when set, captures the full file name, including the page sequence number, as file OSN. (e.g: file1__seq1.jpg will result in file OSN file1__seq1.)

- Use baseName as file OSN – this option results in Batch Builder using file base name, excluding the object name prefix, as the file OSN. Don’t use this option for PDS Objects if the file basename is the same for all the files and only the sequence number is different.
  - For all objects, except PDS Document objects, this accomplishes the following:
    - When building objects automatically – this option captures the file base name, discarding the object name prefix, as file OSN. (e.g.: obj1- -file1.jpg will result in file OSN “file1”. )
When building objects manually this option captures the file base name as file OSN. (e.g: file1.jpg will results in file OSN “file1”.)

- For PDS Document objects
  - Do not use.

- Use baseName—pageSeq as file OSN – this option results in Batch Builder using file base name and page sequence suffix – if present, but excluding the object name prefix, as the file OSN
  - For all objects, except PDS Document objects, this accomplishes the following:
    - When building objects automatically – this option captures the file base name, discarding the object name prefix, as file OSN. (e.g.: obj1-file1.jpg will result in file OSN “file1”.)
    - When building objects manually - this option captures the file base name as file OSN. (e.g: file1.jpg will result in file OSN “file1”.)
  - For PDS Document objects
    - When building objects automatically – this option captures the file base name and page sequence number as file OSN, discarding the object name prefix. (e.g.: obj1-file1_seq1.jpg will result in file OSN “file1_seq1”.)
    - When building objects manually this option captures the file base name and the page sequence number as file OSN. (e.g.: file1_seq1.jpg will result in file OSN “file1_seq1”.)

- Use only pageSeq as file OSN – this option only applies to PDS Document Objects
  - When building objects automatically – this option captures the page sequence number as file OSN, discarding the object name prefix and the file name. (e.g.: obj1-file1_seq1.jpg will result in file OSN “seq1”.)
  - When building objects manually this option captures the page sequence number as file OSN. (e.g: file1_seq1.jpg will result in file OSN “seq1”.)

1.2.3 Setting options for processing large batches

When processing large batches – either from large file sizes or the sheer number if files – you may get “out of memory errors”. The threshold is around 30GB. If you do get memory errors, you will need to make adjustments to BB configuration files to assign more memory to Java.

Note for Windows users: If you find that you need more than 3GB of RAM to run Batch Builder, you will also need to use a 64-bit version of Windows.

Assigning more memory to Java

1. In the main BB program directory use a text editor to open batchbuildergui.bat (Windows) or batchbuildergui.sh (Mac)
2. Find line starting with ‘java –cp’
3. In that line, find the section ‘-Xmx1024m’ and do one of the following:
   - To assign 2GB of RAM, change it to ‘-Xmx2048m’
   - To assign 3GB of RAM, change it to ‘-Xmx3072m’
   - To assign 4GB of RAM, change it to ‘-Xmx4096m’
4. Save the file
Use the smallest amount of RAM to get rid of the error to avoid performance problems with your local computer.

When you need to process a large batch, start Batch Builder using the batchbuildergui.bat or batchbuildergui.sh instead of the executable file.
2. User Interface Basics

2.1 BB panels

The Batch Builder interface includes a menu bar, a tool bar, and three display panels. Context menus are also available by right-clicking on certain places within the GUI.

2.1 BB panels

In the following screen-shot of the interface, these components are labeled.

The following image shows more details about the project panel.
2.2 BB menus

There are two sets of menus in BB:

- Menus accessible from the menu toolbar at the top
- Context menus accessible by right-clicking a particular item in the Project Panel on the left.

Menu toolbar

There are five menus that are accessible from the menu toolbar

**Project menu**

<table>
<thead>
<tr>
<th>Project</th>
<th>Batch</th>
<th>Object</th>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save as</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **New** – create new project.
- **Open** – open existing project.
- **Close** – close currently open project.
• **Save** – save currently open project.

• **Save as …** -- save currently open project as a new project. This option saves the project configuration file “project.conf” (which contains all the project metadata settings entered in the Deposit Settings and Object Template) into a new directory. This is a useful option to use if you are planning to create a new project but the Deposit Settings information or/and Object Template information is going to be the same.

• **Exit** – exit the program.

**Batch menu**

- **New** – create a new object batch.
- **Create descriptors & batch.xml** – process a selected batch (note that a batch icon for a given batch needs to be selected in the Project Panel for this command to become active).
- **Stop creation of batch.xml** – stops the creation of batch that is being currently processed (this command is only active while a batch is being processed).

**Object menu**

- **New** – create new object (this command is only active if you first select a batch icon of a given batch in which object needs to be created in the BB Project Panel).

- **Create batch with objects from template** – create a new batch of objects automatically from template. See the “Automatically build [object type] from template” section for a given object type in this Guide for procedure (E.g.: 5.2 Automatically build still image objects from template).

**View menu**

- Options
- Clear messages
- Reload tree
- Toolbar

Revised: April 14, 2015
• **Options** – view the options dialog. See [Section 1.2 Setting options](#) for more information.

• **Clear messages** – clears messages from the messages panel.

• **Reload tree** – reloads the Project Panel tree (useful when you want to see the latest changes made in the project panel).

• **Toolbar** – show / hide toolbar with action icons.

**Help menu**

<table>
<thead>
<tr>
<th>Project</th>
<th>Batch</th>
<th>Object</th>
<th>View</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>messages</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

• **About** -- information about Batch Builder version and build date.

• **Contents** – link to Batch Builder 2 User Guide.

**Context menus**

There are six types of context menus that are available in BB2 – all from the Project Panel:

1. Project context menu
2. Object template context menu
3. Object template directory context menu
4. Batch context menu
5. Object context menu
6. Object directory context menu

These context menus are described below in more detail.

**Project context menu**

Right-clicking on the project icon (P) will open a context menu that allows you to create a new batch.

**Object template context menu**

Right-clicking on the object template icon (T) will open a menu where you can add a new directory or automatically create a batch of objects from template.
Object template directory context menu

Right-clicking on the directory icon will open a context menu where you can add a new directory nested inside the present one or remove a directory.

Batch context menu

Clicking on the batch icon (B) opens a context menu where you can create a new object, process the batch and remove the batch.

Object context menu

Right-clicking on the object icon (O) will open a context menu where you can add new directory, rename an object, remove an object, and Set Aleph ID.
Note that the right way to rename an object after it was created in BB is to use this menu option. Renaming the object directory on disk outside BB is not sufficient and will lead to errors when trying to open the project in BB afterward.

**Object directory context menu**

Right-clicking on the directory icon will open a context menu where you can add a directory (nested inside the current directory) or remove the current directory.
3. Naming Rules for Objects, Files and Directories

File names on disk

Object and batch directory names on disk

File owner supplied names

Object owner supplied names

File names on disk

For all files in an object:

- Maximum number of characters per file name is 100. LTS recommends that file names be kept to 64 characters or less, and that the complete_directory_path + file_name for each file be kept to 255 characters or less.
- Valid characters in file name prefix are letters, digits, underscores ('_'), and hyphens ('-').
- File names should not contain spaces.
- Use a single '.' character to separate the file name prefix from the file extension. In the case of file compression formats used on archive file formats (e.g. TAR), the double extension format is acceptable. For example:
  - file.tar.gz
  - file.tar.Z
  - file.tar.bz2

Files that share a derivative relationship (e.g., a production master .tif file and its related deliverable .jpg or .jp2 file) should share the same file name in order for Batch Builder to determine that the relationship exists (e.g. clocktower.tif and clocktower.jpg). The file name of a digital file will be changed once the file is in DRS storage. At the point of deposit, DRS assigns each file a numeric DRS identifier. The file name will be the DRS ID followed by the format extension (e.g., 5844020.tif, 5844022.jpg). The original file name is preserved in DRS metadata. The DRS load report that is sent after a successful DRS deposit will associate the file’s DRS ID with the original file name (FILE-ORIGPATH). Also, if you use Batch Builder’s default method for assigning owner supplied name, the original file name (minus format extension) will be preserved in DRS metadata as the owner supplied name. In the case of PDS documents, the original filename will be the part of the owner supplied name before the double underscore (e.g. ‘doc1’ in the owner supplied name ‘doc1__seq1’)

Object and batch directory names on disk

1. Maximum directory name length is 100 characters.
2. No spaces are allowed in batch or object directory names
3. Valid directory name characters are letters, numbers, underscores ('_') and hyphens ('-').

* Note that Batch Builder does not validate these rules and will successfully process the batch with disallowed characters or spaces in batch directory or object directory names. The DRS batch loader is not validating the rules consistently. The DRS batch loader will silently fail (without sending an error report) when a batch with disallowed characters or spaces in batch directory name is dropped off to the DRS dropbox. The DRS loader will successfully load a batch where object directory names...
contain disallowed characters or spaces. These are known issues and they will be addressed in a later software release.

Please make sure to provide only allowed characters in batch directory and object directory names and keep the name length to no more than a 100 characters.

This is important because, when in the future the DRS needs to reconstruct the directory or file paths associated with a batch, it may fail if the directory names contain disallowed characters or exceed a 100 character limit.

File owner supplied names

File owner supplied name (file OSN) serves as an identifier that can be used to link files deposited into the DRS with local information about the files (such as local accession numbers or classification numbers).

An owner supplied name is generally optional for files and need not be unique, except in the case of:

- images linked to SHARED SHELF
- audio files, if a playlist is in use

Failure to supply a unique OSN in these cases will prevent access to these files.

There are three ways of supplying a file OSN:

1. Use file name for file OSN. When using this option, set the file name pattern preferences for generating file OSNs in Batch Builder Options menu. See Section 1.2.2 for more information.

2. Supply file OSNs using an external mapping file. To find out more about using mapping files see Section 15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs of this document.


Recommendations for file owner supplied names:

- Owner supplied names should not exceed 100 characters.
- Only alpha-numeric characters and these symbols should be used: periods (‘.’), underscores (‘_’), and hyphens (‘-’).

Object owner supplied names

Object owner supplied name (object OSN) serves as an identifier that can be used to link objects deposited into the DRS with local information about them (such as local accession numbers or classification numbers). Each object requires an owner supplied name.

Tip: Within an Owner Code, the object Owner Supplied Name must be unique.

There are four ways of supplying object OSNs:

1. Enter Object OSN manually when creating a new object in Batch Builder (Note that you have to create a batch first, before you can create a new object). For the procedure’ see a subsection “Manually create [content model] objects from template’” in a section on how to create object batches of a given content model in this Guide (e.g.: Section 5.2 “Manually create still image objects from template” in Section 5 “Creating and processing still image object batches.”).
2. Have BB create object OSNs for you when it is building object batches automatically from template. In this case you need to add object name prefix to file names (the syntax is: 1) for all objects except PDS Document Objects: [object_osn]--[filename].[extension]; 2) for PDS Document Objects: [object_osn]--[filename]_[pageSeq].[extension]) or supply mapping.txt file in order for BB to associate files with objects. For the procedure’ see a subsection “Automatically build [content model] objects from template” in a section on how to create object batches of a given content model in this Guide (e.g.: 5.2 “Automatically build still image objects from template” in Section 5 “Creating and processing still image object batches.”). See also Section 1.2.2 for additional information on setting file name patterns in the BB Options dialog.

3. Supply object OSN using Command Line Interface (CLI) during batch processing (Note that to use this option you need to have an existing object with an object OSN. The new object OSN supplied in CLI overwrites the object OSN that was given to the object at the time it was originally created.). For more details about CLI see Section 14 “Processing Batches Using Command Line Interface” in this Guide.

4. Supply object OSN using external mapping file during batch processing (Note that to use this option you need to have an existing object with an object OSN. The new object OSN supplied in the external mapping files overwrites the object OSN that was given to the object at the time it was originally created.). To find out more about using mapping files see Section 15 Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs of this document.

Recommendations for owner supplied names:

- The number of characters per owner supplied name should not exceed 100.
- Only alpha-numeric characters and these symbols should be used: periods (‘.’), underscores (‘_’), and hyphens (‘-’).
4. Object and Batch Directories Structure and Contents

**Object directory structure and contents**

An object directory structure is generated by Batch Builder when a new object is created. The object directory structure is dependent on the content model. For instance, a Still Image object directory structure may look like this:

![Object Directory Structure Diagram]

Nested directories indicate a derivative relationship where a file in the top directory serves as a source of the files in the subdirectories. Each object type has a set of required directory name prefixes (such as “image” for Still Image object type). Custom names can be appended to the required prefixes. Batch Builder automatically enforces object directory structure and required directory prefixes based on the content model selected.

After a batch is processed Batch Builder will place a descriptor.xml file at the top level of each object directory. No other files should be stored there.

**Batch directory structure and contents**

All objects within a batch must be located in a batch directory. The top level of this directory should contain only the batch control file (batch.xml) and object directories. No other file should be stored in the top-level batch directory.
5. Creating Still Image Object Batches

5.1 Accepted formats

5.2 Manually create still image objects from template

5.3 Automatically create still image objects from template

5.4 Processing images for SHARED SHELF

There are three methods you can use to create Still Image objects in Batch Builder:

1. Manually create objects from template. This is best for small batches (10 objects or less). In this scenario you generate an object structure in BB for each object and then copy files into it (can be done outside BB). See Section 5.2 for the procedure.

2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See Section 5.3 for the procedure.

3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. This method is useful when object properties such as Owner Code, Billing Code andURN authority path are different for each object. Because this option will be rarely used, it is not currently documented.

5.1 Accepted formats

Still Image objects can contain files in the following formats:

- JPEG 2000 JP2 image files (file extension: jp2)
- JPEG File Interchange Format image files (file extension: jpg)
- Graphic Interchange Format (GIF) image files (file extension: gif)
- Tagged Image File Format (TIFF) image files (file extension: tif or tiff)

5.2 Manually create still image objects from template

This is a description of the procedure to manually create a batch of Still Image objects from template in BB). This method is a good choice when creating a batch with a small number of objects. To create a batch with many objects (over 10), the automatic object creation procedure may be more efficient.

Procedure summary:

1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to object template.
5. Create a new batch and objects.
6. Move/copy files into corresponding directories on disk.
7. Process the batch.
8. Upload the batch to your dropbox
9. Check load report in email

**What you need before you start:**

- Prepare several digital images and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: `image-1.tif`, `image-1.jp2` and `image-1.jpg`). Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

- Decide what you will use for owner supplied names for image objects and the digital image files they consist of. For instance, you could use local classification or local accession numbers. Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

**Procedure:**

Start at Step 5 if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   
   a. From main menu select **Project > New**
   
   b. Enter project data:
      
      **Project Name:** enter a name for your project (used for internal tracking only).
      
      **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      
      TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. museum_slide_project)
      
      **Content Model:** select the "still image" value from the dropdown.
      
      **Project Description (optional):** Any information relevant to the project – will only remain locally.
   
   c. Click OK to continue.

2. Enter DRS deposit settings:
   
   a. Click on “Deposit Settings” in Project Panel tree.
   
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - `{owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}`
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      
      **Success Email:** type email and press enter.
      
      **Failure Email:** type email and press enter.
      
      **Success Method:** choose how you will receive load report.
      
      **Deposit Agent:** type your HUID.

3. Create object template:
   
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
   
   a. Click on “Object Template” in Project Panel tree:
b. Enter required object metadata in the form:

   **Owner Code:** your owner code (use all caps).
   **Billing Code:** your billing code (use all caps). **File Access Flags:** the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
   **URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod.
   **File URN Resource Name Pattern:** use default value \{n\} to generate a unique number.

c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. Add directories to template:

   **For one image file per object:**

   **Add directory:**

   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ”Add Directory…” menu option.

   b. Type in a name for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’

   c. In the Project Panel on the left select the directory you just created.

   d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

   e. Choose “HIGHUSE” for Usage Class.

   **Add additional metadata (optional tab):**

   a. Select the new directory in the Project Panel on the left

   b. In the Content Panel, select the ‘optional’ tab.

   c. Scroll down to “Still Image File Metadata”

   d. Enter any file level optional metadata in the form

      **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

   **For multiple image files per object** (e.g.: a file for archival master and a separate file for deliverable) you need to create a directory for the master file and a nested sub-directory for each derivative file. (This is needed for BB to determine the derivative relationship).

   **Add a master directory:**

   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ”Add Directory…” menu option.

   b. Type “-archival_master” or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. So, typing ‘-archival_master’ will result in a directory called ‘image-archival_master’

   c. In the Project Panel on the left select the directory you just created.
d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

e. Choose “LOWUSE” for Usage Class.

Add additional metadata (optional):

a. Select the new directory in the Project Panel on the left

b. In the Content Panel, select the ‘optional’ tab.

c. Scroll down to "Still Image File Metadata “

d. Enter any file level optional metadata in the form
   **Role:** select ARCHIVAL_MASTER.

Add a nested directory for derivative (e.g. a directory for deliverable images):

a. Right click on the directory you just created in the Project Panel on the left and select the ‘add a directory…’ menu option.

b. Type "-deliverable" or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’

c. In the Project Panel on the left select the directory you just created.

d. In the Content Panel on the right, choose “no” from the dropdown list for the field “First Generation in DRS”.

e. Choose “HIGHUSE” for Usage Class.

Add additional metadata for this derivative subdirectory (optional):

a. Select the new directory in the Project Panel on the left

b. In the Content Panel, select the ‘optional’ tab.

c. Scroll down to "Still Image File Metadata “

d. Enter any file level optional metadata in the form
   **Role:** select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB

e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived from the current one.

f. Save your work (Project > Save on main menu).

5. **Create new batch with objects:**
   Metadata added at this level can be applied to a specific object, or specific file directory.

a. **Create new batch:** select “Batch > New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk). Click OK.
   
   Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.

b. Select the batch (with the red letter B) in the Project Panel

c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and click OK.
d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object (blue letter O)

e. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note: any metadata entered at the object level will override metadata entered at the template level.

f. Repeat b-e if you have more than object.

g. Save your project (Project > Save on main menu).

6. Copy image files into batch object directories on disk (can be done outside Batch Builder).

Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.

7. Process the batch:

a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

Processing messages will appear in the messages pane.

b. When the batch is successfully processed you will see the following message: FINISHED Creation of batch.xml and descriptors complete for batch:

8. Upload batch to dropbox.

a. Open your SFTP client and log into your DRS2 Dropbox account.

b. Change to the "incoming" directory.

c. Upload the batch: copy the entire batch directory to the "incoming" directory.

d. Close the SFTP client. Batch processing will start.

9. Check load report in email.

a. Open your email inbox.

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …" For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel. If you see any error messages, remedy the errors and re-process the batch.
5.3 **Automatically build still image objects from template**

This is a description of the procedure to automatically build a batch of still image objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more than 10) that need to be created and your source files are not broken into directories by object.

**Procedure summary:**

1. Create a new project.
2. Enter DRS deposit information.
3. Create the object template.
4. Add directories to the object template.
5. Repeat steps in (4) for additional nested directories if needed.
6. Save your work
7. Move/copy images into the object template.
8. Create a new object batch.

**What you need before you start:**

- Prepare digital images and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: `image-1.tif`, `image-1.jp2` and `image-1.jpg`).

- Decide what you will use for owner supplied names for image objects and the digital image files they consist of. For instance, you could use local classification or local accession numbers. Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

- Make sure you either provide object name prefixes for each file to specify which objects it should be assigned to (The syntax is: `[obj-osn]--[file_name].[extension]`) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see Section 1.2.2. For more details about external mapping files see Section 15.1.

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select **Project > New**.
   b. Enter project data:
      - **Project Name:** enter a name for your project (used for internal tracking only).
      - **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. museum_slide_project)
      - **Content Model:** select the "still image" value from the dropdown.
**Project Description (optional):** Any information relevant to the project – will only remain locally.

c. Click OK to continue.

2. Enter DRS deposit settings:

   a. Click on “Deposit Settings” in Project Panel tree.

   b. Enter deposit data in the form:

      **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}

      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. Create object template:

   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.

   a. Click on “Object Template” in Project Panel tree:

   b. Enter required object metadata in the form:

      c. **Owner Code:** your owner code (use all caps).
      **Billing Code:** your billing code (use all caps).
      **File Access Flags:** the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
      **URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).
      **File URN Resource Name Pattern:** use default value \{n\} to generate a unique number.

      d. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. Add directories to template:

   In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.

   For one image file per object:

   Add directory:

   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.

   b. Type in a name for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’

   c. In the Project Panel on the left select the directory you just created.
d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

e. Choose “HIGHUSE” for Usage Class.

**Add additional metadata (optional tab):**

a. Select the new directory in the Project Panel on the left
b. In the Content Panel, select the ‘optional’ tab.
c. Scroll down to “Still Image File Metadata “
d. Enter any file level optional metadata in the form

   **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

For multiple image files per object (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

**Add a master directory:**

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.
b. Type “-archival_master” or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. So, typing ‘-archival_master’ will result in a directory called ‘image-archival_master’
c. In the Project Panel on the left select the directory you just created.
d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
e. Choose “LOWUSE” for Usage Class.

**Add additional metadata (optional):**

a. Select the new directory in the Project Panel on the left
b. In the Content Panel, select the ‘optional’ tab.
c. Scroll down to "Still Image File Metadata “
d. Enter any file level optional metadata in the form

   **Role:** select ARCHIVAL_MASTER.

**Add a nested directory for derivative (e.g. a directory for deliverable images):**

a. Right click on the directory you just created in the Project Panel on the left and select the ‘add a directory…” menu option.
b. Type “-deliverable” or a similar suffix that describes the role for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. So, typing ‘-deliverable’ will result in a directory called ‘image-deliverable’
c. In the Project Panel on the left select the directory you just created.
d. In the Content Panel on the right, choose “no” from the dropdown list for the field “First Generation in DRS”.
e. Choose “HIGHUSE” for Usage Class.
Add additional metadata for this derivative subdirectory (optional):

a. Select the new directory in the Project Panel on the left.
b. In the Content Panel, select the ‘optional’ tab.
c. Scroll down to "Still Image File Metadata “
d. Enter any file level optional metadata in the form
   
   **Role:** select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

e. Repeat steps 3 and 4 to create additional nested directories if you have more files derived from the current one.

5. Save your work (Project > Save on main menu).

6. Copy image files into Batch Builder template directory on disk (can be done outside Batch Builder).

   The directories you created in BB have been created on disk, in the project’s template path:
   
   `{project_name}\template\`

   In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object. See **Section 3: Naming Rules for Objects** for how to add an object name prefix. See **Section 15.1: Using mapping.txt file** for how to create a mapping file.

   In the automatic workflow, files with the same role (archival master, deliverable) are copied into the corresponding role-based directory. In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.

   Note: if you need to check where the directories are on disk, click on "Deposit Settings” in the Project Panel tree and look at the Project Path field at bottom.

   **Quick way to copy content files:** you can drag files from your file system onto the object template directories in the Batch Builder project panel.

   **If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.

   **If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.

7. Create a new object batch.

   You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

   **In the Graphical User Interface**

   a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

   b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

   c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see
8. **Process the batch.**

You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).

**In the Graphical User Interface**

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message:

   **FINISHED - Creation of batch.xml and descriptors complete for batch ....**

If you see any error messages, remedy the errors and re-process the batch.

**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
   ```
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.33
   ```

d. Type `batchbuildercli -a build -p [project_directory_path] -b [batch_directory_name]`, e.g.:
   ```
   batchbuildercli -a build -p "E:\My Project" -b batch1
   ```

b. (Optional) add additional parameters to the `batchbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

c. When the batch is successfully processed you will see the following messages:
   ```
   Building PREMIS file metadata...
   Building HulDrsAdmin file metadata...
   Success!
   ```

If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).

### 5.4 Processing images for SHARED SHELF

**Procedure summary:**

1. Create a new project.
2. Enter deposit settings.
3. Create object template.
4. Add directories to object template.
5. Follow manual or automatic object creation process as described in Sections 5.1 or 5.2 to create objects and process the batch.
Steps:

1. Create new project in Batch Builder
   a. From main menu select **Project > New**.
   b. Enter project data:
      - **Project Name**: enter a name for your project (used for internal tracking only).
      - **Project Directory**: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model**: select the "still image" value from the dropdown.
      
      Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Success Email**: type email and press enter.
      - **Failure Email**: type email and press enter.
      - **Success Method**: choose how you will receive load report.
      - **Deposit Agent**: type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      - **Owner Code**: your owner code (use all caps).
      - **Billing Code**: your billing code (use all caps).
      - **File Access Flags**: the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
      - **URN Authority Path**: your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).
      - **File URN Resource Name Pattern**: use default value {n} will generate a unique number.
   c. **Enter optional admin and descriptive metadata** to the object template. Click the “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects).
      

4. Add directories to object template.

   **For one image file per object** (e.g. one JP2 as both master and deliverable):
   a. **Add directory**: right click on “Object Template” in Project Panel tree. The new directory name will start with “image” but you can append a custom suffix.
   b. **Add metadata**: click to select the new directory, then add metadata to the form:
      In the ‘Required’ tab:
First Generation in DRS: select "yes".
Usage Class: select "HIGHUSE".

In the ‘Optional’ tab (this is **required** for SHARED SHELF / VIA workflow): scroll down to "Still Image File Metadata":

c. **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit and for a file to get linked in SHARED SHELF a file needs to have a role DELIVERABLE set in BB.

**Quality:** Select ‘5’ from the dropdown list (required for SHARED SHELF / VIA workflow)

**For multiple image files per object** (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

a. **Add a master directory:** right click on “Object Template” in Project Panel tree to create an "image" directory. In the text field, enter "-archival_master" or a similar suffix that describes the role.

b. **Add metadata for the master directory:** click to select the new directory, then add required metadata to the form:

   - In the ‘Required’ tab:
     - **First Generation in DRS:** select "yes".
     - **Usage Class:** select "LOWUSE".

   - In the ‘Optional’ tab: scroll down to "Still Image File Metadata":
     - **Role:** select ARCHIVAL_MASTER.
     - **Quality:** select a value higher than ‘5’ from dropdown list (any value higher than ‘5’ is allowed - ‘10’ is the highest quality)

c. **Add a nested directory for derivative (JP2s or JPEGs):** right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images). Add a suffix for this derivative (e.g., "-deliverable").

d. **Add metadata for this derivative subdirectory:** click to select the new subdirectory, then add metadata to the form:

   - In the ‘Required’ tab:
     - **First Generation in DRS:** select "no".
     - **Usage Class:** select "HIGHUSE".

   - In the ‘Optional’ tab (**required** for SHARED SHELF / VIA workflow): scroll down to "Still Image File Metadata":
     - **Role:** select ‘DELIVERABLE’. Note that in order to get a delivery URN on deposit and for a file to get linked in SHARED SHELF a file needs to have a role DELIVERABLE set in BB.
     - **Quality:** Select ‘5’ from the dropdown list (required for SHARED SHELF / VIA workflow)

e. **Add a second nested directory if thumbnails are needed.**
   If your deliverables are JPEGs, create an additional nested directory for a **thumbnail** image. Right click on the deliverable directory you just created for large delivery images and create another directory nested inside it. Add a suffix for this derivative (e.g., "-thumb").

   Click to select the new subdirectory, then add metadata to the form:
In the ‘Required’ tab:

First Generation in DRS: select "no".
Usage Class: select "HIGHUSE".

In the ‘Optional’ tab (required for SHARED SHELF / VIA workflow): scroll down to "Still Image File Metadata":

Role: select ‘DELIVERABLE’. Note that in order to get a delivery URN on deposit and for a file to get linked in SHARED SHELF a file needs to have a role DELIVERABLE set in BB.

Quality: Select ‘1’ from the dropdown list (required for SHARED SHELF / VIA workflow)

f. Repeat steps e and d to create additional nested directories if you have more files derived from the current one.

g. Save your work (Project > Save on main menu).

5. Follow instructions in Section 5.2 for manually creating a batch of objects or in Section 5.3 for automatically creating a batch of objects from template and then process the batch.
6. Creating PDS Document Object Batches

6.1 Accepted formats

PDS Document objects are page-turned objects that can be delivered by the DRS Page Delivery Service (PDS). Each object can be composed of multiple files, each representing either a page image, a page text or (optionally) the page text together with the layout (ALTO files).

All PDS Document objects automatically get assigned public delivery service URNs, which resolve to the Page Delivery Service (PDS) URLs. By default, individual files within a PDS Document object do not automatically get assigned public delivery service URNs. IDS delivery URNs may be requested for page images with role “deliverable” by checking this option in object/object template optional metadata panel. Page-level and section-level PDS URNs may be requested after deposit using the Web Admin structure editor.

6.1 Accepted formats

PDS Document objects can contain files in the following formats:

Page Image
- JPEG 2000 JP2 image files (file extension: jp2)
- JPEG File Interchange Format image files (file extension: jpg)
- Graphic Interchange Format (GIF) image files (file extension: gif)
- Tagged Image File Format (TIFF) image files (file extension: tif or tiff)

Page Text
- Plain UTF-8 encoded text (file extension: txt)

Page Layout
- Extensible Markup Language (XML) Files (file extension: xml)

The file extensions noted above are mandatory.

6.2 File name rules

This topic describes specific file name requirements for page-turned object batches. See Section 3 Naming Rules for Objects, Files and Directories for general Batch Builder requirements.

The file-naming scheme for page image, text and page layout files in page-turned object is:

{fileBaseName} {separator} {sequenceNumber}.{extension}

where:

{fileBaseName} is usually a locally-meaningful name, for example a name that associates the digital file with an analog counterpart. This may be an accession number, Aleph ID or other curatorially-significant name. Valid characters to use for the {fileBaseName} are letters, digits, ',', underscores ('_'), and hyphens ('-').

{separator} is a double underscore ('_ _') used to separate the {fileBaseName} from the page sequence number.
{sequenceNumber} is the numeric value that represents the sequence number of the page within the page-turned document. A sequenceNumber can be composed of any of the following characters: 0123456789.

The sequence number can include leading zeros, for example the third page can be written as: 3 or 03 or 000000003. The page sequence number indicates a page's relative position within a sequence of pages, regardless of the numbering that may appear on the page.

{extension} is one of the valid file extensions at the beginning of this topic.

By default Batch Builder assumes that fileBaseName plus the separator and the page sequence number is the file OwnerSuppliedName. E.g.: in a file 12345_01.tif Batch Builder will assume that 12345_01 is the file OwnerSuppliedName. This default can be changed in View-Options menu. See Section 1.2 Setting Options.

Alternatively, instead of using the file naming scheme the file OwnerSuppliedName, the page sequence number and the object OwnerSuppliedName can be supplied in a special mapping file called “mapping.txt”. More about mapping files…

6.3 Procedures to create a batch

6.3.1 Manually create PDS Document objects from template
6.3.2 Automatically build PDS objects from template
6.3.3 Use externally generated METS file to build structure-rich PDS objects

6.3.1 Manually create PDS Document objects from template

This is a description of the process to manually create a PDS Document object batch using Batch Builder 2 (BB). This method is best to use when you have only one or two PDS objects in your batch.

Procedure summary:

1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Create a new object batch
6. Move/copy files into corresponding batch directories on disk
7. Process the batch
8. Upload batch to dropbox
9. Check load report in email

What you need before you start:

- Prepare a batch of page images and (optionally) accompanying machine readable text and XML layout (Alto) files that constitute a future PDS Document object and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names
of text files and XML layout (Alto) files should match the file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt, file1.xml).

- Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: [fileBaseName]_[sequence_number].[extension]. E.g. file1_1.jpg, file2_2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See Section 15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.

- Decide what you will use for Owner Supplied Names for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select Project > New.
   b. Enter project data:
      - **Project Name:** enter a name for your project (used for internal tracking only).
      - **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model:** select the value "PDS document" from the dropdown.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email:** type email and press enter.
      - **Failure Email:** type email and press enter.
      - **Success Method:** choose how you will receive load report.
      - **Deposit Agent:** type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      - **Owner Code:** your owner code (use all caps).
      - **Billing Code:** your billing code (use all caps).
      - **File Access Flags:** the DRS access flag for the files. At this level, select the least restrictive
value if the batch will contain a mix of public and restricted files.

**URN Authority Path**: your NRS authority path. Use all caps. Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod.

**File URN Resource Name Pattern**: type “{n}” to generate a random unique number for IDS file delivery URN. Note that a value in this field is required even if you elect not to have Batch Builder generate IDS URNs for deliverable images. Hover over the field or see Metadata Reference for more values for this field.

**Object URN Resource Name Pattern**: leave at default “{n}” to generate a random unique number for PDS object delivery URN. Type “{objectName}” to have the PDS object delivery URN derived from the object name. Hover over the field or see Metadata Reference for more values for this field.

c. **Enter optional admin and descriptive metadata** to the object template. Click the “optional” tab.

**IDS URN for Deliverable JPG and JP2**: Select "Yes" if you need IDS URNs for all deliverable images in the batch.

For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content

4. Add directories to template:

**Image directories**

For one image file per page image:

a. **Add directory**: right click on “Object Template” in Project Panel tree. The new directory name will start with “image” but you can append a custom suffix.

b. **Add metadata**: click to select the new directory, then add metadata to the form:
   
   In “required” tab:
   
   **First Generation in DRS**: select "yes".
   **Usage Class**: select "HIGHUSE".

   In “optional” tab: scroll down to "Still Image File Metadata":
   
   **Role**: use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

a. **Add a master directory**: right click on “Object Template” in Project Panel tree to create an "image" directory. In the text field, enter ",archival_master" or a similar suffix that describes the role.

b. **Add metadata for the master directory**: click to select the new directory, then add required metadata to the form:
   
   In “required” tab:
   
   **First Generation in DRS**: select "yes".
   **Usage Class**: select "LOWUSE".

   In “optional” tab: scroll down to "Still Image File Metadata":

Revised: April 14, 2015
Role: select ARCHIVAL_MASTER.

c. **Add a nested directory for derivative**: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images). Add a suffix for this derivative (e.g., "-deliverable").

d. **Add metadata for this derivative subdirectory**: click to select the new subdirectory, then add metadata to the form:

   In “required” tab:
   - **First Generation in DRS**: select "no".
   - **Usage Class**: select "HIGHUSE".

   In “optional” tab: scroll down to "Still Image File Metadata":
   - **Role**: select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

e. Repeat the previous steps to create additional nested directories if you have more files derived from the current one.

f. Save your work (Project > Save on main menu).

**Text directories**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

**Layout directories (for Alto coordinates files)**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

5. **Create new batch with objects**:

   Note: Metadata added at this level can be applied to a specific object or file directory.

   a. **Create new batch**: select “Batch > New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk). Click OK.

      Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.

   b. **Click to select new batch** in Project Panel tree. (Look for red letter B).

   c. **Create new object from template**: select Object > New from the main menu. Enter the name of the object (by default, will be used as object OSN). Make sure this object name is unique! Click OK. (Look for blue letter O).
d. **Enter optional metadata** for each object and file. Click the object directory in the Project Panel tree and select the “optional” tab on the right to enter optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects).

For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content . Note that any metadata entered at the object level will override metadata entered at the template level.

e. **Repeat the previous steps** to create additional objects (if you have more than one object in the batch).

f. Save your project (Project > Save on main menu).

6. Copy files into batch object directories on disk (done outside Batch Builder).

Page image files go into an object's "image" directory. Text files go in a "text" directory. Layout files go in a "layout" directory.

Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.

7. Process the batch:

   a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

   b. Processing messages will appear in the messages pane.

   c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:

8. Upload batch to dropbox.

   a. Open your SFTP client and log into your DRS2 dropbox account.

   b. Change to the "incoming" directory.

   c. Upload the batch: copy the entire batch directory to the "incoming" directory.

   d. Close the SFTP client. Batch processing will start.

9. Check load report in email.

   a. Open your email inbox.

   b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"

   For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.

### 6.3.2 Automatically build PDS objects from template

This is a description of the procedure to automatically build a batch of PDS Document objects from template using Batch Builder 2 (BB). Use this method if you have more than two PDS Document objects in your batch.
Procedure summary:
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Move/copy files into template directory.
6. Create an new object batch
7. Process the batch.

What you need before you start:

• Prepare a batch of page images and (optionally) accompanying machine readable text files and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files should match the file names of the page images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt).

• Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: [fileBaseName]_ _[sequence_number].[extension]. E.g.: file1_ _1.jpg, file2_ _2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See Section 15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.

• Decide what you will use for Owner Supplied Names (OSNs) for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.

• Make sure that the object OSNs are supplied for each file by one of the following methods:
  o Append the object prefix to each file name (the syntax is [objprefix]-- [fileBaseName]_ _[pageSeq].[ext]). Set the desired file name pattern objects in the BB Options dialog (see Section 1.2.2 for more information).
  o Supply an external mapping file that maps each file to object (see Section 15.1 for more information).

Procedure:

Start at Step 5 if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select Project > New.
   b. Enter project data:
      
      **Project Name:** enter a name for your project (used for internal tracking only).
      **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      **Content Model:** select the "PDS document" value from the dropdown.

Revised: April 14, 2015
2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - `{owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. Create object template:
   Note: Metadata added at this level will be applied to every object in a batch, unless overridden by specific object-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      
      **Owner Code:** your owner code (use all caps).
      **Billing Code:** your billing code (use all caps).
      **File Access Flags:** the DRS access flag for the files. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
      **URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).
      **File URN Resource Name Pattern:** type “{n}” to generate a random unique number for IDS file delivery URN. Note that a value in this field is required even if you elect not to have Batch Builder generate IDS URNs for deliverable images. Hover over the field or see [Metadata Reference](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) for more values for this field.
      **Object URN Resource Name Pattern:** leave at default “{n}” to generate a random unique number for PDS object delivery URN. Type “{objectName}” to have the PDS object delivery URN derived from the object name. Hover over the field or see [Metadata Reference](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) for more values for this field.
      
      **Enter optional admin and descriptive metadata** to the object template. Click the “optional” tab.

      **IDS URN for Deliverable JPG and JP2:** Select "Yes" if you need IDS URNs for all deliverable images in the batch.

4. Add directories to template:
   In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.

   **Image directories**

   **For one image file per page image:**
a. **Add directory**: right click on “Object Template” in Project Panel tree. The new directory name will start with “image” but you can append a custom suffix.

b. **Add metadata**: click to select the new directory, then add metadata to the form:
   - **Required**:
     - **First Generation in DRS**: select "yes".
     - **Usage Class**: select "HIGHUSE".
   - **Optional**: scroll down to "Still Image File Metadata":
     - **Role**: use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

For multiple image files per page image (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

a. **Add a master directory**: right click on “Object Template” in Project Panel tree to create an "image" directory. In the text field, enter ":archival_master" or a similar suffix that describes the role.

b. **Add metadata for the master directory**: click to select the new directory, then add required metadata to the form:
   - **Required**:
     - **First Generation in DRS**: select "yes".
     - **Usage Class**: select "LOWUSE".
   - **Optional**: scroll down to "Still Image File Metadata":
     - **Role**: select ARCHIVAL_MASTER.

c. **Add a nested directory for derivative**: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images). Add a suffix for this derivative (e.g., ":deliverable").

d. **Add metadata for this derivative subdirectory**: click to select the new subdirectory, then add metadata to the form:
   - **Required**:
     - **First Generation in DRS**: select "no".
     - **Usage Class**: select "HIGHUSE".
   - **Optional**: scroll down to "Still Image File Metadata":
     - **Role**: select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

e. **Repeat previous steps to create additional nested directories if you have more files derived from the current one.**

f. **Save your work** (Project > Save on main menu).

**Text directories**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.
c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

**Layout directories (for Alto coordinates files)**

- Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.
- In the Project Panel on the left select the directory you just created.
- In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.
- Choose “LOWUSE” for Usage Class.

5. Copy files into Batch Builder template directories on disk (can be done inside or outside of Batch Builder).

The directories you created in BB have been created on disk, in the project’s template path:

\{project_name\}/template/

In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object. See Section 3: Naming Rules for Objects for how to add an object name prefix. See Section 15.1: Using mapping.txt file for how to create a mapping file.

In the automatic workflow, files with the same role (archival master, deliverable, text, layout) are copied into the corresponding role-based directory. In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.

Note: if you need to check where the directories are on disk, click on “Deposit Settings” in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.

6. **Create a new object batch.**

You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

**In the Graphical User Interface**

- From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
- In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata that applies specifically to your object (for example descriptive metadata or Aleph ID, administrative categories, etc.). Note that any optional metadata that applies to all objects in the batch should be entered in the object template before your batch is created. For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

7. **Process the batch.**

You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).

**In the Graphical User Interface**

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message:

   **FINISHED - Creation of batch.xml and descriptors complete for batch: …**

   If you see any error messages, remedy the errors and re-process the batch.

---

**6.3.3 Use externally generated METS file to build structure-rich PDS objects**

6.3.3.1 **Preparing externally generated METS file for import**

6.3.3.2 **Using BB manual object building option**

6.3.3.3 **Using BB automatic object building option**

This is a description of the procedures to build structure-rich PDS objects using externally generated METS files. This method is best to use when additional structure (i.e. custom section nodes) needs to be added to a PDS object before DRS deposit. Structure-rich PDS objects can be built using the BB manual object building option as well as using the BB automatic object building option.

**6.3.3.1 Preparing externally generated METS file for import**

1. **Where to place the PDS METS file(s)?**

   a. When building the objects manually the file(s) should be placed into the directory: `[project]\aux\[batch]\[object]`

   b. When building objects automatically the file(s) should be placed into the directory `[project]\aux\template`

2. **How to adjust PDS METS file(s) for ingest by BB?**

   There are changes to the file path and the file name in each xlink:href attribute in the `<filesec>` section of the provided METS files that need to be done before the file can be read and converted by BB.

   a. (Required) The file path must be updated to correspond to the Batch Builder 2 naming and directory structure for every file referenced in xlink:href attribute in the `<filesec>`
section of the provided METS file. For instance, given that when you created directories in BB template you named your archival master directory image-arch, your deliverable directory image-deliverable and your text directory text, the DRS 1-style PDS METS <filesec> section should be updated in the following way:

xlink:href="archival_master/mydoc__1.tif"
should be updated to read
xlink:href="image-arch/mydoc__1.tif"

xlink:href="archival_master/deliverable/mydoc__1.jp2"
should be updated to read
xlink:href="image-arch/image-deliverable/mydoc__1.jp2"

xlink:href="archival_master/ocr_uncorrected/mydoc__1.txt"
should be updated to read
xlink:href="text/mydoc__1.txt"

File path syntax note: The file path style (Linux/Mac vs Windows) in the xlink attribute needs to correspond to the computer operating system on which BB is being run. If BB is run on Windows the file path should use Windows-style slashes:

image-arch\image-deliverable\mydoc__1.jp2

If BB is run on Linux or Mac the file path should use the Linux/Mac style slashes:

image-arch/image-deliverable/mydoc__1.jp2

b. (Optional) The file name in xlink:href needs to be modified if you plan to add an object OSN prefix to file names. For every file referenced in xlink:href attribute in the <filesec> section of the provided METS file The file names should be updated in the following way.

If original file names were mydoc__1.tif, mydoc__1.jp2 and mydoc__1.txt and the object OSN prefix was added to the left and the page sequence number was added to the right so that the new file names are: obj1--mydoc__1.tif, obj1- mydoc__1.jp2 and obj1- mydoc__1.txt the xlink:href attributes should be updated to read:

xlink:href="image-arch/obj1--mydoc__1.tif"
xlink:href="image-arch/image-deliverable/obj1- mydoc__1.jp2"
xlink:href="text/obj1- mydoc__1.txt"

where “obj1” is the object OSN prefix.

3. Name the PDS METS file(s) to correspond to BB naming scheme

The METS file(s) should be named in the following way: `{obj_name}_mets.xml`.

Example

If the original METS file name is original_name.xml, and the PDS Document object owner supplied name is obj1 the new name of the METS file should be obj1_mets.xml

Note that the object OSN that is part of the METS file name (e.g., obj1-mets.xml) should match the object OSN specified in the object name prefix for each file (e.g., obj1--image1_1.jp2) or in the external mapping file mapping.txt (See Section 15.1: Using mapping.txt file for how to create a mapping file.).

If building objects automatically, once a new batch is created the METS file(s) will be moved to the appropriate object directory(ies): `[project]\aux\[batch]\[object]`. Note that if you need to edit
your METS file(s) after the batch has been created you can edit them in their new locations
([project]\_aux\[batch]\[object]).

6.3.3.2 Using BB manual object building option

This is a description of the process to manually create a structure-rich PDS Document object batch using Batch Builder 2 (BB). This method is best to use when you have only one or two PDS objects in your batch.

Procedure summary:
1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Create a new object batch
6. Copy files into object directories on disk
7. Adjust PDS METS file(s) for ingest by BB
8. Rename the PDS METS file(s) to required naming scheme.
9. Place PDS METS file(s) into corresponding object directori(es/y) on disk
10. Process the batch
11. Upload batch to dropbox
12. Check load report in email

What you need before you start:

- Prepare a batch of page images and (optionally) accompanying machine readable text and XML layout (Alto) files that constitute a future PDS Document object and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files and XML layout (Alto) files should match the file names of the page images files (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt, file1.xml).
  - Repeat the steps above for each PDS object you are preparing. Files for all objects you are preparing should reside in directories designated by their future roles – e.g.: archival masters for all objects reside in one directory, large deliverables for all objects reside in another, nested directory, etc.

- Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: [filename]_ _[sequence_number].[extension]. E.g.: file1__1.jpg, file2_ _2.jpg, etc. Check Section 1.2.2 of this Guide for more information about setting file name patterns in BB. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See Section 15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
• Decide what you will use for Owner Supplied Names for your object and the digital image files it consists of. For instance, you could use local classification or local accession numbers or an ALEPH ID.

• Supply externally generated PDS METS file for each object for ingest by Batch Builder (see Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS file). See subsection Preparing externally generated METS file for import into Batch Builder 2 above to learn how to adjust the METS file for ingest by Batch Builder.

Procedure:

Start at Step 5 if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select Project > New.
   b. Enter project data:
      - **Project Name:** enter a name for your project (used for internal tracking only).
      - **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model:** select the value "PDS document" from the dropdown.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email:** type email and press enter.
      - **Failure Email:** type email and press enter.
      - **Success Method:** choose how you will receive load report.
      - **Deposit Agent:** type your HUID.

3. Create object template:

   Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      - **Owner Code:** your owner code (use all caps).
      - **Billing Code:** your billing code (use all caps).
      - **File Access Flags:** the DRS access flag for the files. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
      - **URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod.
      - **File URN Resource Name Pattern:** type “[n]” to generate a random unique number for IDS file delivery URN. Note that a value in this field is required even if you elect not to have Batch
Builder generate IDS URNs for deliverable images. Hover over the field or see Metadata Reference for more values for this field.

**Object URN Resource Name Pattern:** leave at default “{n}” to generate a random unique number for PDS object delivery URN. Type “{objectName}” to have the PDS object delivery URN derived from the object name. Hover over the field or see Metadata Reference for more values for this field.

Enter optional admin and descriptive metadata to the object template. Click the “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects).

For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. Add directories to template:

**Image directories**

**For one image file per page image:**

a. **Add directory:** right click on “Object Template” in Project Panel tree. The new directory name will start with “image” but you can append a custom suffix.

b. **Add metadata:** click to select the new directory, then add metadata to the form:
   
   Required:
   
   **First Generation in DRS:** select "yes".
   **Usage Class:** select "HIGHUSE".

   Optional: scroll down to "Still Image File Metadata":
   
   **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

**For multiple image files per page image** (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

c. **Add a master directory:** right click on “Object Template” in Project Panel tree to create an "image" directory. In the text field, enter "-archival_master" or a similar suffix that describes the role.

d. **Add metadata for the master directory:** click to select the new directory, then add required metadata to the form:
   
   Required:
   
   **First Generation in DRS:** select "yes".
   **Usage Class:** select "LOWUSE".

   Optional: scroll down to "Still Image File Metadata":
   
   **Role:** select ARCHIVAL_MASTER.

e. **Add a nested directory for derivative:** right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images). Add a suffix for this derivative (e.g., "-deliverable").

f. **Add metadata for this derivative subdirectory:** click to select the new subdirectory, then add metadata to the form:
“required” tab:

First Generation in DRS: select "no".
Usage Class: select "HIGHUSE".

“optional” tab: scroll down to "Still Image File Metadata":

Role: select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

g. Repeat the previous steps to create additional nested directories if you have more files derived from the current one.

h. Save your work (Project > Save on main menu).

**Text directories**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

**Layout directories (for Alto coordinates files)**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

5. **Create new batch with objects:**

Note: Metadata added at this level can be applied to a specific object or file directory.

a. Create new batch: select “Batch > New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk). Click OK.

   Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.

b. Click to select new batch in Project Panel tree. (Look for red letter B).

c. Create new object from template: select Object > New from the main menu. Enter the name of the object (by default, will be used as object OSN). Make sure this object name is unique! Click OK. (Look for blue letter O).

d. Enter optional metadata for each object and file. Click the object directory in the Project Panel tree and select the “optional” tab on the right to enter optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects).

For more about optional metadata see 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.
Repeat the previous steps to create additional objects (if you have more than one object in the batch).

f. Save your project (Project > Save on main menu).

6. Copy files into batch object directories on disk (done outside Batch Builder).

Page image files go into an object's "image" directory. Text files go in a "text" directory. Layout files go in a "layout" directory.

Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.

7. Adjust PDS METS file(s) for ingest by BB. See sub-section 6.3.3.1 Preparing externally generated METS file for import into Batch Builder 2 at the top of Section 6.3.3.

8. Rename the PDS METS file(s) to correspond to BB external mapping files naming scheme. See sub-section 6.3.3.1: Preparing externally generated METS file for import into Batch Builder 2.

9. Place the PDS METS file(s) into corresponding object directories

The PDS METS file(s) should be placed into corresponding object directories: [project]\_aux\[batch]\[object].

10. Process the batch:

a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Processing messages will appear in the messages pane.

c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:

11. Upload batch to dropbox

a. Open your SFTP client and log into your DRS2 training dropbox account.

b. Change to the "incoming" directory.

c. Upload the batch: copy the entire batch directory to the "incoming" directory.

d. Close the SFTP client. Batch processing will start.

12. Check load report in email.

a. Open your email inbox.

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"

For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
6.3.3.3 **Using BB automatic object building option**

This is a description of the procedure to build structure-rich PDS objects using externally generated METS files by means of the BB automatic object building option. This method is best to use when you have more than two PDS objects in your batch.

**Procedure summary:**
1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Move/copy files into template directory
6. Place PDS METS file(s) into corresponding template directory
7. Adjust PDS METS file for ingest to BB
8. Rename the PDS METS file to correspond to BB external mapping files naming scheme
9. Create a new object batch
10. Process the batch
11. Upload batch to dropbox
12. Check load report in email

**What you need before you start:**

- Prepare a batch of page images and (optionally) accompanying machine readable text files and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per page image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: file1.tif, file1.jp2 and file1.jpg). The file names of text files should match the file names of the page images files as well (e.g.: file1.tif, file1.jp2 file1.jpg, file1.txt).
  - Repeat the steps above for each PDS object you are preparing. Files for all objects you are preparing should reside in directories designated by their future roles – e.g.: archival masters for all objects reside in one directory, large deliverables for all objects reside in another, nested directory, etc.
- Make sure all the files names have appended PDS sequence numbers. The syntax used in BB2: [filename]_[sequence_number].[extension]. E.g.: file1_1.jpg, file2_2.jpg, etc. Alternatively, instead of supplying appended sequence numbers you can provide them via the external mapping file called mapping.txt. See Section 15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs for more information.
- Decide what you will use for Owner Supplied Names (OSNs) for your objects and the digital image files they contain. For instance, you could use local classification or local accession numbers or ALEPH IDs.
- Make sure that the object OSNs are supplied for each file by one of the following methods:
ο Append the object prefix to each file name (the syntax is \[objprefix\]--\[filename\]_\[pageSeq\].[ext]). Set the desired file name pattern objects in the BB Options dialog (see Section 1.2.2 for more information).

ο When preparing several objects, \[objprefix\] for a corresponding object should be used for the files that are going to be part of that object. E.g.: obj1- -file1_ _01.jpeg, obj2- -file1_ _01.jpeg, obj1- -file2_ _02.jpeg, obj2- -file2_ _02.jpeg etc.

ο Supply an external mapping file that maps each file to object (see Section 15.1 for more information). One mapping file can contain references to multiple objects.

• Supply externally generated PDS METS file for each object for ingest by Batch Builder (see Harvard METS Profile for PDS for a list of elements that can be included in the PDS METS file). The PDS METS file should be placed into \[project\]_aux\_template directory (for Unix, Linux or Mac the path would be \[project\]/_aux/template).

ο Note that you can place several corresponding METS files for each of your objects in the \[project\]_aux\_template directory. The naming scheme for the PDS METS files is explained in step 7 of this procedure.

Procedure:

Start at Step 5 if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select Project > New.
   b. Enter project data:
      
      Project Name: enter a name for your project (used for internal tracking only).
      Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      Content Model: select the "PDS document" value from the dropdown.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      Batch Name Pattern: default - \{owner\}_\{batchDir\}_\{yyyy\}_\{mo\}_\{dd\}_\{hh24\}_\{mm\}_\{ss\}
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      Success Email: type email and press enter.
      Failure Email: type email and press enter.
      Success Method: choose how you will receive load report.
      Deposit Agent: type your HUID.

3. Create object template:
   Note: Metadata added at this level will be applied to every object in a batch, unless overridden by specific object-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
b. Enter required object metadata in the form:

**Owner Code:** your owner code (use all caps).

**Billing Code:** your billing code (use all caps).

**File Access Flags:** DRS access flag for the files in the object. Should contain the least restrictive access flag that applies to all the files.

**URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).

**File URN Resource Name Pattern:** type “{n}” to generate a random unique number for IDS file delivery URN. Note that a value in this field is required even if you elect not to have Batch Builder generate IDS URNs for deliverable images. Hover over the field or see Metadata Reference for more values for this field.

**Object URN Resource Name Pattern:** leave at default “{n}” to generate a random unique number for PDS object delivery URN. Type “{objectName}” to have the PDS object delivery URN derived from the object name. Hover over the field or see Metadata Reference for more values for this field.

**Enter optional admin and descriptive metadata** to the object template. Click the “optional” tab.

**IDS URN for Deliverable JPG and JP2:** Select "Yes" if you need IDS URNs for all deliverable images in the batch.

4. **Add directories to template:**

In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.

**Image directories**

**For one image file per page image:**

a. **Add directory:** right click on “Object Template” in Project Panel tree. The new directory name will start with “image” but you can append a custom suffix.

b. **Add metadata:** click to select the new directory, then add metadata to the form:

   Required:

   **First Generation in DRS:** select "yes".

   **Usage Class:** select "HIGHUSE".

   Optional: scroll down to "Still Image File Metadata":

   **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

**For multiple image files per page image** (e.g., archival master, deliverable), you need to create a directory for the master file and a nested sub-directory for each derivative file.

a. **Add a master directory:** right click on “Object Template” in Project Panel tree to create an "image" directory. In the text field, enter "-archival_master" or a similar suffix that describes the role.

b. **Add metadata for the master directory:** click to select the new directory, then add required metadata to the form:
Required:
   First Generation in DRS: select "yes".
   Usage Class: select "LOWUSE".

Optional: scroll down to "Still Image File Metadata":
   Role: select ARCHIVAL_MASTER.

c. Add a nested directory for derivative: right click on the directory you just created and create another directory nested inside it (e.g., a directory for deliverable images). Add a suffix for this derivative (e.g., "-deliverable").

d. Add metadata for this derivative subdirectory: click to select the new subdirectory, then add metadata to the form:
   Required:
   First Generation in DRS: select "no":.
   Usage Class: select "HIGHUSE".

Optional: scroll down to "Still Image File Metadata":
   Role: select appropriate value for derivative (e.g., DELIVERABLE). Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

e. Repeat previous steps to create additional nested directories if you have more files derived from the current one.

f. Save your work (Project > Save on main menu).

**Text directories**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “text” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

**Layout directories (for Alto coordinates files)**

a. Right click on “Object Template” in the Project Panel to add a file directory. Enter the directory name in the dialog box. The directory name starts with “layout” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

5. **Copy files into Batch Builder template directories on disk (can be done inside or outside of Batch Builder)**

The directories you created in BB have been created on disk, in the project’s template path:

{project_name}\template\ 

In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.

Revised: April 14, 2015
See Section 3: Naming Rules for Objects for how to add an object name prefix. See Section 15.1: Using mapping.txt file for how to create a mapping file.

In the automatic workflow, files with the same role (archival master, deliverable, text, layout) are copied into the corresponding role-based directory. In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.

Copy your PDS METS file into the

Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the object template directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.

6. Place PDS METS file(s) into corresponding template directory
   The file(s) should be placed into the directory: [project]_aux\template.

7. Adjust PDS METS file(s) for ingest by BB. See Section 6.3.3.1: Preparing externally generated METS file for import into Batch Builder 2.

8. Rename the PDS METS file(s) to correspond to BB external mapping files naming scheme. See Section 6.3.3.1: Preparing externally generated METS file for import into Batch Builder 2.

9. Create a new object batch.
   You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

   ** In the Graphical User Interface
   a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.
   b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).
   c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata that applies specifically to your object (for example descriptive metadata or Aleph ID, administrative categories, etc.). Note that any optional metadata that applies to all objects in the batch should be entered in the object template before your batch is created. For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

   You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).

   ** In the Graphical User Interface
a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message:
   FINISHED - Creation of batch.xml and descriptors complete for batch: …

If you see any error messages, remedy the errors and re-process the batch.

In the Command Line Interface

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
   \cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
   Type bathcbuildercli -a build -p [project_directory_path] -b [batch_directory_name], e.g.:
   bathcbuildercli -a build -p "E:\My Project" -b batch1

b. (Optional) add additional parameters to the bathcbuildercli command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

c. When the batch is successfully processed you will see the following messages:
   Building PREMIS file metadata...
   Building HulDrsAdmin file metadata...
   Success!

If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message)

11. Upload batch to dropbox

a. Open your SFTP client and log into your DRS2 training dropbox account.

b. Change to the "incoming" directory.

c. Upload the batch: copy the entire batch directory to the "incoming" directory.

d. Close the SFTP client. Batch processing will start.

12. Check load report in email.

a. Open your email inbox.

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
   For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
7. Creating Opaque Object Batches

7.1 Accepted formats

Files of any format can be deposited as part of an opaque object.

7.2 File and directory structure

Opaque objects can contain two types of files – content files (those files being deposited for preservation), and DRS documentation files. See Section 7.2: Content files and Section 7.3: DRS Documentation Files for more information.

When preparing files for batch processing, the files should be arranged under one of two directories: either content or documentation. The DRS documentation files should be placed in the documentation directory, all other files should be placed in the content directory. The content directory is required and should contain content. The documentation directory is optional.

Example 1: Contents of an opaque object storing a presentation

content\the_presentation.ppt
content\the_presentation_audio.mp3
content\the_presentation_video.mpeg
content\the_presentation_handout.pdf
content\the_presentation_notes.doc
documentation\drs_documentation.txt

Example 2: Contents of an opaque object storing a faculty member's research

content\projectx\2005_002.xls
content\projectx\runDemo.exe
content\projectx\logo.bmp
content\projecty\docs\original_grant.pdf
7.3 Content files

To the extent possible, care should be taken to only include in a single opaque object those files that logically make up an object.

Try to include within the same opaque object, files that:

- Are related by derivative relationships (e.g. master and use copies)
- Have display or rendering dependencies (e.g. style sheets, scripts and images should be included in the same opaque container as web pages dependent on them)
- Require the same descriptive metadata (are part of the same work with the same bibliographic record)

Deposit in separate opaque objects:

- Files which are not related or dependent on each other contextually or structurally
- Files that constitute several independent logical objects

Omit from opaque objects:

- Content not intended for long-term preservation

Although it is expected that the content of opaque objects might not be fully appraised or processed prior to deposit into the DRS, to the extent possible depositors should perform an initial weeding out of unwanted material. This is especially important in the case of donated hard drives which may contain applications, system files, cached data, etc.

<table>
<thead>
<tr>
<th>Examples of opaque object designs</th>
<th>Assessment of design</th>
</tr>
</thead>
<tbody>
<tr>
<td>multiple files related to a single video game</td>
<td>Very good. If the DRS ever supports video game objects the files in this opaque object could be expanded into a fully supported object.</td>
</tr>
<tr>
<td>multiple files related to a single database</td>
<td>Very good. Once the DRS supports database objects the files in this opaque object could be expanded into a fully supported object.</td>
</tr>
<tr>
<td>An object containing one set of RAW camera image files</td>
<td>OK. If you can envision separating them in the future it would be better to only group the ones together that are related to each other. Also if there are other files related to these RAW files (derivative images, etc.) it may be better to group them together so that you don't have to combine them in the future.</td>
</tr>
<tr>
<td>a set of word processing files</td>
<td>OK. Same reason as for the RAW camera image files.</td>
</tr>
<tr>
<td>one audio file</td>
<td>Good. If there are other files related to this audio file (other derivative audio files, transcripts, etc.) it may be better to group them together so that you don't have to combine them in the future.</td>
</tr>
</tbody>
</table>
7.4 DRS documentation files

LTS encourages the creation and deposit of documentation within opaque objects to increase the chances that this content can be migrated into fully supportable DRS objects in the future, and so that all information known about this content can be made available to future stewards of this material.

The file names of all documentation files should start with the prefix **drs_documentation**. The files should be located within a directory called **documentation**, as shown in the File and directory structure topic. These documentation files can be one or more text, PDF or spreadsheet files. The recommended formats for these files are:

- If text: plain text (ASCII or UTF-8 encoding) (*.txt) or OpenDocument Text (*.odt)
- If PDF: PDF/A-1a (*.pdf)
- If spreadsheet: OpenDocument Spreadsheet (*.ods)

These files may include information about file relationships within an opaque object, documentation of original order, licenses or donor agreements, etc. Files describing original order or rights should be named according to the following guidelines.

**Documenting original order**

In keeping with archival practice, depositors are encouraged to document the original order and structure of files as they are submitted to them, especially when large file sets are split into separate opaque objects. The DRS documentation file that documents the original order should conform to the recommended formats listed above, and be deposited with all relevant opaque objects (those split from the original order). The file names of these files should start with the prefix **drs_documentation_original_order**.

**Documenting rights**

It is recommended that Donor agreements and other licenses should be loaded as separate objects to the DRS, before the opaque objects are loaded. See Section 19. Adding Licenses, Documentation and Other Supporting Content for more information. When opaque objects are created in Batch Builder, an object URN of the related rights object can be inserted in object Optional metadata panel.

7.5 Procedures to create a batch

7.5.1 Manually build Opaque objects from template
7.5.2 Automatically build Opaque objects from template

7.5.1 Manually build Opaque objects from template

This is a description of the procedure to manually create a batch of opaque objects from template in Batch Builder 2 (BB). This method should be used if you have less than 5 objects per batch.

**Procedure summary:**

1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Add metadata

Revised: April 14, 2015
6. Save your work
7. Create a new object batch
8. Move/copy files into corresponding directories on disk
9. Process the batch

What you need before you start:

- Prepare several opaque objects and put them in a directory of your choice somewhere on local hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on creating opaque objects.

- Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, you could use local classification or local accession numbers. Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

Procedure:

1. Create a new project.
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “opaque” from the dropdown; click OK to continue.

2. Enter DRS deposit settings.
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. Create object template
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter Owner Code for objects you will be depositing (use all caps).
   c. Enter Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
   e. (Optional) Switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.
4. **Add directories to template.**

**About files in opaque objects:** All files that make up the opaque object must be stored in one “content” directory. Any documentation files that describe the opaque content must be stored in a “documentation” directory. The “documentation” directory must be parallel to the “content” directory. There can be only one “content” directory per opaque object.

**Content directory** (an opaque object can have only one directory named “content”):

a. **Add directory:** Right click on “Object Template” in Project Panel on the left and add a directory. Content directories are prefixed with "content, but you can append a custom suffix to the directory name.

b. **Add metadata:** click to select the new directory, then add metadata to the form:
   - Required:
     - **First Generation in DRS:** select "yes".
     - **Usage Class:** select "LOWUSE".
   - Optional:
     - **Role:** There are no roles for content files,

**Documentation directory** (optional):

a. **Add directory:** Right click on “Object Template” in the Project Panel on the left and add a directory. The directory name starts with “documentation” but you can append a custom suffix.

b. **Add metadata:** click to select the new directory, then add metadata to the form:
   - Required:
     - **First Generation in DRS:** select "yes".
     - **Usage Class:** select "LOWUSE".
   - Optional:
     - **Role:** You can select either DOCUMENTATION or LICENSE roles for documentation files. Select any role that applies.

5. **Save your work:** Project > Save on main menu.

6. **Create a new object batch.**

   a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the left (icon with red letter B).

   b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.

   c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.

   d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

   e. Repeat b-d if you have more than object.

7. **Move/copy images into corresponding file directories on disk.**
The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right.

a. Copy the content files into the corresponding content directory in the object directory.

b. Copy documentation files into the corresponding documentation directory in the object directory.

c. Repeat if you have more than one object.

8. **Process the batch.**
   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
   b. Builder will start processing the batch.
   c. When the batch is successfully processed you will see the following message:
   
   ```
   FINISHED - Creation of batch.xml and descriptors complete for batch: …
   ```

### 7.5.2 Automatically build Opaque objects from template

This is a description of the procedure to automatically create a batch of opaque objects from template in Batch Builder 2 (BB). This method should be used if you have 5 or more opaque objects per batch and the object contents are simple (e.g.: several files per object without any nested directories). If the object content consists of many files and nested directories this method becomes impractical. In this latter case use the procedure to manually build Opaque objects from template.

**Procedure summary:**

1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Add metadata
6. Save your work
7. Move/copy files into corresponding directories on disk
8. Create new batch with objects
9. Process the batch
10. Upload batch to dropbox
11. Check load report in email

**What you need before you start:**

- Prepare your opaque objects and put them in a directory of your choice somewhere on local hard disk or network drive. Consult [DRS2 Content Models Reference](#) for guidelines on creating opaque objects. Note that each opaque object can have only one “content” directory in which the contents are
The word “content” is reserved and cannot be used in any directory names that are part of the directory structure of the object itself (i.e. directories nested inside the “content” directory).

- Decide what you will use for Owner Supplied Names (OSNs) for opaque objects. For instance, you could use local classification or local accession numbers. Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

- Make sure that the object OSNs are supplied for each file by one of the following methods:
  - Append the object prefix to each file name (the syntax is [objprefix]--[filename].[ext]). Set the desired file name pattern objects in the BB Options dialog (see Section 1.2.2 for more information).
  - Supply an external mapping file that maps each file to object (see Section 15.1 for more information).

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select **Project > New**.
   b. Enter project data:
      - **Project Name**: enter a name for your project (used for internal tracking only).
      - **Project Directory**: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model**: select the appropriate value ("opaque") from the dropdown.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern**: default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email**: type email and press enter.
      - **Failure Email**: type email and press enter.
      - **Success Method**: choose how you will receive load report.
      - **Deposit Agent**: type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      - **Owner Code**: your owner code (use all caps).
      - **Billing Code**: your billing code (use all caps).
      - **Object Access**: the DRS access flag. Set value to "N" (no access).
c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab. Notable metadata at this level:

d. Admin category: assign a category to every object. A curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.

4. Add directories to template:
   About files in opaque objects: All files that make up the opaque object must be stored in one “content” directory. Any documentation files that describe the opaque content must be stored in a “documentation” directory. The “documentation” directory must be parallel to the “content” directory. There can be only one “content” directory per opaque object.

   **Content directory** (an opaque object can have only one directory named “content”):

   e. Add directory: Right click on “Object Template” in Project Panel on the left and add a directory. Content directories are prefixed with "content" but you can append a custom suffix to the directory name.

   f. Add metadata: click to select the new directory, then add metadata to the form:

      Required:
      First Generation in DRS: select "yes".
      Usage Class: select "LOWUSE".

      Optional:
      Role: There are no roles for content files,

   **Documentation directory** (optional):

   g. Add directory: Right click on “Object Template” in the Project Panel on the left and add a directory. The directory name starts with “documentation” but you can append a custom suffix.

   h. Add metadata: click to select the new directory, then add metadata to the form:

      Required:
      First Generation in DRS: select "yes".
      Usage Class: select "LOWUSE".

      Optional:
      Role: You can select either DOCUMENTATION or LICENSE roles for documentation files. Select any role that applies.

5. Save your work (Project > Save on main menu).

6. Copy files into Batch Builder template directory on disk.

   The directories you created in BB have been created on disk, in the project’s template path:
   {project_name}\template\ 

   In the automatic workflow, files are copied into a directory in the template path. In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.

   Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

   ** Quick way to copy content files: you can drag files from your file system onto the file template directories in the Batch Builder project panel.

   ** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.
7. Create new batch with objects:
   a. **Create new batch:** From the menu select “Object > Create a new batch with objects from template”. Enter the name of the batch directory to be created on disk and click OK.
      
      In response to this action you will see:
      "FINISHED - Moved objects to [batch name]" in the message panel.
      
      A new batch directory with red letter B added to the Project Panel.
      
      New object directories (marked by blue letter O), and file directories nested below the batch directory.
      
      Behind the scenes, BB created the batch and object directories on disk and moved the content files from the `{project_name}\template` directory into the object directories.
   b. **Add optional metadata** for each object and/or each file. Note that required metadata was supplied by the object template.
      
      Select an object directory (or file directory) in the Project Panel and then select the “optional” tab on the right.
      
      **Object metadata:** select the object directory, open the “optional” tab.
      
      Notable metadata types include:
      
      **Aleph ID for MODS import:** import descriptive metadata from Aleph. You can also right-click over the object directory in project panel to assign Aleph ID.
      
      **Admin category:** a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
      
      **Descriptive metadata fields (MODS):** use only if not importing by Aleph ID or including external MODS file.
      
      **File metadata:** select a file directory, open the “optional” tab:
      
      **Admin category:** a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
      
      To import an object description from Aleph, right click on the object directory and select "Set Aleph ID".
   c. **Save your project** (Project > Save on main menu).

8. Process the batch:
   a. In the Project Panel tree, **right click on the batch** you want to process (batch with red letter B) and select “Create descriptors & batch.xml.” Or from the main menu, select Batch > Create descriptors & batch.xml.

   b. Processing messages will appear in the messages pane.

   c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:

9. Upload batch to dropbox:
   a. Open your SFTP client and log into your DRS2 dropbox account.

Revised: April 14, 2015
b. Change to the "incoming" directory.
c. Upload the batch: copy the entire batch directory to the "incoming" directory.
d. Close the SFTP client. Batch processing will start.

10. Check load report in email:
   a. Open your email inbox.
   b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
   c. For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
8. Creating Opaque Container Object Batches

8.1 Accepted formats
8.2 File and directory structure
8.3 Content files
8.4 DRS Documentation files
8.5 Procedures to create a batch

There are two methods you can use to create Opaque Container objects in Batch Builder:

1. Manually create objects from template. This is best when you have less than 5 objects to work with. In this scenario you generate an object structure in BB for each object and then copy files into it (can be done outside BB). See section 8.5 for the procedure.

2. Automatically build objects from template. This method is best for large batches of objects (5 or more objects per batch). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 8.5 for the procedure.

Note that an opaque container object can have only one directory named “container” (where all the content files are stored). Inside the container directory there can one zip file containing files in any format.

Opaque container objects and the files they contain cannot be delivered using DRS delivery systems, such as FDS. Opaque container content can only be downloaded through Web Admin.

8.1 Accepted formats

Files of any format can be deposited as part of an opaque container object. The opaque container itself must be in ZIP format.

8.2 File and directory structure

Inside the single zip file, opaque container objects can contain two types of files – content files (those files being deposited for preservation), and DRS documentation files (files documenting the contents of the opaque container). See Content files and DRS Documentation Files for more information.

When preparing files for batch processing, the files should be arranged under one of two directories: either content or documentation – before the zip file is created. The DRS documentation files should be placed in the documentation directory, all other files should be placed in the content directory. The content directory is required and has to contain at least one file. The documentation directory is optional.

Example 1: Contents of an opaque object storing a presentation

content\the_presentation.ppt
content\the_presentation_audio.mp3
content\the_presentation_video.mpeg
content\the_presentation_handout.pdf
content\the_presentation_notes.doc
documentation\drs_documentation.txt

Example 2: Contents of an opaque object storing a faculty member's research

content\projectx\2005_002.xls
content\projectx\runDemo.exe
8.3 Content files

To the extent possible, care should be taken to only include in a single opaque container object zip file those files that logically make up an object.

Try to include within the same opaque container object’s zip file, files that:

- Are related by derivative relationships (e.g. master and use copies)
- Have display or rendering dependencies (e.g. style sheets, scripts and images should be included in the same opaque container as web pages dependent on them)
- Require the same descriptive metadata (are part of the same work with the same bibliographic record)

Deposit in separate opaque container objects:

- Files which are not related or dependent on each other contextually or structurally
- Files that constitute several independent logical objects

Omit from opaque container objects:

- Content not intended for long-term preservation

Although it is expected that the content of opaque container objects might not be fully appraised or processed prior to deposit into the DRS, to the extent possible depositors should perform an initial weeding out of unwanted material. This is especially important in the case of donated hard drives which may contain applications, system files, cached data, etc.

<table>
<thead>
<tr>
<th>Examples of opaque container object designs</th>
<th>Assessment of design</th>
</tr>
</thead>
<tbody>
<tr>
<td>multiple files related to a single video game</td>
<td>Very good. If the DRS ever supports video game objects the files in this opaque object could be expanded into a fully supported object.</td>
</tr>
<tr>
<td>multiple files related to a single database</td>
<td>Very good. Once the DRS supports database objects the files in this opaque object could be expanded into a fully supported object.</td>
</tr>
<tr>
<td>An object containing one set of RAW camera image files</td>
<td>OK. If you can envision separating them in the future it would be better to only group the ones together that are related to each other. Also if there are other files related to these RAW files (derivative images, etc.) it may be better to group them together so that you don’t have to combine them in the future.</td>
</tr>
<tr>
<td>a set of word processing files</td>
<td>OK. Same reason as for the RAW camera image files.</td>
</tr>
</tbody>
</table>
| one audio file | Good. If there are other files related to this audio file (other derivative audio files, transcripts, etc.) it
may be better to group them together so that you don't have to combine them in the future.

8.4 DRS documentation files

LTS encourages the creation and deposit of documentation within an opaque container object’s zip file to increase the chances that this content can be migrated into fully supportable DRS objects in the future, and so that all information known about this content can be made available to future stewards of this material.

The file names of all documentation files should start with the prefix `drs_documentation`. The files should be located within a directory called `documentation`, as shown in the File and directory structure topic. These documentation files can be one or more text, PDF or spreadsheet files. The recommended formats for these files are:

- If text: plain text (ASCII or UTF-8 encoding) (*.txt) or OpenDocument Text (*.odt)
- If PDF: PDF/A-1a (*.pdf)
- If spreadsheet: OpenDocument Spreadsheet (*.ods)

These files may include information about file relationships within an opaque container object’s zip file, documentation of original order, licenses or donor agreements, etc. Files describing original order or rights should be named according to the following guidelines.

**Documenting original order**

In keeping with archival practice, depositors are encouraged to document the original order and structure of files as they are submitted to them, especially when large file sets are split into separate opaque container objects. The DRS documentation file that documents the original order should conform to the recommended formats listed above, and be deposited with all relevant opaque container objects (those split from the original order). The file names of these files should start with the prefix `drs_documentation_original_order`.

**Documenting rights**

It is recommended that Donor agreements and other licenses should be loaded as separate objects to the DRS, before the opaque container objects are loaded. See 19. Adding Licenses, Documentation and Other Supporting Content for more information. When opaque container objects are created in Batch Builder, an object URN of the related rights object can be inserted in object Optional metadata panel.

8.5 Procedures to create a batch

8.5.1 Manually build Opaque Container objects from template

8.5.2 Automatically build Opaque Container objects from template

8.5.1 Manually build Opaque Container objects from template

This is a description of the procedure to manually create a batch of opaque container objects from template in Batch Builder 2 (BB). This method should be used if you have less than 5 objects per batch.

**Procedure summary:**

1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Add metadata
6. Save your work
7. Create a new object batch
8. Move/copy files into corresponding directories on disk
9. Process the batch

What you need before you start:

- Prepare several opaque container object zip files and put them in a directory of your choice somewhere on local hard disk or network drive. Consult DRS2 Content Models Reference for guidelines on creating opaque container objects.
- Decide what you will use for Owner Supplied Names (OSNs) for opaque container objects. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.

Procedure:

1. Create a new project.
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “opaque container” from the dropdown; click OK to continue.

2. Enter DRS deposit settings.
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:

   Batch Name Pattern: default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}

   (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

   Success Email: type email and press enter.
   Failure Email: type email and press enter.
   Success Method: choose how you will receive load report.
   Deposit Agent: type your HUID.

3. Create object template
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter DRS Owner Code for objects you will be depositing (use all caps).
   c. Enter DRS Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
4. **Add directories to template.**

**Container directory**

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “container” but you can append a custom suffix).

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

**Documentation directory (optional)**

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “documentation” but you can append a custom suffix).

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

Go to Project menu in the top menu bar and choose **Save** to save your project.

5. **Save your work:** Project > Save on main menu.

6. **Create a new object batch.**

a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the left (icon with red letter B).

b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.

c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.

d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections **17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content**. Note that any metadata entered at the object level will override metadata entered at the template level.

e. Repeat b-d if you have more than object.

7. **Move/copy zip files into corresponding file directories on disk.**

(Can be done outside Batch Builder)

The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory
structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right.

a. Copy the zip files into the corresponding container directory in the object directory.
b. Repeat if you have more than one object.

8. **Process the batch.**
   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
   b. Builder will start processing the batch.
   c. When the batch is successfully processed you will see the following message:
      
      `FINISHED - Creation of batch.xml and descriptors complete for batch: …`

8.5.2 **Automatically build Opaque Container objects from template**

This is a description of the procedure to automatically create a batch of opaque container objects from template in Batch Builder 2 (BB). This method should be used if you have 5 or more opaque container objects per batch.

**Procedure summary:**

1. Create a new project
2. Enter DRS deposit settings
3. Create object template
4. Add directories to template
5. Add metadata
6. Save your work
7. Move/copy zip files into corresponding directories on disk
8. Create new batch with objects
9. Process the batch
10. Upload batch to dropbox
11. Check load report in email

**What you need before you start:**

- Prepare your opaque container objects and put them in a directory of your choice somewhere on local hard disk or network drive. Consult [DRS2 Content Models Reference](#) for guidelines on creating opaque container objects. Note that each opaque container object can have only one “container” directory in which the zip files are contained.

- Decide what you will use for Owner Supplied Names (OSNs) for opaque container objects. For instance, you could use local classification or local accession numbers. Consult section 3 [Naming rules for files, objects and directories](#) of this Guide for more information.

- Make sure that the object OSNs are supplied for each file by one of the following methods:
ο Append the object prefix to each file name (the syntax is [objprefix]--
[filename].[ext]). Set the desired file name pattern objects in the BB Options dialog (see section 1.2.2 for more information).

OR

ο Supply an external mapping file that maps each file to object (see section 15.1 for more information).

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select **Project > New**.
   b. Enter project data:
      - **Project Name**: enter a name for your project (used for internal tracking only).
      - **Project Directory**: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model**: select the appropriate value ("opaque container") from the dropdown.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern**: default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email**: type email and press enter.
      - **Failure Email**: type email and press enter.
      - **Success Method**: choose how you will receive load report.
      - **Deposit Agent**: type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific batch-, object-, or directory-level metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      - **DRS Owner Code**: your owner code (use all caps).
      - **DRS Billing Code**: your billing code (use all caps).
      - **Object Access**: the DRS access flag. Set value to "N" (no access).
   c. Enter optional admin and descriptive metadata to the object template. Click the “optional” tab.
   Notable metadata at this level:
   - **Admin category**: assign a category to every object. A curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.
4. Add directories to template:

**About files in opaque container objects:** The zip file that makes up an opaque container object must be stored in one “container” directory.

a. **Add container directory:** right click on “Object Template” in Project Panel tree. Container directories are prefixed with ”container”, but you can append a custom suffix to the directory name.

b. **Add documentation directory** (optional): Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “documentation” but

5. **Add metadata:** For each added directory, click to select the new directory, then add metadata to the form:

a. Required:
   - **First Generation in DRS:** select "yes".
   - **Usage Class:** select "LOWUSE".

6. Save your work (Project > Save on main menu).

7. Copy files into Batch Builder template directory on disk.

The directories you created in BB have been created on disk, in the project’s template path:

{project_name}\template\container{optional addition suffix}

In the automatic workflow, files are copied into a directory in the template path. In a later step, Batch Builder will use the object name prefix for each file to create object directories and move files for each object into these directories.

**Note:** if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

** Quick way to copy content files: you can drag files from your file system onto the file template directories in the Batch Builder project panel.

** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.

** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.

8. Create new batch with objects:

a. **Create new batch:** From the menu select “Object > Create a new batch with objects from template”. Enter the name of the batch directory to be created on disk and click OK.

   In response to this action you will see:

   "FINISHED - Moved objects to [batch name]" in the message panel.

   A new batch directory with red letter B added to the Project Panel.

   New object directories (marked by blue letter O), and file directories nested below the batch directory.

   Behind the scenes, BB created the batch and object directories on disk and moved the content files from the {project_name}\template directory into the object directories.

b. **Add optional metadata** for each object and/or each file. Note that required metadata was supplied by the object template.
Select an object directory (or file directory) in the Project Panel and then select the “optional” tab on the right.

Object metadata: select the object directory, open the “optional” tab.

Notable metadata types include:

**Aleph ID for MODS import:** import descriptive metadata from Aleph. You can also right-click over the object directory in project panel to assign Aleph ID.

**Admin category:** a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.

**Descriptive metadata fields (MODS):** use only if not importing by Aleph ID or including external MODS file.

**File metadata:** select a file directory, open the “optional” tab:

**Admin category:** a curator-assigned label, such as an exhibit name, project name, etc., that can be used to group together a set of objects or files.

To import an object description from Aleph, right click on the object directory and select "Set Aleph ID".

c. **Save your project** (Project > Save on main menu).

9. Process the batch:

a. In the Project Panel tree, **right click on the batch** you want to process (batch with red letter B) and select “Create descriptors & batch.xml.” Or from the main menu, select Batch > Create descriptors & batch.xml.

b. Processing messages will appear in the messages pane.

c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:

10. Upload batch to dropbox:

a. Open your SFTP client and log into your DRS2 dropbox account.

b. Change to the "incoming" directory.

c. Upload the batch: copy the entire batch directory to the "incoming" directory.

d. Close the SFTP client. Batch processing will start.

11. Check load report in email:

a. Open your email inbox.

b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"

c. For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel.
9. Creating Document (PDF) Object Batches

9.1 Accepted formats

- Portable Document Format
- PDF/A
- PDF/X

9.2 Manually create document objects from template

This is a description of the procedure to create a simple batch of Document (PDF) objects from template BB. Use this method when only several document objects need to be created, processed in BB and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically.

Procedure summary:
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Create a new object batch.
6. Move/copy files into corresponding directories on disk.
7. Process the batch.

**What you need before you start:**
- Prepare several PDF files and put them in a directory of your choice somewhere on local hard disk or network drive.
- Decide what you will use for Owner Supplied Names for Document objects and the digital files (PDFs) they consist of. For instance, you could use local classification or local accession numbers. Consult Section 3 Naming rules for files, objects and directories of this Guide for more information.

**Procedure:**
**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select **Project > New**
   b. Configure Batch Builder to ignore file validation errors (necessary when processing most types of PDF files). From the main menu, select View > Options. Check “Ignore file validation errors” and then click OK.
   c. Enter project data:
      - **Project Name:** enter a name for your project (used for internal tracking only).
        TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. software_documentation_project)
      - **Content Model:** select the "document" value from the dropdown.
      - **Project Description (optional):** Any information relevant to the project – will only remain locally.
   d. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}{mo}{dd}_{hh24}{mm}{ss}
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email:** type email and press enter.
      - **Failure Email:** type email and press enter.
      - **Success Method:** choose how you will receive load report.
      - **Deposit Agent:** type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
**Owner Code:** your owner code (use all caps).

**Billing Code:** your billing code (use all caps).

**Object Access:** the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.

**URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).

**File URN Resource Name Pattern:** use default value \{n\} to generate a unique number.

c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. **Add directories to template.**
   a. Right click on “Object Template” in the Project Panel on the left and select the ‘add a directory…’ menu option.
   b. Type in a name for your directory in the text box. The directory name will start with “document” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_diary_pdf’ will result in a directory called ‘document_diary_pdf’
   c. In the Project Panel on the left select the directory you just created.
   d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
   e. Choose “HIGHUSE” for Usage Class.

**Add additional metadata (optional):**
   a. Select the new directory in the Project Panel on the left
   b. In the Content Panel, select the ‘optional’ tab.
   c. Scroll down to ”Document Object Metadata “
   d. Enter any file level optional metadata in the form
      
      **Role:** use Ctrl Click to select ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

5. Save your work (Project > Save on main menu).

6. **Create new batch with objects:**
   Metadata added at this level can be applied to a specific object, or specific file directory.
   a. **Create new batch:** select “Batch > New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk). Click OK.
      Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.
   b. Select the batch (with the red letter B) in the Project Panel
   c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and click OK.
   d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object (blue letter O)
e. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note: any metadata entered at the object level will override metadata entered at the template level.

f. Repeat b-e if you have more than object.

7. Save your project (Project > Save on main menu).

8. Copy image files into batch object directories on disk (can be done outside Batch Builder). Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.

   ** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.

   ** If using mapping.txt, this is when you should copy it to the auxiliary object path in the project.

   ** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary object path in the project.

9. Process the batch:

   a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

   b. Processing messages will appear in the messages pane.

   c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch:

10. Upload batch to dropbox.

    a. Open your SFTP client and log into your DRS2 training dropbox account.

    b. Change to the "incoming" directory.

    c. Upload the batch: copy the entire batch directory to the "incoming" directory.

    d. Close the SFTP client. Batch processing will start.

11. Check load report in email.

    a. Open your email inbox.

    b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"

    For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel. If you see any error messages, remedy the errors and re-process the batch.

9.3 **Automatically create document objects from template**

This is a description of the procedure to automatically build a batch of Document (PDF) objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more than 10) that need to be created and your source files are not broken into directories by object. (e.g. you have 100 PDF files in a directory on disk).

**Procedure summary:**
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Move/copy files into template directory.
6. Add object name prefix to file names or supply mapping.txt file.
7. Create new object batch.
8. Process the batch.

**What you need before you start:**

- Prepare the PDF files and put them in a directory of your choice somewhere on local hard disk or network drive.

- Decide what you will use for owner supplied names for document objects and the PDF files they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.

- Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: \[obj-osn\]--\[file_name\].\[extension\]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see Section 1.2.2. For more details about external mapping files see Section 15.1.

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   
   a. From main menu select **Project > New**.

   b. Configure Batch Builder to ignore file validation errors (necessary when processing most types of PDF files). From the main menu, select View > Options. Check “Ignore file validation errors” and then click OK.

   c. Enter project data:
      
      **Project Name:** enter a name for your project (used for internal tracking only).

      **Project Directory:** select the directory where project will be saved (click ellipsis button to browse for or create a directory).

      TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. software_documentation_project)

      **Content Model:** select the "document" value from the dropdown.

      **Project Description (optional):** Any information relevant to the project – will only remain locally.

   d. Click OK to continue.

2. Enter DRS deposit settings:
   
   a. Click on “Deposit Settings” in Project Panel tree.
b. Enter deposit data in the form:

**Batch Name Pattern:** `default - {owner}_ {batchDir}_ {yyyy} {mo} {dd} _{hh24} {mm} {ss}`

(This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

**Success Email:** type email and press enter.

**Failure Email:** type email and press enter.

**Success Method:** choose how you will receive load report.

**Deposit Agent:** type your HUID.

3. Create object template:

Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.

a. Click on “Object Template” in Project Panel tree:

b. Enter required object metadata in the form:

- **Owner Code:** your owner code (use all caps).
- **Billing Code:** your billing code (use all caps).
- **Object Access:** the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
- **URN Authority Path:** your NRS authority path. Use all caps. Look up your Path here if needed: [http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod](http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod).
- **File URN Resource Name Pattern:** use default value `{n}` to generate a unique number.

c. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

4. Add directories to template:

In automatic object workflow, you create role-based directories (archival master, deliverable) and in a later step, Batch Builder will create the objects for you.

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.

b. Type in a name for your directory in the text box. The directory name will start with “document” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_PDFs’ will result in a directory called ‘document_PDFs’

c. In the Project Panel on the left select the directory you just created.

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

e. Choose “HIGHUSE” for Usage Class.

**Add additional metadata:**

a. Select the new directory in the Project Panel on the left

b. In the Content Panel, select the ‘optional’ tab.

c. Scroll down to “Document Object Metadata”
d. Enter any file level optional metadata in the form
   
   **Role:** use Ctrl Click to select ARCHIVAL_MASTER and DELIVERABLE roles. Note that in order to get a delivery URN on deposit a file needs to have a role DELIVERABLE set in BB.

5. Save your work (Project > Save on main menu).

6. **Copy files into** Batch Builder template directory on disk (can be done outside Batch Builder)
   
   a. The directories you created in BB have been created on disk, in the project’s template path:

   b. `{project_name}\template\`

   c. In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object. See [Naming Rules for Objects](#) for how to add an object name prefix. See [Using mapping.txt file](#) for how to create a mapping file.

   d. Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom

   e. **Quick way to copy content files:** you can drag files from your file system onto the object template directories in the Batch Builder project panel.

   f. **If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.**

   g. **If including external MODS descriptive metadata, this is when you should copy it to the auxiliary template path in the project.**

9. **Create a new object batch.**

   You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

   **In the Graphical User Interface**

   a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

   b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

   c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

   d. Save the project to have BB2 write the new metadata values to the internal configuration files.

   **In the Command Line Interface**

   a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:

   ```
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.38
   ```
Type `batchbuildercli -a buildtemplate -p [project_directory_path] -b [batch_directory_name]`, e.g.:

```
batchbuildercli -a buildtemplate -p "E:\My Project" -b batch1
```

Note that the batch directory name is the name of your new batch directory, to be created by BB.

b. If the batch creation is successful you will see the following messages:

```
Initializing BB...
Done!
Creating batch1 and objects from files in the template...
Success!
```

10. **Process the batch.**

You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)

**In the Graphical User Interface**

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

When the batch is successfully processed you will see the following message: **FINISHED - Creation of batch.xml and descriptors complete for batch: ...**

If you see any error messages, remedy the errors and re-process the batch.

**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:

```
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
```

Type `batchbuildercli -a build -p [project_directory_path] -b [batch_directory_name]`, e.g.:

```
batchbuildercli -a build -p "E:\My Project" -b batch1
```

b. (Optional) add additional parameters to the `batchbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

c. When the batch is successfully processed you will see the following messages:

```
Building PREMIS file metadata...
Building HulDrsAdmin file metadata...
Success!
```

If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).

### 9.4 Depositing a thesis object

DRS supports deposit of digitized theses and dissertations and associated supporting content.
A thesis object can consist of a single PDF file or multiple PDFs representing the same thesis (for example, an original PDF and a PDF/A file derived from it, an archival version and a reduced size delivery version, or the redacted and unredacted versions of a thesis). Every file with the role Deliverable will be assigned a delivery URN. The deliverable files in thesis objects are delivered by the File Delivery Service (FDS). The delivery restrictions are governed by DRS access flags (P = public; R = restricted to Harvard community; N = no delivery).

Optional supporting content can consist of thesis certificates (if supplied as separate from the thesis file), thesis supplements, embargo documentation, and licenses. See more about preparing supporting content for DRS in the section “Preparing supporting content” below.

What follows are instructions on how to prepare a thesis object and supporting content for deposit.

Preparing a thesis object

Preparing supporting content

Preparing a thesis object

To deposit a thesis object, follow the regular manual or automatic workflow for creating a Document batch. Use these metadata values:

- **Object-level Role:** THESIS.
- **File-level Processing** value: leave blank, except for a redacted version of the thesis, which should be coded as REDACTED.
- **File-level Role:** assign DELIVERABLE to get a Delivery URN for the PDF file. Optionally, assign role ARCHIVAL_MASTER to the original file. If there is only one file in the thesis, then assign both roles to the file (Ctrl-Click in Batch Builder to assign multiple roles).

Preparing supporting content

A thesis object may be accompanied by any of the following supporting content: thesis certificate, thesis supplement, embargo documentation, license documentation.

Supporting content must be deposited to DRS and associated with the thesis object through relationship and/or rights metadata. There are three options for depositing supporting content:

- **Deposit supporting content to DRS first, in a separate batch.** After supporting content is deposited, the supporting Object URN can be used to link it to the regular content. Use the corresponding relationships fields in Batch Builder to link regular objects to supporting content when creating a regular content batch.
- **Deposit supporting content and regular content in the same batch.**
  - In this case, Object Owner Supplied Name rather than Object URN is used for linking. When placing supporting content and regular content in the same batch, make sure that the supporting objects are named in such a way that the Object Owner Supplied Name of the supporting object (the target of the relationships) occurs alphabetically before the Object Owner Supplied Name of the regular content object (the source of the relationship). This is needed because in order for the relationship to be created correctly, the supporting object needs to be ingested into DRS before the regular object.
- **Deposit supporting content after regular content** (applies to all supporting content, including license and embargo objects).
  - If depositing supported content after the regular content objects have been deposited to DRS, the relationships between the supporting content objects and regular content objects will need to be
created in DRS Web Admin after both types of objects have been deposited. This option is not currently recommended for large volume workflows.

See the procedure for depositing supporting content in Section 19 “Adding Licenses, Documentation and Other Supporting Content.”

Types of supporting content for theses

**Thesis certificate**: Certificate of approval that specifies a thesis or doctoral dissertation was approved in partial fulfillment of requirements for the degree. Most of the time, the certificate is included as part of the thesis and thus does not need to be deposited as a separate object. When the certificate is a separate file, it should be deposited as a separate supporting object. Certificates must be in PDF format and should be deposited using content model Document. The object role for certificates should be set to “THESIS_CERTIFICATE”. There can be only one certificate associated with a thesis.

To relate a certificate object to the thesis object:

- If deposited before thesis object: Get the certificate’s object URN from the load report, create the thesis object batch and add the object URN to “Has Documentation Object” field in object-level optional metadata in Batch Builder.

- If deposited in the same batch with the thesis object, use certificate Owner Supplied Name in “Has Documentation Object” field of the thesis object in object-level optional metadata in Batch Builder.

- If deposited after thesis object: Display the thesis object in Web Admin, select “Relationships” tab, add a HAS_DOCUMENTATION relationship and link to the certificate by its DRS ID, URN or Owner Supplied Name.

**Thesis supplement**: Supplementary material included with a thesis, such as Power Point presentations, audio, video, appendixes, raw data, CAD files, etc. There is no limit on the number of supplemental objects a thesis can have. Any of the following content models can be used for thesis supplements: Audio, Document, Opaque, Still Image, or Text. Use the THESIS_SUPPLEMENT role at the object level.

To relate a thesis supplement to the thesis object:

- If deposited before thesis object: Get the supplement’s object URN from the load report, create the thesis object batch and add the object URN to “Has Supplement Object” field in object-level optional metadata.

- If deposited in the same batch with the thesis object, use supplement Owner Supplied Name in “Has Supplement Object” field of the thesis object in object-level optional metadata in Batch Builder.

- If deposited after thesis object: Display the thesis object in Web Admin, select “Relationships” tab, add a HAS_SUPPLEMENT relationship and link to the supplement by its DRS ID, URN or Owner Supplied Name.

**Embargo documentation**: If there is an access embargo on the thesis object, documentation about the embargo can be deposited as supporting content. This documentation describes the embargo requirements, such as embargo start/end date and reasons for the embargo. Batch Builder can associate only one embargo document with a thesis object, and the embargo document must be deposited using the Document object content model (a PDF file). The embargo document should have the EMBARGO_DOCUMENTATION role set at the object level.
To relate embargo documentation to the thesis object:

- If deposited before thesis object: Get the documentation’s object URN from the load report, create the thesis object batch, fill out the “Embargo Rights” metadata section in object-level optional metadata (insert the object URN into the “Documentation Object URN” field in that section).

- If deposited in the same batch with the thesis object, enter the documentation’s Owner Supplied Name into the “Documentation Object” field of the Embargo Rights section of the thesis document object.

- If deposited after thesis object: Display the thesis object in Web Admin, select “Rights” tab, add/fill out a Rights block and link to the embargo documentation by selecting its owner supplied name from the Rights Document pull down list.

License: If the thesis has conditions on use, a license detailing these conditions should be deposited also. The license can be deposited using the Document, Still Image, or Text content model using an object-level role “LICENSE”.

The license objects can be deposited in the same batch with thesis objects.

To relate license documentation to the thesis object:

- If deposited before thesis object: Get the documentation’s object URN from the load report, create the thesis object batch, insert the object URN into the “License” field in the Other Rights Documentation section in object-level optional metadata.

- If deposited in the same batch with the thesis object, enter the license Owner Supplied Name into the “License” in the Other Rights Documentation section of the object-level optional metadata.

- If deposited after thesis object: Display the thesis object in Web Admin, select “Rights” tab, add/fill out a Rights block and link to the embargo documentation by selecting its owner supplied name from the Rights Document pull down list.
10. Creating Text Object Batches

10.1 Accepted formats

- Standard Generalized Markup Language (MIME type: text/sgml)
- Extensible Markup Language (MIME type: text/xml)
- Plain Text (MIME type: text/plain)

10.2 Manually create text objects from template

This is a description of the procedure to manually create a batch of Text objects from template in Batch Builder 2 (BB). Use this method when only several Text objects need to be created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically.

Procedure summary:

1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Create new object batch.
6. Move/copy files into corresponding directories on disk.
7. Process the batch.

What you need before you start:
• Prepare several text files and put them in a directory of your choice somewhere on local hard disk or network drive.

• Decide what you will use for Owner Supplied Names for your Text objects and the digital files they consist of. For instance, you could use local classification or local accession numbers. Section 3 of this Guide for more information about file and object Owner Supplied Names.

**Procedure:**

1. **Create a new project.**
   
   a. Open BB by double clicking on the executable.
   
   b. From the Project menu select New.
   
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “text” from the dropdown; click OK to continue.

2. **Enter DRS deposit settings.**
   
   a. Click on “Deposit Settings” in Project Panel tree.
   
   b. Enter deposit data in the form:

   **Batch Name Pattern**: default - \{owner\}_\{batchDir\}_\{yyyy\}_\{mo\}_\{dd\}_\{hh24\}_\{mm\}_\{ss\}  

   (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

   **Success Email**: type email and press enter.

   **Failure Email**: type email and press enter.

   **Success Method**: choose how you will receive load report.

   **Deposit Agent**: type your HUID.

3. **Create object template (called “batch template” in BB 1).**
   
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   
   b. Enter Owner Code for objects you will be depositing (use all caps).
   
   c. Enter Billing Code for objects you will be depositing (use all caps).
   
   d. Select DRS Access Flag value for objects you will be depositing.
   
   e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.
   
   f. Enter File URN Resource Name Pattern.
   
   g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

4. **Add directories to template.**
   
   a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “text” but you can append a custom suffix).
b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

e. Note about Role: For text objects, role at the file directory level is optional. In any case, there is no “deliverable” role at this level and one is not needed since the DRS loader automatically generates a delivery URN for text files.

f. Go to Project menu in the top menu bar and choose Save to save your project.

5. Create new object batch.

a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the left (icon with red letter B).

b. From the Object menu select New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.

c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.

d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your object). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

e. Repeat if you have more than object.

6. Move/copy files into corresponding file directories on disk.

(Done outside Batch Builder)

The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right.

a. Copy the files into corresponding file directories in the object directory.

b. Repeat if you have more than one object.

7. Process the batch.

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message:

FINISHED - Creation of batch.xml and descriptors complete for batch: …

If you see any error messages, remedy the errors and re-process the batch.
10.3 *Automatically build text objects from template*

This is a description of the procedure to automatically build a batch of Text objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that need to be created and your source files are in directories that are not broken by object.

**Procedure summary:**
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directives to template.
5. Move/copy files into template directories.
6. Add object name prefix to file names or supply a mapping.txt file.
7. Create new object batch.
8. Process the batch.

**What you need before you start:**

- Prepare a dozen of text files and put them in a directory of your choice somewhere on local hard disk or network drive.

- Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See Section 3 for more information about owner supplied names.

- Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: `[obj-osn]--[file_name].[extension]`) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see Section 1.2.2. For more details about external mapping files see Section 15.1.

**Procedure:**

1. **Create a new project.**
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “text” from the dropdown; click OK to continue.

2. **Enter DRS deposit information.**
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:

   **Batch Name Pattern:** default - `{owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}`

   (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
Success Email: type email and press enter.
Failure Email: type email and press enter.
Success Method: choose how you will receive load report.
Deposit Agent: type your HUID.

3. Create object template (called “batch template” in BB 1).
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter Owner Code for objects you will be depositing (use all caps).
   c. Enter Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
   e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.
   f. Enter File URN Resource Name Pattern.
   g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

4. Add directories to template.
   a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “text” but you can append a custom suffix).
   b. In the Project Panel on the left select the directory you just created.
   c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
   d. Choose “HIGHUSE” for Usage Class.
   e. Note about Role: For text objects, role at the file directory level is optional. In any case, there is no “deliverable” role at this level and one is not needed since the DRS loader automatically generates a delivery URN for text files.
   f. Go to Project menu in the top menu bar and choose Save to save your project.

5. Move/Copy files into template directory.
   (Done outside Batch Builder)
   Once you added directories to Object Template in BB, they were also created on disk. The directory structure on disk is the same as what you see in the Project Panel in Batch Builder when you expand the Object Template icon, but on disk the Object Template directory is called “template.” If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel and take a look at the Project Path field at the bottom of the main metadata panel.
   Copy files to the corresponding text directory inside the template directory.

6. Add object name prefix to file names or supply a mapping.txt file.
   In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.
**Add an object owner supplied name as a prefix** to the name of each file. The prefix needs to be separated from the file name by the special separator string “--”. E.g.: `obj1--file1.txt` is a file name that tells Batch Builder that this particular file needs to be part of object `obj1`.

**Provide a mapping file** `mapping.txt` placed in the project `/_aux/template` directory which maps each file to an object owner supplied name.

Syntax:
```
relative_file_path, file_OwnerSuppliedName, PDS_sequence
number(optional), object_OwnerSuppliedName
```

Example:
```
document\379129.txt,FILEOSN1,,Obj1
```
```
document\4541102.txt,FILEOSN2,,Obj2
```

**Notes on syntax:** There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so that Batch Builder can associate the right value with the right element. For example, when using `mapping.txt` file for objects other than PDS Documents, an extra comma needs to be inserted between the FILE OSN value and Object OSN value where PDS sequence number value would be expected.

7. **Create a new object batch.**

You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

**In the Graphical User Interface**

a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to add any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
```
cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
```

Type `batchbuildercli` –a buildtemplate –p [project_directory_path] –b [batch_directory_name], e.g.:
batchbuildercli -a buildtemplate -p "E:\My Project" -b batch1

Note that the batch directory name is the name of your new batch directory, to be created by BB.

b. If the batch creation is successful you will see the following messages:

   Initializing BB...
   Done!
   Creating batch1 and objects from files in the template...
   Success!

8. **Process the batch.**

   You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)

   **In the Graphical User Interface**
   
   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

   b. Builder will start processing the batch.

   c. When the batch is successfully processed you will see the following message: **FINISHED - Creation of batch.xml and descriptors complete for batch: …**

If you see any error messages, remedy the errors and re-process the batch.

   **In the Command Line Interface**

   a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:

   ```
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
   ```

   Type `batchbuildercli` -a build -p [project_directory_path] -b [batch_directory_name], e.g.:

   ```
   batchbuildercli -a build -p "E:\My Project" -b batch1
   ```

   b. (Optional) add additional parameters to the `batchbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

   c. When the batch is successfully processed you will see the following messages:

   ```
   Building PREMIS file metadata...
   Building HulDrsAdmin file metadata...
   Success!
   ```

   If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).

10.4 **Create and deposit audio playlists as text objects**

   Batch Builder 2 allows processing and deposit of AES-60 audio playlists for existing deliverable audio files in DRS 2. The audio files need to be referenced in the playlist file, so the audio objects need to be deposited first. For instructions on depositing audio files see Section 13 of this document.
What is a playlist?

An audio playlist is an XML file that contains descriptive and structural metadata about streaming audio delivered from DRS 2. Streaming audio represented by an audio playlist can contain one or more audio files or/and one or more segments from the same audio file.

DRS 2 audio playlists are created according to the AES-60 specification, which addresses “the creation, management and preservation of material that can be re-used as originally produced, or may provide input material for new production projects.”

Audio playlists are deposited to the DRS as Text Objects and are linked to audio files by a HAS_PRESENTATION relationship, where the audio file is the source and the Playlist object is the target of the relationships. The HAS_PRESENTATION relationship between the Playlist Text Object and the audio files it references is created by DRS automatically on ingest.

In the AES-60 playlist file, descriptive information about the streaming audio is recorded in the topmost section of the file. The <identifier> element that identifies the work is required, while additional elements are optional. Structural information about audio tracks is located in <part> elements that follow descriptive information.

Here is an example of the descriptive information entered into the audio playlist file for the audio work “Poetry Reading – E.E. Cummings”:

Example:

```
<title>
  <dc:title>Poetry Reading - E.E. Cummings </dc:title>
</title>
<creator>
  <contactDetails>
    <name>
      <name> E.E. Cummings </name>
    </name>
  </contactDetails>
  <role typeLabel="Author"/>
</creator>
<subject>
  <dc:subject>Chaire. Selections</dc:subject>
</subject>
<description>
  <dc:description>1 sound tape reel (21 min.) : 7 1/2 ips ; 7 in.
  1/2 in. tape.
</dc:description>
<publisher>
  <contactDetails>
    <name>
      <name>Woodberry Poetry Room</name>
    </name>
  </contactDetails>
</publisher>
```
Following descriptive information, for each streaming track a <part> block which includes structural and administrative metadata is inserted. Here is an example for one of the tracks:

Example:

```xml
<part>
  <title>
    <dc:title>Untitled Region</dc:title>
  </title>
  <format>
    <start>
      <editUnitNumber editRate="44100" factorNumerator="1" factorDenominator="1" startRate="44100" factorNumerator="1" factorDenominator="1">0</editUnitNumber>
    </start>
    <duration>
      <editUnitNumber editRate="44100" factorNumerator="1" factorDenominator="1" startRate="44100" factorNumerator="1" factorDenominator="1">21168</editUnitNumber>
    </duration>
  </format>
  <identifier>
    <dc:identifier>PS3505U334C52x1953_DM_01_01_{D579DB08-1A5B-47C5-9750-E10FA86AD1F7}</dc:identifier>
  </identifier>
</part>
```

The required elements in each <part> block are <title>, <format> and <identifier>.

<title>
contains track title, that is displayed by SDS.

<format>
contains track `<start>` and `<duration>` elements, which supply information that tells SDS at which point in the audio file SDS should start and stop playing the audio.

The start and duration of each track are indicated by an element `<editUnitNumber>`, the value of which represents the number of samples (the count starts at sample 0 at the beginning of the track). In the example above, SDS will start playing the track at sample 0 (at the very beginning) and stop playing at sample 21168.

`<identifier>`

element contains the reference to the audio file that is being played.

The value that is supplied in the `<identifier>` element should be the file Owner Supplied Name of the deliverable audio file in the DRS being referenced by the playlist. After deposit to DRS, the value in the `<identifier>` element is automatically converted to a URN of the referenced audio file.

Example:

Before DRS deposit:

```xml
<identifier>
  <dc:identifier>PS3505U334C52x1953_DM_01_01_{D579DB08-1A5B-47C5-9750-E10FA86AD1F7}</dc:identifier>
</identifier>
```

After DRS deposit:

```xml
<identifier>
  <dc:identifier>urn-3:FHCL.MUSI:12345</dc:identifier>
</identifier>
```

**How do I create a playlist?**

1. Use an AES-60 Playlist for DRS example to start:
   
   [http://hul.harvard.edu/ois/systems/drs/docs/aes60example.xml](http://hul.harvard.edu/ois/systems/drs/docs/aes60example.xml)

2. Open this file in an XML editor and substitute values with information that is relevant to your audio file(s). Note that in the descriptive information section preceding `<part>`, only `<dc:title>` is required. You can optionally enter more descriptive metadata or you can delete the tags you will not be using. In the `<part>` block for each track only `<dc:title>` , `<format>` (and all the sub-elements of `<format>`) and `<identifier>` (and the `<dc:identifier>` sub-element) are required. `<creator>` and `<contributor>` are optional. The `<dc:identifier>` sub-element should include the file Owner Supplied Name of the audio file in the DRS that the playlist is referring to. Because the playlists refer to audio in DRS by file Owner Supplied Name, the audio files need to have the file Owner Supplied Names that are unique within the Owner Code. This only applies to audio files that playlists refer to. If you are not using or ever plan to use a playlist you do not need to keep the file Owner Supplied Name of the audio file in DRS unique within the Owner Code.

3. Once you create the playlist file, use the instructions in Section 10.2 or 10.3 to create and process a text object batch that contains the playlist file. Once the text object containing the playlist file is deposited into the DRS, you will get a successful DRS report, containing a delivery URN for the file that will resolve to a Streaming Delivery Service URL which will deliver the playlist and the audio it is referring to.
Here is an example of an audio with a playlist being delivered in Streaming Delivery Service:

![Audio Player Image]

Note, that playlists only deliver streaming audio. You cannot download audio when using playlists. If you would like your users to download audio, then you should distribute audio URNs that resolve to the File Delivery Service. These URNs are automatically created along with the Streaming Delivery Service URNs when you deposit audio files into the DRS. See Section 10 for more details about depositing audio into the DRS.
11. Creating Color Profile Object Batches

11.1 Accepted formats

The following format is accepted for files contained in color profile objects:

- ICC File Format for Color Profiles (MIME type: application/x-icc)

11.2 Manually create color profile objects from template

This is a description of the procedure to manually create a batch of color profile objects from template in Batch Builder 2 (BB). Use this method when only several color profile objects need to be created, processed in Batch Builder (BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically.

**Procedure summary:**

1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directory to template.
5. Create new object batch.
6. Move/copy files into corresponding directories on disk.
7. Process the batch.

**What you need before you start:**

- Prepare several color profile files and put them in a directory of your choice somewhere on local hard disk or network drive.

11.3 Automatically create color profile objects from template

There are three methods you can use to create Text objects in Batch Builder:

1. Manually create objects from template. This is best when you have only one or two color profile objects to work with. In this scenario you generate in BB an object structure for each object and then copy files into it (can be done outside BB). See section 11.2 for the procedure.

2. Automatically build objects from template. This method is best for large batches of objects (over 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 11.3 for the procedure.

3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. Because this option will be rarely used, it is not currently documented.

Revised: April 14, 2015
• Decide what you will use for Owner Supplied Names for your color profile objects and the digital files they consist of. See Section 3 of this Guide for more information about file and object Owner Supplied Names.

**Procedure:**

1. **Create a new project.**
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “color profile” from the dropdown; click OK to continue.

2. **Enter DRS deposit settings.**
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}

      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. **Create object template (called “batch template” in BB 1).**
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter DRS Owner Code for objects you will be depositing (use all caps).
   c. Enter DRS Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
   e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.
   f. Enter File URN Resource Name Pattern.
   g. Switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.
   h. Leave the default Role in the Color Profile Object Metadata section as COLOR_PROFILE

4. **Add directories to template.**
   a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “color _profile” but you can append a custom suffix).
   b. In the Project Panel on the left select the directory you just created.
c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

Go to Project menu in the top menu bar and choose Save to save your project.

5. **Create new object batch.**

a. From the Batch menu select “New”; enter the name of the new batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the left (icon with red letter B).

b. Select the new Batch, then select New from the Object menu. Leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.

c. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.

d. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your object). For more about optional metadata see sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

e. Repeat if you have more than one object.

6. **Move/copy files into corresponding file directories on disk.**

(Can be done outside of Batch Builder)

The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right.

a. Copy the files into corresponding file directories in the object directory.

b. Repeat if you have more than one object.

7. **Process the batch.**

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message: **FINISHED - Creation of batch.xml and descriptors complete for batch: …**

If you see any error messages, remedy the errors and re-process the batch.

### 11.3 Automatically build color profile objects from template

This is a description of the procedure to automatically build a batch of color profile objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that need to be created and your source files are in directories that are not broken down by object.

**Procedure summary:**
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directives to template.
5. Move/copy files into template directories.
6. Add object name prefix to file names or supply a mapping.txt file.
7. Create new object batch.
8. Process the batch.

What you need before you start:

- Prepare a dozen of files and put them in a directory of your choice somewhere on local hard disk or network drive.
- Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See section 3 for more information about owner supplied names.
- Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: `[obj-osn]--[file_name].[extension]`) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 15.1.

Procedure:

1. **Create a new project.**
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “color profile” from the dropdown; click OK to continue.

2. **Enter DRS deposit information.**
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - `{owner}_-{batchDir}_-{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}`
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      
      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. **Create object template (called “batch template” in BB 1).**
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
b. Enter DRS Owner Code for objects you will be depositing (use all caps).

c. Enter DRS Billing Code for objects you will be depositing (use all caps).

d. Select DRS Access Flag value for objects you will be depositing.

e. Enter the URN Authority Path for your objects (Look up your Path here if needed:
   http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.

f. Enter File URN Resource Name Pattern.

g. (Optional) Switch to “optional” tab in the Content Panel to enter any additional optional metadata
   (for example descriptive metadata, roles or/and relationships that will apply to your objects). For
   more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive
   Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that
   metadata entered at the object level will override metadata entered at the template level.

h. Leave the default Role in the Color Profile Object Metadata section as COLOR_PROFILE

4. **Add directories to template.**

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The
directory name starts with “color_profile” but you can append a custom suffix).

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First
   Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

Go to Project menu in the top menu bar and choose Save to save your project.

5. **Move/Copy files into template directory.**

   (Can be done outside Batch Builder)

Once you added directories to Object Template in BB, they were also created on disk. The directory
structure on disk is the same as what you see in the Project Panel in Batch Builder when you expand
the Object Template icon, but on disk the Object Template directory is called “template.” If you need
to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the
Project Panel and take a look at the Project Path field at the bottom of the main metadata panel.

Copy files to the corresponding color profile directory inside the template directory. (e.g.
template\color_profile)

6. **Add object name prefix to file names or supply a mapping.txt file.**

In order to tell BB which object each file should end up with you need to either add object name
prefixes to each file name or supply a mapping.txt file that associates each file with its future object.

   o **Add an object owner supplied name as a prefix** to the name of each file. The prefix needs to be
     separated from the file name by the special separator sting “--“.
     E.g.: obj1--file1.icm is a file name that tells Batch Builder that this particular file needs to
     be part of object obj1.

     OR

   o **Provide a mapping file mapping.txt** placed in the project /_aux/template directory which maps
each file to an object owner supplied name.
Syntax:
relative_file_path, file_OwnerSuppliedName, PDS_sequence number (optional), object_OwnerSuppliedName

Example:

<table>
<thead>
<tr>
<th>File Path</th>
<th>FILE OSN</th>
<th>Sequence</th>
<th>Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>document\379129.txt</td>
<td>FILEOSN1</td>
<td>,,</td>
<td>Obj1</td>
</tr>
<tr>
<td>document\4541102.txt</td>
<td>FILEOSN2</td>
<td>,,</td>
<td>Obj2</td>
</tr>
</tbody>
</table>

Notes on syntax: There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so that Batch Builder can associate the right value with the right element. For example, when using mapping.txt file for objects other than PDS Documents, an extra comma needs to be inserted between the FILE OSN value and Object OSN value where PDS sequence number value would be expected.

7. Create a new object batch.

You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

In the Graphical User Interface

a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to add any additional optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that metadata entered at the object level will override metadata entered at the template level.

In the Command Line Interface

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
   `cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45`
   Type `batchbuildercli -a buildtemplate -p [project_directory_path] -b [batch_directory_name]`, e.g.:
   `batchbuildercli -a buildtemplate -p "E:\My Project" -b batch1`
   Note that the batch directory name is the name of your new batch directory, to be created by BB.

b. If the batch creation is successful you will see the following messages:
   Initializing BB...
   Done!
   Creating batch1 and objects from files in the template...
   Success!
8. **Process the batch.**

You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)

**In the Graphical User Interface**

a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

b. Builder will start processing the batch.

c. When the batch is successfully processed you will see the following message: **FINISHED - Creation of batch.xml and descriptors complete for batch: …**

   If you see any error messages, remedy the errors and re-process the batch.

**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
   
   ```cmd
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
   ```
   
   Type `batchbuildercli -a build -p [project_directory_path] -b [batch_directory_name]`, e.g.:
   
   ```cmd
   batchbuildercli -a build -p "E:\My Project" -b batch1
   ```

b. (Optional) add additional parameters to the `batchbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

c. When the batch is successfully processed you will see the following messages:
   
   Building PREMIS file metadata...
   
   Building HulDrsAdmin file metadata...
   
   Success!

   If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).
12. Creating Target Object Batches

12.1 Accepted formats

12.2 Manually create target image objects from template

12.3 Automatically create target image objects from template

There are three methods you can use to create Target Image objects in Batch Builder:

1. Manually create objects from template. This is best for small batches (10 objects or fewer). In this scenario you generate an object structure in BB for each object and then copy files into it (can be done outside BB). See section 12.2 for the procedure.

2. Automatically build objects from template. This method is best for large batches of objects (more than 10 objects). In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See section 12.3 for the procedure.

3. Manually create objects without using the template. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. This method is useful when object properties such as Owner Code, Billing Code andURN authority path are different for each object. Because this option will be rarely used, it is not currently documented.

12.1 Accepted formats

The following formats are accepted for files contained in target objects:

Target image
- TIFF (MIME type: image/tiff)
- JPEG (MIME type: image/jpeg)
- GIF (MIME type: image/gif)
- JPEG 2000 JP2 (MIME type: image/jp2)

Target description
- Plain Text (MIME type: text/plain)

12.2 Manually create target image objects from template

This is a description of the procedure to manually create a batch of Target Image objects from template in Batch Builder 2 (BB). This method is a good choice when creating a batch with a small number of objects. To create a batch with many objects (over 10), the automatic object creation procedure may be more efficient.

Procedure summary:
1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to object template.
5. Create a new batch and objects.

6. Move/copy files into corresponding directories on disk.

7. Process the batch.

8. Upload the batch to your dropbox

9. Check load report in email

**What you need before you start:**

- Prepare several target images and (optionally) related Target Description Files (TDFs). Put them in a directory of your choice somewhere on local hard disk or network drive.

- Decide what you will use for owner supplied names for Target objects and the files they consist of. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.

**Procedure:**

**Start at Step 5** if you are reusing a project to generate a new batch.

1. Create new project in Batch Builder
   a. From main menu select **Project > New**
   b. Enter project data:
      - **Project Name**: enter a name for your project (used for internal tracking only).
      - **Project Directory**: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      - **Content Model**: select the "target image" value from the dropdown.
      - **Project Description (optional)**: Any information relevant to the project – will only remain locally.
   c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      - **Batch Name Pattern**: default - {owner}_ {batchDir} _ {yyyyMMdd} {mo} {dd} _ {hh24} _ {mm} _ {ss} 
        (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      - **Success Email**: type email and press enter.
      - **Failure Email**: type email and press enter.
      - **Success Method**: choose how you will receive load report – email, dropbox or both.
      - **Deposit Agent**: type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
a. Click on “Object Template” in Project Panel tree:

b. Click on the ‘required’ tab and enter object metadata in the form:

- **DRS Owner Code**: your owner code (use all caps).
- **DRS Billing Code**: your billing code (use all caps).
- **Object Access**: the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
- **URN Authority Path**: your NRS authority path. Use all caps. Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod.
- **File URN Resource Name Pattern**: use default value `{n}` to generate a unique number.

c. Click on ‘optional’ tab to enter any additional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. Add image directory:

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.

b. Select ‘image’ from the drop down menu next to ‘directory name’.

c. Type in a name for your directory in the text box. The directory name will start with ‘image’ but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_) So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’

d. In the Project Panel on the left select the directory you just created.

e. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

f. Choose “LOWUSE” for Usage Class.

**Add additional metadata (optional tab):**

a. Select the new directory in the Project Panel on the left

b. In the Content Panel, select the ‘optional’ tab.

c. Scroll down to “Target Image File Metadata”

d. Enter any file level optional metadata in the form

5. Add target description file (tdf) directory:

a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory…” menu option.

b. Select ‘tdf’ from the drop down menu next to ‘directory name’.

c. Type in a name for your directory in the text box. The directory name will start with ‘tdf’ but the name you type will be appended to it. In the Project Panel on the left select the directory you just created.

d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

e. Choose “LOWUSE” for Usage Class.
Add additional metadata (optional tab):
   a. Select the new directory in the Project Panel on the left
   b. In the Content Panel, select the ‘optional’ tab.
   c. Scroll down to “Target Image File Metadata”
   d. Enter any file level optional metadata in the form.

6. Create new batch with objects:
   Metadata added at this level can be applied to a specific object, or specific file directory.
   a. Create new batch: select “Batch > New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk). Click OK.
      Tip: including the word "batch" in the name will help you remember the directory’s purpose on the file system.
   b. Select the batch (with the red letter B) in the Project Panel
   c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter a unique name for the object (Object Owner Supplied Name) and click OK.
   d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object (blue letter O)
   e. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note: any metadata entered at the object level will override metadata entered at the template level.
   f. Repeat b-e if you have more than object.
   g. Save your project (Project > Save on main menu).

7. Copy image files into batch object directories on disk (can be done outside Batch Builder).
   Note: if you need to check where the batch/object directories are on disk, click on "Deposit Settings" in the Project Panel tree and look at the Project Path field at bottom.
   ** Quick way to copy content files: you can drag files from your file system onto the object directories in the Batch Builder project panel.

8. (Optional) Copy Target Description Files to the tdf directories.

9. Process the batch:
   a. In the Project Panel tree, right click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
      Processing messages will appear in the messages pane.
   b. When the batch is successfully processed you will see the following message: FINISHED Creation of batch.xml and descriptors complete for batch:

10. Upload batch to dropbox.
    a. Open your SFTP client and log into your DRS2 dropbox account.
    b. Change to the "incoming" directory.
c. Upload the batch: copy the entire batch directory to the "incoming" directory.
d. Close the SFTP client. Batch processing will start.

11. Check load report in email.
   a. Open your email inbox.
   b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
      For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel. If you see any error messages, remedy the errors and re-process the batch.
12.3 Automatically build still image objects from template

This is a description of the procedure to automatically build a batch of target image objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (more than 10) that need to be created and your source files are not broken into directories by object.

Procedure summary:
1. Create a new project.
2. Enter DRS deposit information.
3. Create the object template.
4. Add directories to the object template.
5. Repeat steps in (4) for additional nested directories if needed.
6. Save your work
7. Move/copy images into the object template.
8. Create a new object batch.

What you need before you start:
• Prepare digital images and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per image (e.g.: an archival master and a deliverable or an archival master, a deliverable and a thumbnail) make sure file names match (e.g.: image-1.tif, image-1.jp2 and image-1.jpg).
• Decide what you will use for owner supplied names for target image objects and the digital files they consist of. For instance, you could use local classification or local accession numbers. Consult section 3 Naming rules for files, objects and directories of this Guide for more information.
• Make sure you either provide object name prefixes for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see section 1.2.2. For more details about external mapping files see section 15.1.

Procedure:
Start at Step 5 if you are reusing a project to generate a new batch.
1. Create new project in Batch Builder
   a. From main menu select Project > New.
   b. Enter project data:
      Project Name: enter a name for your project (used for internal tracking only).
      Project Directory: select the directory where project will be saved (click ellipsis button to browse for or create a directory).
      TIP: use ‘project’ as part of the directory name to make it easier to identify later. (e.g. museum_slide_project)
      Content Model: select the 'target image’ value from the dropdown.
Project Description (optional): Any information relevant to the project – will only remain locally.

c. Click OK to continue.

2. Enter DRS deposit settings:
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      Batch Name Pattern: default - \{owner\}_\{batchDir\}_\{yyyy\}_\{mo\}_\{dd\}_\{hh24\}_\{mm\}_\{ss\}
      
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      Success Email: type email and press enter.
      Failure Email: type email and press enter.
      Success Method: choose how you will receive load report.
      Deposit Agent: type your HUID.

3. Create object template:
   Metadata added at this level will be applied to every object in a batch, unless overridden by specific object metadata that you define in later steps.
   a. Click on “Object Template” in Project Panel tree:
   b. Enter required object metadata in the form:
      
      c. DRS Owner Code: your owner code (use all caps).
      DRS Billing Code: your billing code (use all caps).
      Object Access: the DRS access flag. At this level, select the least restrictive value if the batch will contain a mix of public and restricted files.
      URN Authority Path: your NRS authority path. Use all caps. Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod.
      File URN Resource Name Pattern: use default value \{n\} to generate a unique number.
      
      d. Switch to “optional” tab to enter any optional metadata (for example, descriptive metadata, roles and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. Add image directory to template:
   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory’ menu option.
   b. Type in a name for your directory in the text box. The directory name will start with “image” but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_). So, typing ‘_tifs_and_jpegs’ will result in a directory called ‘image_tifs_and_jpegs’
   c. In the Project Panel on the left select the directory you just created.
   d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
   e. Choose “LOWUSE” for Usage Class.

Add additional metadata (optional tab):
a. Select the new directory in the Project Panel on the left
b. In the Content Panel, select the ‘optional’ tab.
c. Scroll down to "Still Image File Metadata “
d. Enter any file level optional metadata in the form

5. Add target description file (tdf) directory:
   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a
directory…” menu option.
   b. Select ‘tdf’ from the drop down menu next to ‘directory name’.
   c. Type in a name for your directory in the text box. The directory name will start with ‘tdf’ but the
   name you type will be appended to it. In the Project Panel on the left select the directory you just
   created.
   d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First
   Generation in DRS”.
   e. Choose “LOWUSE” for Usage Class.

Add additional metadata (optional tab):
   a. Select the new directory in the Project Panel on the left
   b. In the Content Panel, select the ‘optional’ tab.
   c. Scroll down to “Target Image File Metadata”
   d. Enter any file level optional metadata in the form.

6. Save your work (Project > Save on main menu).

7. Copy image files and optional target description files into Batch Builder template directories on disk
   (can be done outside Batch Builder).

   The directories you created in BB have been created on disk, in the project’s template path:
   \{project_name}\template\ 

   In order to tell BB which object each file should end up with you need to either add object name
   prefixes to each file name or supply a mapping.txt file that associates each file with its future object.
   See Naming Rules for Objects for how to add an object name prefix. See Using mapping.txt file
   for how to create a mapping file.

   In the automatic workflow, files with the same role (image, tdf) are copied into the corresponding
   role-based directory. In a later step, Batch Builder will use the object name prefix for each file to
   create object directories and move files for each object into these directories.

   Note: if you need to check where the directories are on disk, click on "Deposit Settings" in the Project
   Panel tree and look at the Project Path field at bottom.

   ** Quick way to copy content files: you can drag files from your file system onto the object template
directories in the Batch Builder project panel.

   ** If using mapping.txt, this is when you should copy it to the auxiliary template path in the project.

   ** If including external MODS descriptive metadata, this is when you should copy it to the auxiliary
   template path in the project.

8. Create a new object batch.
You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

**In the Graphical User Interface**

a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

c. (Optional) Select the object icon of your new object in the Project Panel and switch to “optional” tab in the Content Panel to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content. Note that any metadata entered at the object level will override metadata entered at the template level.

d. Save the project to have BB2 write the new metadata values to the internal configuration files.

**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:

   `cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45`

   Type `batchbuildercli -a buildtemplate -p [project_directory_path] -b [batch_directory_name]`.

   Example:

   `batchbuildercli -a buildtemplate -p "E:\My Project" -b batch1`

   Note that the batch directory name is the name of your new batch directory, to be created by BB.

b. If the batch creation is successful you will see the following messages:

   Initializing BB...
   Done!
   Creating batch1 and objects from files in the template...
   Success!

9. **Process the batch.**

   You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI).

   **In the Graphical User Interface**

   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

   b. Builder will start processing the batch.

   c. When the batch is successfully processed you will see the following message: \**FINISHED - Creation of batch.xml and descriptors complete for batch ...**

   If you see any error messages, remedy the errors and re-process the batch.
**In the Command Line Interface**

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:
   
   ```bash
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
   ```

b. Type `batchbuildercli -a build -p [project_directory_path] -b [batch_directory_name]`, e.g.:
   ```bash
   batchbuildercli -a build -p "E:\My Project" -b batch1
   ```

c. (Optional) add additional parameters to the `batchbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

d. When the batch is successfully processed you will see the following messages:
   
   ```
   Building PREMIS file metadata...
   Building HulDrsAdmin file metadata...
   Success!
   ```

If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message).
13. Creating Audio Object Batches

13.1 Accepted formats
13.2 Manually create audio objects from template
13.3 Automatically build audio objects from template
13.4 Build an advanced audio batch

There are four methods you can use to create Audio objects in Batch Builder:

1. Manually create objects from template. This is best when you have only one or two Audio objects to work with and you are not depositing any extra content -- such as ADL audio decision lists and AES 60 structural metadata files for governing audio playback. In this scenario you generate in BB an object structure for each object and then copy files into it (can be done outside BB). See Section 13.2 for the procedure.

2. Automatically create objects from template. This is best when you have three or more Audio objects to work with and you are not depositing any extra content -- such as ADL audio decision lists and AES 60 structural metadata files for governing audio playback. In this scenario BB generates object structure for each of your objects and moves files into object directories. Before this can happen you need to rename your files to add special “object name” file prefixes or provide mapping files that associate files with their objects. See Section 13.3 for the procedure.

3. In this method, rather than using the template, you fill out object and file metadata and create object directories for each individual object one-object-at-a-time. As this method is rarely used in workflows, it is not currently documented.

4. Use Batch Builder advanced audio functionality to build an advanced audio batch. Use this method if you plan to deposit audio files along with additional supporting files containing technical and structural metadata about your audio – such as ADL audio decision lists and AES 60 structural metadata files for governing audio playback. See Section 13.4 for the procedure. If you do not need to deposit ADL or AES-60 files with your audio, use the procedures described in Sections 13.2 or 13.3 instead

13.1 Accepted formats

Audio content files
- Audio Interchange File Format (MIME type: audio/x-aiff)
- Broadcast Waveform Audio (MIME type: audio/x-wave)
- MPEG 1/2 Audio Layer 3 (MIME type: audio/mpeg)
- MPEG Advanced Audio Encoding (MIME type: audio/mp4)

Additional files that are only accepted in advanced audio workflow (See Section 13.4)
- Process History file; Format: Extensible Markup Language
- Processing Files Container; Format name: ZIP
- Audio Decision List; Format: Audio Decision List

13.2 Manually create audio objects from template

This is a description of the procedure to manually create a batch of Audio objects from template in Batch Builder 2 (BB). Use this method when only Audio objects need to be created, processed in Batch Builder
(BB) and deposited into the DRS. If you have many (over 10) objects to create, use the procedure to build objects automatically.

**Procedure summary:**

1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Create new object batch.
6. Move/copy files into corresponding directories on disk.
7. Process the batch.
8. Upload the batch to your dropbox
9. Check the email report

**What you need before you start:**

- Prepare several audio files and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one audio file per recording (e.g.: an archival master and a deliverable or an archival master, a production master and a deliverable) make sure file names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult Section 3 of this Guide for more information on file and directory naming.
- Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See Section 3 for more information about owner supplied names.

**Procedure:**

1. **Create a new project.**
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “audio” from the dropdown; click OK to continue.

2. **Enter DRS deposit settings.**
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      ```
      Batch Name Pattern: default - {owner}_ {batchDir}_ {yyyy} {mo} {dd} _{hh24} {mm} {ss}
      ```
      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)
      
      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
Success Method: choose how you will receive load report.
Deposit Agent: type your HUID.

3. **Create object template (called “batch template” in BB 1).**
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter Owner Code for objects you will be depositing (use all caps).
   c. Enter Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
   e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.
   f. Enter File URN Resource Name Pattern.
   g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional metadata see Sections 17. Adding Relationships, 18. Adding Descriptive Metadata, 19. Adding Licenses, Documentation and Other Supporting Content.

4. **Add directories to template.**

   **If there is one audio file per object**
   (e.g.: one file that serves as archival master and as deliverable)
   a. Right click on “Object Template” in the Project Panel on the left and add a directory and select the ‘add a directory…’ menu option.
   b. Type in a name for your directory in the text box. The directory name starts with “audio”, but the name you type will be appended to it. Tip: to make it easier to read, start your directory name with an underscore (_). So, typing ‘_mp3_files’ will result in a directory called ‘audio_mp3_files’.
   c. In the Project Panel on the left select the directory you just created.
   d. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.
   e. Choose “HIGHUSE” for Usage Class.
   f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.

   **If there are two or more audio files per object**
   (e.g.: a separate file for archival master and a separate file for deliverable)

   Create a directory for an archival master and nest one or more deliverable directories inside it (this is needed for BB to determine the derivative relationship).
   a. Right click on “OBJECT TEMPLATE” in the Project Panel on the left and select the ‘add a directory …’ menu option.
   b. In the text box, type ‘-archival_master’ or a similar suffix that describes the role of your directory. The directory name will start with “audio” but the name you type will be appended to it. So, typing ‘-archival_master’ will result in a directory called ‘audio-archival_master’.
c. In the Project Panel on the left select the directory you just created.

d. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

e. Choose “LOWUSE” for Usage Class.

f. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role ARCHIVAL_MASTER.

g. In the Project Panel on the left, right click on the directory you just created and select the ‘add a directory …’ menu option.

h. In the text box, type ‘-deliverable’ or a similar suffix that describes the role for your directory.

i. In the Project Panel on the left, select the directory you just created.

j. In the Content Panel choose “no” from the dropdown list for the field “First Generation in DRS”.

k. Choose “HIGHUSE” for Usage Class.

l. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.

m. If you have more deliverables that are derived from the archival master (an mp3 deliverable and an mp4 deliverable for instance) right click on the topmost audio directory you created, add a custom suffix if needed and follow steps g-i once again.

5. Save your work (Project > Save on main menu)

6. Create new object batch.

a. Select “Batch>New” from the main menu. Enter a name for the batch (will be used as the batch directory name on disk) Click OK.

   Tip: including the word “batch” in your batch name will help you remember the directory’s purpose on the file system.

b. Select the batch (with the red letter B) in the project Panel.

c. From the main menu select Object > New; leave Content Model at default (FROM TEMPLATE) and enter the name of the object (Object Owner Supplied Name). Click OK.

d. Click on the “+” next to the Batch icon to expand it – it will show the icon for the new object.

e. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for instance, if each object has a separate corresponding Aleph record, you can switch to the Optional tab in the Content Panel on the right while the object icon is selected in the Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for MODS import” field).

f. Repeat if you have more than object.

7. Move/copy files into corresponding file directories on disk.

   (Can be done outside Batch Builder)

   The directory structure on disk is the same as what you see in the Project Panel in Batch Builder if you expand the batch icon. If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel on the left and look at the Project Path field at the bottom of the Content Panel on the right.

a. Copy the files for into corresponding file directories in the object directory.
b. Repeat if you have more than one object.

8. **Process the batch.**
   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”
   b. Builder will start processing the batch.
   c. When the batch is successfully processed you will see the following message: **FINISHED - Creation of batch.xml and descriptors complete for batch: …**

If you see any error messages, remedy the errors and re-process the batch.

9. Upload batch to dropbox.
   a. Open your SFTP client and log into your DRS2 training dropbox account.
   b. Change to the "incoming" directory.
   c. Upload the batch: copy the entire batch directory to the "incoming" directory.
   d. Close the SFTP client. Batch processing will start.

10. Check load report in email.
    a. Open your email inbox.
    b. Look for message from "drs2-support" with subject "DRS LOAD REPORT …"
    For a more readable report, open the attached text file in Excel, or just copy the file listing and paste into Excel. If you see any error messages, remedy the errors and re-process the batch.

13.3 **Automatically build audio objects from template**

This is a description of the procedure to automatically build a batch of audio objects from template using Batch Builder 2 (BB). Use this method if you have a large number of objects (over 10) that need to be created and your source files are not broken into directories by object.

**Procedure summary:**

1. Create a new project.
2. Enter DRS deposit settings.
3. Create object template.
4. Add directories to template.
5. Move/copy files into template directories.
6. Add object name prefix to file names or supply a mapping.txt file.
7. Create new object batch.
8. Process the batch.
9. Upload the batch to your dropbox
10. Check the load report in email

**What you need before you start:**

Revised: April 14, 2015
- Prepare audio files and put them in a directory of your choice somewhere on local hard disk or network drive. If you have more than one file per object (e.g.: an archival master and a deliverable or an archival master, a production master and a deliverable) make sure the file names match (e.g.: music-1.aif, music-1.wav and music-1.mp3). Consult Naming Rules section of this Guide for more information on file and directory naming.

- Decide what you will use for Owner Supplied Names for your objects and the files they consist of. For instance, you could use local classification or local accession numbers. See section 3 of this Guide for more information about owner supplied names.

- Make sure you either provide object name prefix for each file to specify which objects it should be assigned to (The syntax is: [obj-osn]--[file_name].[extension]) or provide object assignment for your file in an external mapping file. For more details about providing object prefixes for your files see Section 1.2.2. For more details about external mapping files see Section 15.1.

Procedure:

1. Create a new project.
   a. Open BB by double clicking on the executable.
   b. From the Project menu select New.
   c. In the dialog enter Project Name (used for internal tracking); select the directory on disk in which the project will be saved (click the ellipsis button to browse to it on disk); select Content Model “audio” from the dropdown; click OK to continue.

2. Enter DRS deposit settings.
   a. Click on “Deposit Settings” in Project Panel tree.
   b. Enter deposit data in the form:
      
      **Batch Name Pattern:** default - {owner}_{batchDir}_{yyyy}_{mo}_{dd}_{hh24}_{mm}_{ss}

      (This is the name for a batch that appears on DRS deposit reports. Batch name must be at least 3 characters long.)

      **Success Email:** type email and press enter.
      **Failure Email:** type email and press enter.
      **Success Method:** choose how you will receive load report.
      **Deposit Agent:** type your HUID.

3. Create object template (called “batch template” in BB 1).
   a. Select “Object Template” in Project Panel on the left and then enter information in the Content Panel on the right.
   b. Enter Owner Code for objects you will be depositing (use all caps).
   c. Enter Billing Code for objects you will be depositing (use all caps).
   d. Select DRS Access Flag value for objects you will be depositing.
   e. Enter the URN Authority Path for your objects (Look up your Path here if needed: http://nrs.harvard.edu/urn-3:hul.ois:nrsstatusprod) – use all caps.
   f. Enter File URN Resource Name Pattern.
   g. (Optional) switch to “optional” tab to enter any optional metadata (for example descriptive metadata, roles or/and relationships that will apply to your objects). For more about optional
4. **Add directories to template.**

**If there is one audio file per object**
(e.g.: one file that serves as archival master and as deliverable)

a. Right click on “Object Template” in the Project Panel on the left and add a directory (The directory name starts with “audio” but you can append a custom suffix).

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right, choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “HIGHUSE” for Usage Class.

e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and use Ctrl Click on your keyboard to select role ARCHIVAL_MASTER and role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.

**If there are two or more audio files per object**
(e.g.: a separate file for archival master and a separate file for deliverable)

Create a directory for an archival master and nest one or more deliverable directories inside it (this is needed for BB to determine the derivative relationship).

a. Right click on “Object Template” in the Project Panel on the left to add a directory (this will be the directory for archival master). The directory name starts with “audio” but you can append a custom suffix.

b. In the Project Panel on the left select the directory you just created.

c. In the Content Panel on the right choose “yes” from the dropdown list for the field “First Generation in DRS”.

d. Choose “LOWUSE” for Usage Class.

e. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role ARCHIVAL_MASTER.

f. In the Project Panel on the left right click on the directory you just created and create another directory nested inside it (this will be the directory for deliverable audio). Once again, append a custom suffix to directory name if needed (e.g. “audio-deliverable”).

g. In the content panel choose “no” from the dropdown list for the field “First Generation in DRS”.

h. Choose “HIGHUSE” for Usage Class.

i. In the Content Panel switch to Optional tab, scroll down to Audio File Metadata and select role DELIVERABLE. Note that in order to get a delivery URN on deposit an audio file needs to have a role DELIVERABLE set in BB.

j. If you have more deliverables that are derived from the archival master (an mp3 deliverable and an mp4 deliverable for instance) right click on the topmost audio directory you created, add a custom suffix if needed and follow steps g-i once again.

Go to Project menu in the top menu bar and choose **Save** to save your project.

5. **Move/Copy files into template directory.**
Once you added directories to Object Template in BB, they were also created on disk. The directory structure on disk is the same as what you see in the Project Panel in Batch Builder when you expand the Object Template icon, but on disk the Object Template directory is called “template.” If you need to check where on disk Batch Builder built the directory structure, click on Deposit Settings in the Project Panel and take a look at the Project Path field at the bottom of the main metadata panel.

- If you have one audio file per object, copy each file to the corresponding audio directory inside the template directory.
- If you have more than one file per object, copy the files for each object into corresponding nested audio directories in the template directory.
  
  Important: the file names for all files belonging to the same object need to match (e.g.: `audio-1.aif; audio-1.wav; audio-1.mp3`).

6. **Add object name prefix to file names or supply a mapping.txt file.**

In order to tell BB which object each file should end up with you need to either add object name prefixes to each file name or supply a mapping.txt file that associates each file with its future object.

- **Add an object owner supplied name as a prefix** to the name of each file. The prefix needs to be separated from the file name by the special separator sting “--“.
  
  E.g.: `obj1--file1.aif` is a file name that tells Batch Builder that this particular file needs to be part of object `obj1`.
  
  Make sure that the file name pattern setting in the BB Options dialog is set to the correct setting. See more information about file Owner Supplied Name pattern settings in [Section 1.2.2](#).

- **Provide a mapping file mapping.txt** placed in the project /_aux/template directory which maps each file to an object owner supplied name.

  **Syntax:**
  ```plaintext```
  relative_file_path, file.OwnerSuppliedName, PDS_sequence_number(optional), object.OwnerSuppliedName
  ```plaintext```

  **Notes on syntax:** There should be no spaces between a comma “,” and the next character. If an optional element value is skipped it still needs to be designated by a comma “,” so Batch Builder can associate the right value with the right element. For example, for objects that do not have PDS sequence numbers, an extra comma needs to be inserted between the FILE OSN value and Object OS.

  **Example:**
  ```plaintext```
  audio_archival-master\379129.aif,FILEOSN1,,Obj1
  audio_archival-master\4541102.aif,FILEOSN2,,Obj2
  audio_archival-master\audio_deliverable\379129.mp3,FILEOSN1,,Obj1
  audio_archival-master\audio_deliverable\4541102.mp3,FILEOSN2,,Obj2
  ```plaintext```

7. **Create a new object batch.**
You can create your new object batch in the Graphical User Interface or using the Command Line Interface (CLI).

In the Graphical User Interface

a. From the Object menu in BB select “Create a new batch with objects from template”; enter the name of the batch directory to be created on disk and click OK. A new batch icon will be added to the Project Panel on the right (icon with a red letter B) and new objects will be built that are going to be part of this batch.

b. In the Project Panel click on the “+” next to the Batch icon of the batch you just created to expand the tree – it will show the icons for the new objects (a blue letter O).

c. (Optional) Select each object icon in the Project Panel and edit any needed metadata (for instance, if each object has a separate corresponding Aleph record, you can switch to the Optional tab in the Content Panel on the right while the object icon is selected in the Project Panel on the left and enter the Aleph ID for each object in the “Aleph ID for MODS import” field).

In the Command Line Interface

a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:  
   cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45

   Type batchbuildercli –a buildtemplate –p [project_directory_path] –b [batch_directory_name], e.g.:  
   batchbuildercli -a buildtemplate -p "E:\My Project" -b batch1

   Note that the batch directory name is the name of your new batch directory, to be created by BB.

b. If the batch creation is successful you will see the following messages:

   Initializing BB...

   Done!

   Creating batch1 and objects from files in the template...

   Success!

8. Process the batch.

   You can process your batch in the Graphical User Interface (GUI) or using the Command Line Interface (CLI)

   In the Graphical User Interface

   a. In the Project Panel on the left right-click on the batch you want to process (batch icon with a red letter B) and select “Create descriptors and batch.xml.”

   b. Builder will start processing the batch.

   c. When the batch is successfully processed you will see the following message: FINISHED - Creation of batch.xml and descriptors complete for batch: …

   If you see any error messages, remedy the errors and re-process the batch.

   In the Command Line Interface

   a. In the command line window (Terminal on Mac or Linux or CMD on Windows) change to the BB installation directory, e.g.:  
      cd C:\Program Files\BatchBuilder\BatchBuilder-2.0.45
b. Type `bathcbuildercli -a build -p [project_directory_path] -b [batch_directory_name]`, e.g.: `bathcbuildercli -a build -p “E:\My Project” -b batch1`

c. (Optional) add additional parameters to the `bathcbuildercli` command to substitute batch, object and directory level properties. For more information see Section 14. Processing Batches Using Command Line Interface.

d. When the batch is successfully processed you will see the following messages:

   ```
   Building PREMIS file metadata...
   Building HulDrsAdmin file metadata...
   Success!
   ```

   If you see any error messages at the end of batch processing, remedy the errors and re-process the batch (you can disregard any errors showing during batch processing on command line as long as you get the final “Success!” message)

### 13.4 Build an advanced audio batch (command line)

13.4.1 Default audio properties
13.4.2 Command line syntax
13.4.3 Preparation
13.4.4 Batch Builder Execution
13.4.5 Depositing to the DRS

Use this method to deposit audio files along with additional supporting files containing technical and structural metadata about your audio – such as ADL audio decision lists, AES-57 technical metadata files and AES-60 structural files (playlists) for governing audio playback.

If you don’t need to deposit these additional files with your audio, use the procedures described in sections 13.2 and 13.3 to deposit your audio instead. If you want to deposit only audio files and corresponding AES-60 playlists, you may do so using the Audio genre and Text genre in Batch Builder GUI. First deposit the audio and then deposit the playlists as a separate Text object batch. See Sections 13.2 and 13.3 for depositing simple audio and Section 10.4 for depositing audio playlists as text objects.

Note that BB2 in advanced mode is COMMAND LINE ONLY. Required and optional metadata such as deposit settings, object and file metadata is supplied using special configuration files.

#### 13.4.1 Default audio properties

Default audio properties for advanced audio are stored in the “/conf/advanced/audio” directory of Batch Builder install directory. These files are never changed under normal circumstances. They govern default metadata assignments for advanced audio. Most default assignments can be overwritten by object-specific, and file-specific properties files.

The following default audio properties files are present in the “/conf/advanced/audio” directory:

- `archival_directory.properties`
- `default.properties`
- `deliverable_directory.properties`
- `misc_directory.properties`
- `playlists_directory.properties`
• production_directory.properties
  The following settings are set in each file:

  **archival_directory.properties**
  # properties for the archival directory
  usageClass=LOWUSE
  isFirstGenerationInDrs=yes
  role=ARCHIVAL_MASTER

  **default.properties**
  # directories to scan for content. Each directory could have a
  # corresponding _directory.properties file
  dirs=archival,production,deliverable,misc
  cmid=CMID-2.0

  **deliverable_directory.properties**
  # properties for the deliverable directory
  usageClass=HIGHUSE
  isFirstGenerationInDrs=no
  role=DELIVERABLE

  **misc_directory.properties**
  # properties for the misc directory
  usageClass=LOWUSE
  isFirstGenerationInDrs=unspecified

  **playlists_directory.properties**
  # properties for the playlists directory
  usageClass=HIGHUSE
  isFirstGenerationInDrs=unspecified

  **production_directory.properties**
  # properties for the production directory
  usageClass=LOWUSE
  isFirstGenerationInDrs=no
  role=PRODUCTION_MASTER
13.4.2 Command line syntax

The existing Batch Builder Windows bat and Unix shell scripts are used to launch Batch Builder in advanced mode. The syntax is:

- On PC: batchbuildercli –advanced audio –d [object directory path]
  - Use Windows style directory separator ‘\’
- On Mac or Linux: ./batchbuildersli.sh -advanced audio –d [object directory path]
  - Use UNIX style directory separator ‘/’

Note that by default the object directory name serves as the object Owner Supplied Name (you can override that in audio.properties file).

Example 1 (Windows):

```
batchbuildercli –advanced audio –d “C:\mybatch\004390909”
```

Example 2 (Mac / Linux):

```
./batchbuildersli.sh -advanced audio -d /mybatch/004390909
```

13.4.3 Preparation

1. Arrange the content so that it has the directory structure shown in Figure 1.

Below is a sample directory structure created in preparation for use with Batch Builder. Underlined directories must be named as shown. Other directories can exist in the directory structure but Batch Builder will ignore them.

```
/batch/

audio.properties (required)
relationships.csv (required for derivative relationships)
mods.xml  (optional; descriptive metadata for the object)

/batch/object/

archival/  (required if there are archival master files)
digiprov.xml  (optional process history for object)
sub_dir1_Media/ (“_Media” is an optional suffix)
  file1.wav
  file1.xml (AES57 metadata for file1.wav)
  file1.properties (DRS metadata for file1.wav)
  file2.wav
  file2.xml (AES57 metadata for file2.wav)
  file2.properties (DRS metadata for file2.wav)
sub_dir2_Media/ (“_Media” is an optional suffix)
  file1.wav
  file1.xml (AES57 metadata for file1.wav)
  file1.properties (DRS metadata for file1.wav)
  file2.wav
  file2.xml (AES57 metadata for file2.wav)
  file2.properties (DRS metadata for file2.wav)
```
2. Create the required **audio.properties** configuration file. This file should be put into the root of the batch directory. The file contains all required batch level and object level settings. The format of it must be:

- US-ASCII text
- Each line in “property=value” format
- Lines can be commented out by starting the line with the ‘#’ symbol.
- Can’t use reserved XML characters (see the table below for full list).

**Table of properties.** The table below lists the properties that can be specified in this file. An example audio.properties file is shown in Figure 2.
<table>
<thead>
<tr>
<th>Property</th>
<th>Valid Values</th>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessFlag</td>
<td>one of: P,R,N</td>
<td>R</td>
<td>The default access flag to use for this object’s files. Can be overridden by the access flag specified in file level properties files.</td>
</tr>
<tr>
<td>authorityPath</td>
<td>a valid NRS authority path</td>
<td>FHCL.Loeb</td>
<td>Authority path for any URNs that will be created for this object’s files</td>
</tr>
<tr>
<td>batchName</td>
<td>100 character limit; Valid values: ASCII alpha-numeric characters, /&quot;./&quot;/&quot;./&quot;/&quot;_/&quot;/&quot;~&quot;/ The following reserved XML characters should be excluded: gen-delims = &quot;:/&quot;/&quot;/&quot;/&quot;?&quot;/&quot;#&quot;/&quot;[$&quot;/&quot;&quot;&quot;/&quot;@&quot; sub-delims = &quot;!&quot;/&quot;$&quot;/&quot;&amp;&quot;/&quot;&quot;&quot;/&quot;&quot;(&quot;/&quot;&quot;)&quot;/&quot;&quot;<em>/&quot;&quot;</em>&quot;/&quot;}:&quot;/&quot;}&quot;/&quot;}&quot;/&quot;=&quot;/</td>
<td>Valid value examples: Project_137_4a~5.1a Batch-123_23yux-a.21 Invalid values examples: batch&amp;&amp;&lt;&lt;&gt;&gt;&gt;&lt;! project清代盐政与盐税</td>
<td></td>
</tr>
<tr>
<td>billingCode</td>
<td>a valid Billing Code</td>
<td>FHCL.MUSI.MUS_004</td>
<td>Billing code for the object</td>
</tr>
<tr>
<td>depositAgent</td>
<td>a valid 8 digit HUID</td>
<td>xxxxxxxx</td>
<td>Person depositing the object.</td>
</tr>
<tr>
<td>objectOSN</td>
<td>A unique value within the content’s Owner Code</td>
<td>A299ff</td>
<td>Name for the object</td>
</tr>
<tr>
<td>ownerCode</td>
<td>a valid Owner Code</td>
<td>FHCL.MUSI</td>
<td>Owning unit of the object</td>
</tr>
<tr>
<td>resourcePattern</td>
<td>an NRS resource pattern, see Section 16.1 Assigning File</td>
<td>{n}</td>
<td>Resource name pattern for any URNs created for this object’s files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>One or more roles for the object (not likely to be used - included to support future uses)</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>role</td>
<td>currently no roles for audio object are used</td>
<td></td>
<td></td>
</tr>
<tr>
<td>failureEmail</td>
<td>one or more valid email addresses separated by commas</td>
<td>People who will be sent failed loader reports</td>
<td></td>
</tr>
<tr>
<td>successEmail</td>
<td>one or more valid email addresses separated by commas</td>
<td>People who will be sent successful loader reports</td>
<td></td>
</tr>
<tr>
<td>successMethod</td>
<td>one of: EMAIL, DROPBOX, ALL</td>
<td>Distribution method for the loader reports</td>
<td></td>
</tr>
</tbody>
</table>

**Sample audio.properties file.**

```
#properties for the object
alephID=009513791
authorityPath=FHCL.Loeb
batchName=Project_137_4a
billingCode=FHCL.MUSI.MUS_004
depositAgent=12345678
failureEmail=example1@fas.harvard.edu,example2@fas.harvard.edu
objectOSN= A299ff
ownerCode=FHCL.MUSI
resourcePattern={n}
successEmail=example1@fas.harvard.edu,example2@fas.harvard.edu
successMethod=EMAIL
```

Place the audio.properties file at the root of the batch directory, e.g.:

```
…/my_batch-19a326/
    audio.properties
```

3. Create **relationships.csv file**. Put this file at the root of batch directory.
This must be a comma-separated file named relationships.csv, supplying relationships between files in the object, and/or between this object and existing DRS object, and/or between files in this object and existing DRS files or objects.

The file paths inside the file need to be in the form supported by the OS on which you are running Batch Builder (POSIX for MAC/Linux and DOS-style for Windows).

The syntax must be:

\[
\text{[Source\_filePath],[relationship\_name],[target\_type],[target]}
\]

where

- **Source\_filePath:**
  - for files in this object: relative path to the source file from the object directory for this object

- **relationship\_name**, one of:
  - HAS\_SOURCE (indicates derivative relationships between files in this object)
  - HAS\_DOCUMENTATION (for pointing from files or the object to DRS-stored documentation files or objects)
  - HAS\_METHODOLOGY (for pointing from the object to a DRS-stored methodology object)
  - HAS\_RIGHTS (for pointing from files or the object to DRS-stored rights files or objects)

- **target\_type**, one of:
  - RELATIVE\_PATH (used for a relative file path)
  - HUL\_DRS\_OBJECT\_URN (used for the URN of a DRS object)
    - For example: urn-3:HUL.DRS.OBJECT:175616
    - These are persistent IDs new to DRS2 given to all objects that always have a HUL.DRS.OBJECT authority path
  - OBJECT\_OSN (used for the Owner Supplied Name of a DRS object having the same owner code as this object) Note that the object ingest service needs to be updated to support handling relationships using OBJECT\_OSN
  - HUL\_DRS\_OBJECT\_ORACLE – DRS ID of the target object
  - HUL\_DRS\_FILE\_ORACLE – DRS ID of the target file

- **Target**: relative path to a file, DRS object URN or DRS object owner supplied name

Lines can be commented out by starting the line with the ‘#’ symbol

**Sample relationships.csv file.** The paths need to be in the form supported by OS you are running Batch Builder on.

```
# Derivative audio content relationships
deliverable\performances\file1.mp3,HAS\_SOURCE,RELATIVE\_PATH,production\sub\dir1\file1.wav
deliverable\performances\file2.mp3,HAS\_SOURCE,RELATIVE\_PATH,production\sub\dir1\file1.wav
deliverable\performances\file3.mp3,HAS\_SOURCE,RELATIVE\_PATH,production\sub\dir1\file1.wav
```

Revised: April 14, 2015
deliverable\performances\file4.mp3,HAS_SOURCE, RELATIVE_PATH,production\sub_dir1\file2.wav

Place this file at the root of the batch directory, e.g.:

…/my_batch-19a326/
    audio.properties
    relationships.csv

Note that the following relationships are automatically determined by Batch Builder and should not be listed in the relationships.csv file:

- **HAS_DOCUMENTATION** relationships between audio files and ADL audio decision lists deposited at the same time
- **HAS_PRESENTATION** relationships between audio deliverable files and AES60 playlist objects deposited at the same time.

4. If manually supplying descriptive metadata, create a MODS file called mods.xml complying with MODS schema versions 3.4 or earlier. See [http://www.loc.gov/standards/mods/](http://www.loc.gov/standards/mods/) for more information about MODS metadata and schemas.

Place this file at the root of the batch directory, e.g.:

…/my_batch-19a326/
    audio.properties
    mods.xml
    relationships.csv

Note that as an alternative to supplying a MODS file, descriptive metadata can be imported from Aleph by Batch Builder by providing an Aleph ID in the audio.properties file.

5. **Optionally provide technical metadata for files** in the batch in the AES57 format.

These files should be named the same as the files they describe, except with an xml file extension. For example in Figure 1 on page 1 of this document, the file at

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.xml

contains technical metadata for the file at

my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav

Batch Builder will read in and use the technical metadata supplied by these files but will supplement it with format metadata supplied by FITS (see [http://fits.googlecode.com](http://fits.googlecode.com)).

6. **Optionally provide file-level properties files for files in the batch** to override Batch Builder-configured metadata values. These files can contain any file-level batch Builder properties. Each properties file contains properties for a specific audio file. It needs to be placed in the same directory with the audio file the properties of which it is listing. The properties that can be provided in the file-level properties files are shown in the Table below.

<table>
<thead>
<tr>
<th>Property</th>
<th>Valid values</th>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessFlag</td>
<td>one of: P,R,N</td>
<td>P</td>
<td>Access level of file</td>
</tr>
<tr>
<td>adminCategory# -- done</td>
<td>A comma-delimited list of one or more Wordshack URIs –</td>
<td><a href="http://id.lib.harvard.edu/wordshack/admin">http://id.lib.harvard.edu/wordshack/admin</a> Category/12345</td>
<td>Administrative categories to associate with the file</td>
</tr>
<tr>
<td><strong>fileosn</strong></td>
<td>34561-a7-bach</td>
<td>Name for the file (not necessarily unique)</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>-------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>isFirstGenerationInDrs</strong></td>
<td>yes</td>
<td>whether or not the file is the closest version in the DRS to the original capture or creation</td>
<td></td>
</tr>
<tr>
<td><strong>isPreferredDeliverableSource</strong></td>
<td>yes</td>
<td>whether or not the file is the recommended file to use for generating future deliverables</td>
<td></td>
</tr>
<tr>
<td><strong>processing</strong></td>
<td>BIT_REDUCED, DENOISED</td>
<td>Key actions taken on the file before it was deposited to the DRS</td>
<td></td>
</tr>
<tr>
<td><strong>quality</strong></td>
<td>5</td>
<td>Locally-defined measure of quality</td>
<td></td>
</tr>
<tr>
<td><strong>usageClass</strong></td>
<td>LOWUSE</td>
<td>Estimate of how frequently the file will be accessed by library users</td>
<td></td>
</tr>
<tr>
<td><strong>methodology</strong></td>
<td>(any text)</td>
<td>Notes about the methods</td>
<td></td>
</tr>
<tr>
<td>role</td>
<td>comma-delimited list of one or more of: ARCHIVAL_MASTER, CONTAINER, DELIVERABLE, DOCUMENTATION, LICENSE, LOG, ORIGINAL_ORDER, PAGE_COORDINATES, PAGE_IMAGE, PAGE_TEXT, PRODUCT_MASTER, STYLE_SHEET, TARGET_DESCRIPTION, TARGET_IMAGE, THUMBNAIL, AUDIO_DECISION_LIST, PROCESS_FILES, PROCESS_HISTORY</td>
<td>DELIVERABLE</td>
<td></td>
</tr>
<tr>
<td>downloadProhibited (for audio files)</td>
<td>yes</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Audio file must be streamed - direct download will not be permitted. Note that you need to include this property only if value is set to ‘yes’. If the value is set to ‘no’ simply do not include the property. It is set at ‘no’ by default. If the property is provided and set to ‘yes’ you also need to set the downloadProhibitedBasis property listed below.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basis for the restrictions or terms of use.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*Required if downloadProhibited property is supplied.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>downloadProhibitedLicense (for audio files)</td>
<td>DRS object URN of the license object</td>
<td>urn-3:HUL.DRS.OBJECT:T:197548</td>
<td></td>
</tr>
<tr>
<td>ID of the documentation within the DRS, e.g. a deposited donor agreement</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>downloadProhibitedLicense (any text)</td>
<td>90 year policy</td>
<td>A note about the</td>
<td></td>
</tr>
<tr>
<td>Tabular Representation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>enseTerms</strong></td>
<td>(for audio files)</td>
<td>documentation, e.g. the applicable section</td>
<td></td>
</tr>
<tr>
<td><strong>downloadProhibitedGrantStart</strong></td>
<td>A date/timestamp</td>
<td>yyyy-mm-dd yyyy-mm yyyy schema date and schema dateTime formats</td>
<td></td>
</tr>
<tr>
<td>(for audio files)</td>
<td></td>
<td>Embargo start date</td>
<td></td>
</tr>
<tr>
<td><strong>downloadProhibitedGrantEnd</strong></td>
<td>A date/timestamp</td>
<td>yyyy-mm-dd yyyy-mm yyyy schema date and schema dateTime formats</td>
<td></td>
</tr>
<tr>
<td>(for audio files)</td>
<td></td>
<td>Embargo end date</td>
<td></td>
</tr>
</tbody>
</table>

Note that because of the way the support for PREMIS rights is implemented in the advanced workflow properties files, you can also set object level embargo and secure storage rights in the audio.properties files. You just need to use the appropriate property names.

These files should be named the same as the files they describe, except with a properties file extension. For example the file at

```
my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.properties
```

would contain metadata for the file at

```
my_batch-19a326/my_object-A299ff/archival/sub_dir1/file1.wav
```

### 13.4.4 Batch Builder Execution

The syntax is:

```
./batchbuildercli.sh -advanced audio -d path-to-object-directory
```

where the `path-to-object-directory` is a relative or absolute path to the directory containing the content needed to build a single audio object.

For example:

```
./batchbuildercli.sh -advanced audio -d /home/prod/content/my_batch-19a326/obj-994533
```

The program will:
- Create a directory at `workspace/moved_content`
- Put a copy of the files that were in the `misc` directory in the `workspace/moved_content` directory
- Zip up the contents of the `misc` directory and name it `misc_files.zip`
- Create the object descriptor for the audio content
  - The AES57 file at `original/?.xml` will be interpreted as technical metadata for the original item to be stored in a `<sourceMD>` element in the descriptor
  - If any AES60 files were included in the playlist directory:
    - Build separate Text objects for each playlist
- The file name will be used as the object owner-supplied-name
- Create the object descriptor for each object
- The descriptor will be named `{object-OSN}_descriptor.xml` and will be written to the batch directory
- (Relationships between the playlist object and audio deliverable files will be automatically created by the DRS Loader.)

After executing Batch Builder the following changes should be visible in the batch directory:

/my_batch-19a326/
- `batch.xml` (DRS batch loading file)
- `descriptor.xml` (object descriptor for the audio object)
- `my_object-A299ff/`
  - `misc/`
    - `misc_files.zip` (files that were in the misc directory)
  - `workspace/`
    - `moved_content/` (contains content in the misc directory)
  - `playlist1-A299ff_descriptor.xml` (descriptor for playlist object containing `playlist1-A299ff.xml`)
  - `playlist2-A299ff_descriptor.xml` (descriptor for playlist object containing `playlist2-A299ff.xml`)

### 13.4.5 Depositing to the DRS

After executing the script, copy the following portion of the directory structure to your DRS dropbox.

/my_batch-19a326/ (example batch directory)
- `batch.xml`
- `descriptor.xml`
- `my_object-A299ff/` (example object directory)
  - `archival/`
  - `deliverable/`
  - `misc/`
  - `original/`
  - `production/`
  - `playlist1-A299ff_descriptor.xml` (example descriptor for a playlist object)
  - `playlist2-A299ff_descriptor.xml` (example descriptor for a playlist object)

The DRS loader will not automatically delete any files or directories that are uploaded to a dropbox but that aren’t referenced in the object descriptors. These files and directories should be filtered out as part of the transfer process; otherwise they will need to be manually deleted from the dropbox. These include:

- Any other subdirectories in the object directory (e.g. pre-archival, workspace)
- Properties files (audio.properties)
- AES57 files used to indicate metadata for the original item or for audio content files (*.xml)
- MODS file (mods.xml)
- Relationships file (relationships.csv)

**Notes:**

- Object owner-supplied-names (Object OSNs)
Object OSNs are required in DRS 2 and must be unique within an Owner Code. Please keep that in mind when explicitly assigning objects names, for example in the audio.properties file; or implicitly for example, by the file names of the AES60 playlists.

- URNs
  - An object-level URN is automatically given to all objects.
    These URNs will have a HUL.DRS.OBJECT authority path, e.g. urn-3:HUL.DRS.OBJECT:175844
  - File-level URNs are automatically given to files with the role DELIVERABLE.
    These URNs will have a local authority path, e.g. urn-3:FHCL.Loeb.Faids:mus00023

14.1 Basic command line syntax

14.2 Switches

14.3 Deposit settings properties

14.4 Object properties

14.5 Directory properties

The Batch Builder 2 installation package includes a command line interface tool (CLI) designed for automated deposit workflows that performs three actions:

- **build**: build the descriptors and batch.xml for a specified batch within a specified project using batch, object and directory level property values supplied on command line or/and in the Graphical User Interface (GUI).

- **templatedirs**: rebuild the directories in the object template from the information in the project configuration file.

- **buildtemplate**: Create a new batch with objects from template in the specified project.

CLI should be used in conjunction with the GUI. For instance, a depositor can use the Batch Builder GUI to build the initial project, and then use the command line to substitute batch-level, object-level and directory level metadata values when processing batches of objects.

**CLI On-screen Help.** To see on-screen help while in CLI type:

```plaintext
batchbuildercli -h to display only example usage
batchbuildercli --fullhelp to display example usage and a list of all overridable batch, object and directory properties
```

14.1 Basic command line syntax

**Please note** that on computers running Microsoft Windows XP or later, the maximum length of the string that you can use at the command prompt is 8191 characters.

```plaintext
batchbuildercli -a action -p project_dir -b batch_name
-a actions: templatedirs, buildtemplate, build.
[--aleph object_name=123;...]
[--batchprop property=value,property=value,property=value;...]
[--objectprop object_name::property=value,property=value;...]
[--dirprop object_name::directory_path::property=value,property=value;...]
```

14.2 Switches

- **-a [action]** – required – accepts three actions: templatedirs, buildtemplate, and build.

- **templatedirs**: rebuild the directories in the object template from the information in the project configuration file.

- **buildtemplate**: Create a new batch with objects from template in the specified project.
• **build**: build the descriptors and batch.xml for a specified batch within a specified project using batch, object and directory level property values supplied on command line or/and in the Graphical User Interface (GUI).

**-p [project directory path]** – required – indicates the path to the project directory on disk. This path must be created in Batch Builder GUI before using the command line option. The project path cannot be created while executing this command. If path does not already exist the action will fail.

**-b [batch_name]** – required for actions buildtemplate and build – name of batch directory. When using buildtemplate action BB2 will create a new batch directory with the name specified by the -b switch, e.g.: `batchbuildercli -a buildtemplate -p c:\myproject\ -b new_batch_directory_name`. When using the build action, BB2 will process the existing batch directory specified by the -b switch, e.g.: `batchbuildercli -a build -p c:\myproject\ -b existing_batch_directory_name`.

**-aleph [object_name1]=[alephID];[object_name2]=[alephID] etc.** – optional – system number of corresponding record in ALEPH. Batch Builder uses this number to pull metadata from the corresponding ALEPH record into the MODS section of the object descriptor. This switch can be used with action build. Example:

```
-aleph obj1=12345;obj2=67890
```

**Note** that no other methods of entering aleph id or MODS should be used for the batch if this switch is invoked – such as mapping files with ALEPH IDs, user supplied MODS files, descriptive metadata entered in the GUI or ALEPH IDs supplied in the GUI – otherwise BB will throw an error or silently fail to write the new ALEPH ID into the descriptor.

**-batchprop [property=value,property=value,property=value...]** – optional – overrides specified project deposit settings for a given batch. The -batchprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’. Repeatable batch property values should be as property=value pairs separated by a comma – e.g.:

```
- batchprop “successEmail=success1@example.com,successEmail=success2@example.com”
```

**-objectprop [object_name::property=value,property=value;...]** – optional – overrides specified object metadata properties for given objects. The -objectprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’.

**-dirprop [object_name::directory_path::property=value,property=value;...]** – optional – overrides specified file metadata property values for given files. The -dirprop argument must be wrapped in quotes to ensure that the entire string is passed correctly to Batch Builder. Each property=value pair should be separated by a comma ‘,’.

**Example** (using all switches listed above):

```
C:\BatchBuilder-2.0.50> batchbuildercli -a build -p "C:\my_project\" -b batch1 -aleph objectname1=12345;objectname2=67890; -batchprop batchName=mybatch{depositAgent}{batchDir}{ss},successEmail=success@me.me,failureEmail=failure@me.me,successMethod=email,depositAgent=12345678" -objectprop objectname1::“metsLabel=some citation information”;objectname2::“metsLabel=some citation information2” - dirprop objectname1::image_archmaster::accessFlag=N,isFirstGenerationInDrs=yes,quality=10;objectname1::image_archmaster\image-
```
14.3 Deposit settings properties (batch properties)

Syntax:  `-batchprop property=value,property=value,property=value...`

- `projectName` -- substitutes passed string for the existing BB project name
- `projectDescription` – substitutes passed string for the existing content of the project description field
- `batchName` – substitutes passed string for the default batch name (not the batch directory name)
  E.g.: `-batchprop batchName=mybatch`
  E.g.: `-batchprop batchName={depositAgent}{batchDir}{ss}`
- `successEmail` – substitutes passed string for success email(s) (emails should be separated by comma without any blank space in between)
  E.g.: `-batchprop successEmail=myname@example.com,myname2@example2.com`
- `failureEmail` – substitutes passed string for failure email(s)
  E.g.: `-batchprop failureEmail=myname@example.com,myname2@example2.com`
- `successMethod` - substitutes passed string for the successMethod specified in deposit settings panel in the GUI. The options are `email`, `all`, `dropbox`.
  E.g.: `-batchprop successMethod=email`
- `depositAgent` - substitutes passed string for the deposit agent HUID specified in deposit settings panel
  E.g.: `-batchprop depositAgent=12345678`

Example:

```
C:\BatchBuilder-2.0.50> batchbuildercli -a build -p "C:\my_project_path" -b batch1 -batchprop "batchName=mybatch{depositAgent}{batchDir}{ss},successEmail=succes@me.me,failureEmail=failur@me.me,successMethod=email,depositAgent=12345678"
```

14.4 Object properties

To pass an Aleph ID (in order to import metadata from Aleph) use a separate switch: `-aleph`
See section 14.2 Switches for an example.

Syntax 1: (for all object properties except relatedLinks and harvardMetadataLinks)

```
-objectprop
object_name1::property=value,property=value;object_name2::property=value,property=value; etc.
```

Syntax 2: (for relatedLinks and harvardMetadataLinks properties):
-objectprop object_name1::relatedLinks="Relationship=value --- URI=value";object_name2::relatedLinks="Relationship=value --- URI=value"; etc.

Note that the separator between “Relationship=value” field/value pair and “URI=value” field/value pair is “ --- “ (i.e. “{blank_space}{three dashes}{blank_space}”).

-objectprop object_name1::harvardMetadataLinks="Type=LinkType --- Identifier=value";object_name2::harvardMetadataLinks="Type=LinkType --- Identifier=value" etc.

Note that the separator between “Type=LinkType” field/value pair and “Identifier=value” field/value pair is “ --- “ (i.e. “{blank_space}{three dashes}{blank_space}”).

The LinkType value for harvardMetadataLinks comes from a controlled list. The following are valid link types (case sensitive):

- Aleph
- Finding Aid
- Gale
- HLSL
- HULPR
- Local
- OCLC
- RLIN
- URI

### List of overridable object properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>ownerCode</td>
<td>Owner Code</td>
</tr>
<tr>
<td>billingCode</td>
<td>Billing Code</td>
</tr>
<tr>
<td>accessFlag</td>
<td>DRS Access Flag</td>
</tr>
<tr>
<td>adminCategory</td>
<td>Administrative Category ID (can be looked up in Word Shack by searching for Admin Category display value)</td>
</tr>
<tr>
<td>captionBehavior</td>
<td>IDS / PDS Caption Behavior</td>
</tr>
<tr>
<td>captionUnitName</td>
<td>IDS / PDS Caption Unit Name</td>
</tr>
<tr>
<td>captionDescription</td>
<td>IDS / PDS Caption Description</td>
</tr>
<tr>
<td>metsLabel</td>
<td>METS Label display value (currently displays in citation label of PDS Document objects)</td>
</tr>
<tr>
<td>methodology</td>
<td>Object methodology</td>
</tr>
<tr>
<td>nonPublicNote</td>
<td>Value for the non-public note field</td>
</tr>
<tr>
<td>processingLevel</td>
<td>Object processing level</td>
</tr>
<tr>
<td>producer</td>
<td>Object producer – controlled value from Word Shack</td>
</tr>
<tr>
<td>relatedLinks</td>
<td>Related links values – displays in PDS</td>
</tr>
<tr>
<td>harvardMetadataLinks</td>
<td>Harvard metadata links values – displays in PDS</td>
</tr>
<tr>
<td>viewText</td>
<td>viewText option – affects display of text in PDS</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>secureStorage</td>
<td>not yet implemented.</td>
</tr>
<tr>
<td>secureStorageBasis</td>
<td>not yet implemented.</td>
</tr>
<tr>
<td>secureStorageLicense</td>
<td>not yet implemented.</td>
</tr>
<tr>
<td>secureStorageLicenseTerms</td>
<td>not yet implemented.</td>
</tr>
<tr>
<td>secureStorageGrantEnd</td>
<td>not yet implemented.</td>
</tr>
<tr>
<td>embargoDuration</td>
<td>Embargo duration value in days, months or years</td>
</tr>
</tbody>
</table>
| embargoBasis | One of the controlled values:  
  - Harvard policy  
  - license  
  - risk assessment  
  - statute  
  - copyright |
<p>| embargoLicense | URN of the DRS license object – corresponds to BB GUI field Documentation |
| embargoLicenseTerms | Corresponds to BB GUI field Documentation Note |
| embargoGrantStart | Corresponds to BB GUI field Start Date |
| embargoGrantEnd | Corresponds to BB GUI field End Date |
| harvardPolicy | URN of an existing Harvard policy object in DRS |
| license | URN of an existing license object in DRS |
| statute | URN of an existing statute object in DRS |
| titleInfoType | MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information |
| titleInfoTitle | MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information |
| titleInfoSubTitle | MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information |</p>
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>See also</th>
</tr>
</thead>
<tbody>
<tr>
<td>titleInfoType2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>titleInfoTitle2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>titleInfoSubTitle2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>titleInfoPartNumber2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>titleInfoPartName2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>titleInfoNonSort2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameType</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAuthority</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameNamePart</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameNamePartType</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDisplayForm</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAffiliation</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>nameRoleTerm</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDescription</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameType2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAuthority2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameNamePart2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameNamePartType2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDisplayForm2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAffiliation2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameRoleTerm2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDescription2</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameType3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAuthority3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameNamePart3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>namePartType3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDisplayForm3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameAffiliation3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameRoleTerm3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>nameDescription3</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>typeOfResource</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>typeOfResourceCollection</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>typeOfResourceManuscript</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>genre</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoPlaceTerm</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoPublisher</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoDateIssued</td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>Origin Information Field</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>originInfoDateCreated</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoDateCaptured</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoDateValid</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoDateModified</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoCopyrightDate</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>originInfoDateOther</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>languageTerm</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>physicalDescriptionReformattingQuality</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>physicalDescriptionDigitalOrigin</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>abstract</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>tableOfContents</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>classification</td>
<td>MODS Metadata - see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>identifierType</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>identifierType2</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>identifier3</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>identifierType3</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>accessCondition</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>accessConditionDisplayLabel</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>accessConditionType</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>recordInfoRecordIdentifier</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>recordInfoSource</strong></td>
<td>MODS Metadata – see <a href="http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html">http://www.loc.gov/standards/mods/v3/mods-userguide-elements.html</a> for more information</td>
<td></td>
</tr>
<tr>
<td><strong>has_documentation</strong></td>
<td>Object URN of a related Documentation object in DRS</td>
<td></td>
</tr>
<tr>
<td><strong>Has_methodology</strong></td>
<td>Object URN of a related Methodology object in DRS</td>
<td></td>
</tr>
</tbody>
</table>
urnAuthorityPath | URN Authority Path
resourceNamePattern | Resource Name Pattern for a URN
role | Object role

Example 1:
C:\Program Files\BatchBuilder\BatchBuilder-2.0.14> batchbuildercli -a build -p "C:\Documents and Settings\user\Desktop\stillimage-imgs-Shared Shelf" -b batch3 -objectprop "Obj1::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001,urnAuthorityPath=FHCL"

Example 2:
C:\Program Files\BatchBuilder\BatchBuilder-2.0.14> batchbuildercli -a build -p "C:\Documents and Settings\user\Desktop\stillimage-imgs-Shared Shelf" -b batch4 -objectprop "Obj1::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001,urnAuthorityPath=FHCL;Obj2::ownerCode=FHCL.FAL,billingCode=FCHL.FAL.SSP_0001,urnAuthorityPath=FHCL"

14.5 Directory (file) properties

Syntax: -dirprop
"object1::directory_path1::property=value,property=value;object1::directory_path2::property=value,property=value;object2::directory_path1::property=value,property=value" ... etc.

List of overridable directory properties

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessFlag</td>
<td>File DRS Access Flag</td>
</tr>
<tr>
<td>adminCategory</td>
<td>Administrative Category ID (can be looked up in Word Shack by searching for Admin Category display value)</td>
</tr>
<tr>
<td>adminFlag</td>
<td>Administrative Flag</td>
</tr>
<tr>
<td>adminFlagNote</td>
<td>Administrative Flag Note</td>
</tr>
<tr>
<td>isFirstGenerationInDrs</td>
<td>Is first generation in DRS</td>
</tr>
<tr>
<td>isPreferredDeliverableSource</td>
<td>Is preffered deliverable source (for future reformatting purposes)</td>
</tr>
<tr>
<td>nonPublicNote</td>
<td>Value for the non-public note field</td>
</tr>
<tr>
<td>processing</td>
<td>Processing</td>
</tr>
<tr>
<td>producer</td>
<td>Object producer – controlled value from Word Shack</td>
</tr>
<tr>
<td>quality</td>
<td>Quality</td>
</tr>
<tr>
<td>usageClass</td>
<td>Usage Class</td>
</tr>
<tr>
<td>methodology</td>
<td>File Methodology</td>
</tr>
<tr>
<td>processingNote</td>
<td>Processing Note (Text files)</td>
</tr>
<tr>
<td>encodingAgent</td>
<td>Encoding Agent (Text files)</td>
</tr>
<tr>
<td>encodingRole</td>
<td>Encoding Role (Text files)</td>
</tr>
<tr>
<td>language</td>
<td>Language (Text files)</td>
</tr>
<tr>
<td>disposition</td>
<td>Audio Metadata</td>
</tr>
<tr>
<td>useType</td>
<td>Audio Metadata</td>
</tr>
</tbody>
</table>

Revised: April 14, 2015
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>leftRightPanMap</td>
<td>Audio Metadata</td>
</tr>
<tr>
<td>frontRearPanMap</td>
<td>Audio Metadata</td>
</tr>
<tr>
<td>role</td>
<td>Role</td>
</tr>
<tr>
<td>has_target</td>
<td>Has target in DRS</td>
</tr>
<tr>
<td>has_color_profile</td>
<td>Has color profile in DRS</td>
</tr>
<tr>
<td>has_world_reference_data</td>
<td>Has world location in DRS</td>
</tr>
<tr>
<td>has_documentation</td>
<td>Has documentation in DRS</td>
</tr>
<tr>
<td>has_subset</td>
<td>Has subset files in DRS</td>
</tr>
<tr>
<td>has_presentation</td>
<td>Has a playlist in DRS (Audio only)</td>
</tr>
<tr>
<td>maxPixelDimension</td>
<td>IDS restriction on delivery size for JP2 images in pixels</td>
</tr>
<tr>
<td>maxPixelBasis</td>
<td>One of the controlled values:</td>
</tr>
<tr>
<td></td>
<td>• Harvard policy</td>
</tr>
<tr>
<td></td>
<td>• license</td>
</tr>
<tr>
<td></td>
<td>• risk assessment</td>
</tr>
<tr>
<td></td>
<td>• statute</td>
</tr>
<tr>
<td></td>
<td>• copyright</td>
</tr>
<tr>
<td>maxPixelLicense</td>
<td>URN of the DRS license object – corresponds to BB GUI field Documentation</td>
</tr>
<tr>
<td>maxPixelLicenseTerms</td>
<td>Corresponds to BB GUI field Documentation Note</td>
</tr>
<tr>
<td>downloadProhibited</td>
<td>Prohibits delivery of audio as downloadable file. Audio will only be delivered as streaming</td>
</tr>
<tr>
<td>downloadProhibitedBasis</td>
<td>One of the controlled values:</td>
</tr>
<tr>
<td></td>
<td>• Harvard policy</td>
</tr>
<tr>
<td></td>
<td>• license</td>
</tr>
<tr>
<td></td>
<td>• risk assessment</td>
</tr>
<tr>
<td></td>
<td>• statute</td>
</tr>
<tr>
<td></td>
<td>• copyright</td>
</tr>
<tr>
<td>downloadProhibitedLicense</td>
<td>URN of the DRS license object – corresponds to BB GUI field Documentation</td>
</tr>
<tr>
<td>downloadProhibitedLicenseTerms</td>
<td>Corresponds to BB GUI field Documentation Note</td>
</tr>
<tr>
<td>harvardPolicy</td>
<td>Object URN of related Harvard policy object in DRS</td>
</tr>
<tr>
<td>license</td>
<td>Object URN of related license object in DRS</td>
</tr>
<tr>
<td>statute</td>
<td>Object URN of related statute object in DRS</td>
</tr>
<tr>
<td>idsDeliverableURNs</td>
<td>Additional IDS URNs for individual images within a PDS Document object</td>
</tr>
</tbody>
</table>

See the [DRS 2 Metadata Reference](#) document for more detailed descriptions of the substituted properties. See [Adding Relationships](#) section for more details definitions of substituted relationship values.

**Example:**
C:\Program Files\BatchBuilder\BatchBuilder-2.0.45>batchbuildercli -a build -p "E:\Testing\BatchBuilderProjects\Still-Image-20110907" -b batch4 -batchprop "successEmail=succes1@example.com,successEmail=succesemail2@example.com,failureEmail=failure@example.com" -objectprop "obj1::ownerCode=FHCL.FAL,billingCode=FHCL.FAL.SSP_0001,accessFlag=R,urnAuthorityPath=FHCL;obj2::ownerCode=FHCL.FAL,billingCode=FHCL.FAL.SSP_0001,accessFlag=R,urnAuthorityPath=FHCL" -dirprop "obj1::image_archmaster::accessFlag=N,isFirstGenerationInDrs=yes,quality=10;obj1::image_archmaster\image_deliverable::accessFlag=R,isFirstGenerationInDrs=yes,quality=5"
15. Using External Mapping Files to Supply ownerSuppliedNames, Page Sequence Numbers and Aleph IDs.

15.1 Using mapping.txt file

Batch Builder can use external mapping files to:

1. Associate **Owner Supplied Names** with existing files and new (to be built automatically by BB) objects (mapping.txt)
2. Associate **Aleph IDs** with new (to be built automatically by BB) objects (mapping.txt)
3. Determine **page sequence numbers** for PDS Document objects (mapping.txt)
4. Associate Harvard Metadata Links (links to discovery systems) and Related Links (links to any system or website) with new objects or existing objects in a batch (mapping.txt)
5. Associate **Aleph IDs** with existing objects (object_mapping.txt)
6. Associate **Owner Supplied Names** with existing objects (object_mapping.txt)

Mapping files can be used in two ways:

- To interact with files and objects during automatic object building from template.
- To interact with files and objects during batch processing.

Batch Builder will display an INFO message in the message panel when any of the auxiliary input files are discovered, e.g.:

```
INFO   - found mapping.txt in E:\Testing\DRS_2.2\BatchBuilderProjects\StillImage-2-3-11\aux\batch1\ObjwJP2
```

15.1 Using mapping.txt file

**Rules for using mapping.txt file**

**File name:** mapping.txt

**Function:**

- Objects that are built by BB automatically from template will inherit the following property values specified in this file: File Owner Supplied Name, PDS Document sequence number, Object Owner Supplied Name, Aleph ID, Harvard Metadata Links, Related Links.
- Objects that are created manually will inherit the following property values specified in this file: File Owner Supplied Name, PDS Document sequence number, Harvard Metadata Links, Related Links.

**Placement:**

- For use during automatic object building, place the file in the `{project_dir}/_aux/template/` directory. When used with the automatic object building function the file will be automatically copied to `{project_dir}/_aux/{batch_name}/{object_name}/` for each object created.
- For use during manual object building, place the file in the `{project_dir}/_aux/{batch_name}/{object_name}/` directory.
Syntax:
relative_file_path,file_OwnerSuppliedName,PDS_sequence_number(optional),object_OwnerSuppliedName(optional),AlephNumber(optional),Harvard_metadata_identifier_type|metadata_identifier(optional),relatedlink_relationship_type|relationship_uri(optional)

Additional notes on syntax:

Harvard metadata links can be repeatable, in which case multiple links are separated by a double pipe character ‘||’:
Harvard_metadata_identifier_type|metadata_identifier||
Harvard_metadata_identifier_type|metadata_identifier

Related links can also be repeatable, in which case multiple links are separated by a double pipe character ‘||’:
relatedlink_relationship_type|relationship_uri||relatedlink_relationship_type|relationship_uri

There should be no spaces between a comma ‘,’ and the next character. If an optional element value is skipped it still needs to be designated by a comma ‘,’ so Batch Builder can associate the right value with the right element. Harvard metadata links and related links only need to be specified once per object. Once they are specified once, they can be omitted for other files in the object (no need to mark their absence with commas in that case).

Example 1:

image_arch\DDC003144.tif,DDC003144,,obj_DDC003144,524391,Aleph|524391||Finding Aid|hou02239,Google|http://www.google.com|Gale|http://www.gale.com

In this example, there is a skipped PDS sequence number indicated by two commas. There are two values for Harvard metadata links and two values for related links.

Note that Harvard metadata links and related links only need to be specified once per object. If the object has more than one file, Harvard metadata links and related links can be specified for any file in the object and they will end up as properties for the object. In the line that specifies properties for the deliverable file, no related links and Harvard metadata links need to be specified because they were already specified for the archival master file in the object.

Example 2:

image_arch\DDC003144.tif,DDC003144,,obj_DDC003144,524391

In this example, there is a skipped PDS sequence and a skipped Harvard metadata link value. Both missing values are indicated by two commas. The related link value is specified only for the first file in the object.

Example 3:
In this example, there is a PDS sequence number for each file and the Aleph ID, the DRS Metadata link and the related link values are skipped.

**Parameters in detail:**

- **Relative file path**: the relative path to the file (including the file name and extension), from either the `_aux/{batch}/{object}`, or `_aux/template` directory. This is the file that the next 3 parameters will be applied to. Use the POSIX (UNIX style) path when on Mac or Linux and Windows style path when on Windows.

- **File Owner Supplied Name**: (Required) - The file owner supplied name

- **Sequence number**: (Optional) - Alternate method to providing the sequence number as part of the file name pattern. This controls in which order page images and text appear in PDS Document objects when they are displayed in PDS.

- **Object Owner Supplied Name**: (Optional) - When the object Owner Supplied Name is not provided as part of the file name pattern, then this property can be used to control which files are added to which objects when building objects from the template. This parameter is ignored when the mapping.txt file is placed directly into `_aux/{batch}/{object}/` directory for a manually created object.

- **Aleph ID** (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch Builder imports MODS descriptive metadata from the HOLLIS record specified and places it into the object descriptor during batch processing.

   Note that Batch Builder supports multiple methods of receiving MODS descriptive metadata. These include supplying a custom MODS file, entering descriptive metadata directly in the graphical user interface and supplying Aleph ID to import MODS from HOLLIS. Only one method at a time can be used. For instance, if you are supplying a custom MODS file you cannot provide Aleph ID to import MODS from HOLLIS.

- **Harvard metadata links** (Optional) – link to a record in one of the discovery systems specified on the controlled list. Use the controlled list of discovery systems to specify what system is the link to: Aleph, Finding Aid, Gale, HULPR, Local, OCLC, RLIN. Currently, actionable links to HOLLIS and OASIS are created automatically when the record identifier for these systems is supplied. For OASIS use ‘Finding Aid’.

- **Related links** (Optional) – link to any discovery system or website. Full URL needs to be provided in order for the link to be actionable.

**Procedure for creating and placing a mapping file**

**Create the mapping file:**

1. Create a text file called "mapping.txt". If your batch contains multiple objects, file mappings for all objects can go in this one file.

2. Add a line of mapping values for every file to be mapped, using the syntax:

   relative_file_path,file_OSN,PDS_sequence_number(optional),object_OSN(optional),AlephID (optional),Harvard_metadata_identifier_type|metadata_identifier(optional),relatedlink_relationship_type|relationship_uri(optional)
Example:

```
image_arch\DDC003144.tif,DDC003144,,obj_DDC003144,524391,Aleph|524391||Finding Aid|
hout02239,Google|http://www.google.com|Gale|http://www.gale.com
image_arch\image-del\DDC003144.tif,DDC003144,,obj_DDC003144,524391
```

Save the mapping.txt file.

Add the mapping file to the batch:

3. If using the manual object workflow:
   a. Create the batch with objects (Step 5 in the batch procedure). This will generate batch directory structure on disk.
   b. Copy mapping.txt into the object directory inside the BB project's auxiliary (_aux) path:
      `{project_dir}/_aux/{batch_name}/{object_name}/`
      If you have file mappings for multiple objects in a batch, place a copy of the same file into each corresponding object directory inside the BB project's auxiliary (_aux) path.
   c. Continue with your batch procedure.

4. If using the automatic object workflow:
   a. Add directories to the template and copy content files into those directories (Steps 4-5 in the batch procedure).
   b. Place mapping.txt into the template directory in the BB project's auxiliary (_aux) path:
      `{project_dir}/_aux/template/`
   c. Continue with your batch procedure.

5. When BB processes the batch, an INFO message displays in the message panel when the mapping file is discovered, for example:

```
INFO   - found mapping.txt in C:\drs2-beta2-training-BB\BB2-projects-2.0.19o\image-project\_aux\batch-brueghel-skaters-3\object-skaters-3
```

15.2 Using object_mapping.txt file

**File Name:** object_mapping.txt

**Function:** The objects contained in the batches processed by Batch Builder will inherit the property values (such as Aleph IDs and object owner supplied names) specified in the file (note that this file is not used for automatic object building). This file is accessed by Batch Builder during batch processing (generating the batch/xml file and the descriptor).

**Placement:** There is one object_mapping.txt file per project. It needs to be placed in `{project_dir}/_aux/template/` directory. It is read in once when the project is opened. If you created and placed the file while BB was open, you will need to restart BB so that the file can be accessed during batch processing.

**Syntax:** `object_directory_name,ALEPH_number,OBJECT_OWNER_SUPPLIED_NAME`

- Object directory name: (Required) - The name of the directory in which object is contained.
  
  E.g.: `birdsofasia`
• **Aleph id:** (Optional) - Aleph ID of the HOLLIS record where the object is described. Batch Builder imports MODS descriptive metadata from the HOLLIS record specified and places it into the object descriptor during batch processing.

• Note that there are multiple methods of passing a MODS descriptive metadata file to Batch Builder. Only one method at a time can be used.

• **Object Owner Supplied Name:** (Optional) - This property can be used to override the object Owner Supplied Name that is normally derived from object directory name. It will be applied to the object specified by in the object directory name property.

**Example 1** (specifying object directory name and aleph ID):

```
birdsofasia,005111819,
brighambulletin,006659177,
```

The extra comma at the end represents the blank value for object owner supplied name. It is required even if object owner supplied name is not specified.

**Example 2** (specifying object directory name, aleph ID and object owner supplied name):

```
birdsofasia,005111819,BA_2348
brighambulletin,006659177,BA_35559
```

In this example all three values are specified.

**Example 3** (specifying object directory name and object owner supplied name):

```
birdsofasia,,BA_2348
brighambulletin,,BA_35559
```

The extra comma in the middle represents the blank value of the aleph ID for the object. Even if aleph ID is not specified the comma delimited is required.
16. Working with URNs

16.1 Assigning URN Resource Name Patterns
16.2 Using URNs

Batch Builder by default requests public delivery service URNs for deliverable files of still image objects, document objects and text objects. For PDS document objects a public delivery URN is requested for the object itself rather than for a particular file within the object. For opaque objects no public delivery URNs are requested.

File URN authority path and URN Resource Name Pattern value can be entered in the required settings panel for each object or in the object template required setting panel (in which case the settings will propagate to all objects created from the template).

**Required settings panel – NRS section**

Additionally, for PDS Document Objects, Object URN Resource Name Pattern value can be entered in the required settings panel for each object or in the object template required setting panel (in which case the settings will propagate to all objects created from the template).
16.1 Assigning File URN Resource Name Patterns

The resource name component of the URN must be unique relative to the authority path. Batch Builder can generate all or part of the resource name automatically using mask fields that will be replaced with actual values by the system (shown in the table below).

Resource names can be composed of alpha-numeric characters (upper and lower case, although all NRS comparisons are case-insensitive) and the following punctuation characters:

( ) + , - = @ ; _ ! * ' . :

Batch Builder will use \{n\} as the default resource name mask field (\{n\} resolves to a unique number). However, Batch Builder supports additional resource name patterns that are described below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Replacement Value</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>{dd}</td>
<td>01 to 31</td>
<td>Day of the month</td>
</tr>
<tr>
<td>{hh24}</td>
<td>01 to 24</td>
<td>Current hour of day</td>
</tr>
<tr>
<td>{mm}</td>
<td>00 to 59</td>
<td>Current minute of hour</td>
</tr>
<tr>
<td>{mo}</td>
<td>01 to 12</td>
<td>Current month of year</td>
</tr>
<tr>
<td>{ss}</td>
<td>00 to 59</td>
<td>Current second of hour</td>
</tr>
<tr>
<td>{yyyy}</td>
<td>1999 to 9999</td>
<td>Current year</td>
</tr>
<tr>
<td>{n}</td>
<td>0 to 10 to the 27th power</td>
<td>Unique numeric value</td>
</tr>
<tr>
<td>{fileBaseName}</td>
<td>Name of the file excluding the file extension</td>
<td>Base name of file. Note that this mask works only in Batch Builder. It does not work if assigning URNs to existing objects in Web Admin.</td>
</tr>
<tr>
<td>{objectName}</td>
<td>Owner Supplied Name of the PDS Document Object</td>
<td>Generates URN Resource Name based on PDS Document Object Owner Supplied Name. Note that this mask works only in Batch Builder. It does not work if assigning URNs to existing objects in Web Admin.</td>
</tr>
</tbody>
</table>

Here are examples of URN masks and the resulting resource name:

urn-3:dig:{n}  -->  urn-3:dig:75
urn-3:FAL:{yyyy}-{n}  -->  urn-3:FAL:1999-76
urn-3:HCL-DIG:{yyyy}{mo}{dd}  -->  urn-3:HCL-DIG:20000103 (unique only for one file on any given day)
urn-3:HCL-DIG:{yyyy}{mo}{dd}{n}  -->  urn-3:HCL-DIG:200001032 (always unique)

16.2 Using URNs

Each URN assigned by NRS has the form:

urn-3:{authorityPath}:{resourceName}
urn-3:RAD.SCHL:1081404

where "urn-3" is the Harvard namespace identifier, \{authorityPath\} is the NRS authority path corresponding to the organizational unit responsible for the URN, and \{resourceName\} is the unique identifier for the digital file.
To make a URN actionable ( usable in a browser) for DRS 2 objects, you must append it to an NRS URL (http://nrs.harvard.edu/). The full working URL for the example URN above would be:
http://nrs.harvard.edu/urn-3:HUL.Guest:152824

New URNs are passed to the NRS name resolution server for activation. A URN requested during DRS2 batch deposit should become active within 15 minutes of successful batch deposit.

**Note for large batch deposits:** URNs sometimes don’t activate until the next day for large batches due to the processing of the batch taking more than 10 minutes (NRS update runs every 10 minutes throughout the day. If a batch takes longer than that to process in the DRS loader, there are circumstances under which the NRS update may be unable to catch the new URN transaction generated by the batch).
17. Adding Relationships

17.1 Image relationships

17.2 PDS Document object relationships

17.3 Opaque object relationships

17.4 Opaque Container object relationships

17.5 Document (PDF) object relationships

17.6 Text object relationships

17.7 Color Profile object relationships

17.8 Target object relationships

17.9 Audio object relationships

DRS models relationships between files and objects. Relationships can indicate derivative relationships between object files, how an object is structured, or associations between content.

Derivative relationships and structural relationships are automatically determined by Batch Builder based on placement of files in particular directories and on file names. Other relationships must be explicitly set by depositors, especially relationships between objects or files being processed in Batch Builder to objects or files already stored in the DRS.

Below is a list of relationships Batch Builder can create for the nine content models it currently supports.

17.1 Still image object relationships

File-to-file

HAS SOURCE -- relationships between derivative images. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.

HAS SUBSET FILE – file is the source of relationship to another file that is part of a stitched image. A DRS ID or a DRS URN of the related subset file needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

File-to-object

HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A DRS ID or a DRS URN of the color profile object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Color Profile Content Model is not supported by Batch Builder 2 yet).

HAS TARGET OBJECT – file has an associated target object in the DRS. A DRS ID or a DRS URN of the target image object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image Content Model is not supported by Batch Builder 2 yet).

HAS WORLD REFERENCE OBJECT – file has an associated world file object in the DRS (for GIS objects). A DRS ID or a DRS URN of the world file object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.2 PDS document object relationships

File-to-file

HAS SOURCE -- relationships between derivative images. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.

File-to-object

HAS COLOR PROFILE OBJECT – file has an associated color profile object in the DRS. A DRS ID or a DRS URN of the color profile object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Color Profile Content Model is not supported by Batch Builder 2 yet).

HAS TARGET OBJECT – file has an associated target object in the DRS. A DRS ID or a DRS URN of the target image object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created. (Note that the Target Image Content Model is not supported by Batch Builder 2 yet)
HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.3 Opaque object relationships

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS Object URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.4 Opaque Container object relationships

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS Object URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
HAS DOCUMENTATION OBJECT—object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT—object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.5 Document (PDF) object relationships

File-to-file

HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
17.6 Text object relationships

File-to-file

HAS SOURCE -- relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS Object URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.7 Color Profile object relationships

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS Object URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.8 Target object relationships

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE - file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION – file has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

Revised: April 14, 2015
HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

17.9 Audio object relationships

File-to-file

HAS SOURCE – relationships between derivative files. The relationship is automatically inferred by Batch Builder if a file with the same file name is present in two directories, one of which is nested inside the other.

File-to-object

HAS LICENSE – file has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – file has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS STATUTE – file has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – file has an associated documentation object in the DRS. A DRS ID or a DRS Object URN of the documentation object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

Object-to-object

HAS LICENSE – object has an associated license object in the DRS. A DRS ID or a DRS URN of the license object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS HARVARD POLICY – object has an associated Harvard Policy object in the DRS. A DRS ID or a DRS URN of the Harvard Policy object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
HAS STATUTE – object has an associated statute object in the DRS. A DRS ID or a DRS URN of the statute object needs to be entered in the directory level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS DOCUMENTATION OBJECT – object has an associated documentation object in the DRS. A DRS ID or a DRS URN of the documentation object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.

HAS METHODOLOGY OBJECT – object has an associated methodology object in the DRS. A DRS ID or a DRS Object URN of the methodology object needs to be entered in the object level metadata panel in Content Panel of Batch Builder in order for this relationship to be created.
18. Adding Descriptive Metadata

18.1 Importing an Aleph record

18.2 Entering data in the GUI

18.3 Importing from a MODS file

In DRS 2 descriptive metadata can be added to an object. It is stored in the object descriptor file. There are three ways to add descriptive metadata:

1. Have Batch Builder import descriptive metadata from an existing ALEPH record.
2. Enter descriptive metadata in the Batch Builder GUI.
3. Import descriptive metadata from a MODS file.

18.1 Importing an Aleph record

Batch Builder provides three ways of importing descriptive metadata from an existing ALEPH record:

1. Specify Aleph ID in a mapping file (see Section 15: Using External Mapping Files for more information)
2. Specify Aleph ID on command line (see Section 14: Processing Batches Using Command Line Interface for more information)
3. Enter Aleph ID in Batch Builder GUI (either in object template metadata or in object metadata). This option is described below.

To enter Aleph ID in Batch Builder GUI:

1. Obtain the Aleph ID of the record
2. In BB select the object template or the object in the Project Panel on the left
   
   (Optional shortcut) Note that if you are selecting an object, you can right click on the object and choose “Set Aleph ID” from the right click context menu. A data entry box will pop up where you can enter the Aleph ID (this doesn’t work if you are selecting object template). You can then skip steps 3 and 4 below.

3. Switch to Optional tab in the Content Panel on the right
4. Enter the Aleph ID into the field “Aleph ID for MODS import.”
Note that Aleph ID is not repeatable. Save the project before processing the batch (so that the new information is written into the BB2 configuration file).

Once the batch is processed the descriptive metadata for the object will end up in the MODS section of the object descriptor. Make sure that no other methods of entering descriptive metadata are used at the same time (e.g.: there is no MODS file as well or there is no descriptive metadata also entered in the Object Metadata fields in the BB GUI) or you will receive an error while processing a batch.

18.2 Entering descriptive metadata in the BB GUI

You can enter descriptive metadata directly in the BB GUI in the Object Metadata section in the Content panel.

In BB select the object in the Project Panel on the left; switch to Optional tab in the Content Panel on the right, and enter the descriptive metadata into the fields in the Object Metadata section. The descriptive metadata is expected in MODS 3.5 format and the fields in the GUI follow MODS 3.5. MODS 3.4 and earlier is versions of MODS 3.x s are also accepted.

To look up MODS 3.5 fields definitions see: http://www.loc.gov/standards/mods/mods-outline-3-5.html

18.3 Importing descriptive metadata from a MODS file

Rules for importing a MODS file

Descriptive metadata for an object can be imported from a locally supplied MODS file. BB expects the MODS to be valid MODS 3.5 XML or earlier. Note that MODS 3.6 is not yet supported. There should be one MODS XML file per object being described. Descriptions of multiple objects cannot be supplied in the same MODS file. Each MODS file can contain only one set of descriptive metadata for an object – e.g.: a collection-level record and an object-level record cannot be part of the same MODS file for the same object.

File Name: `{obj_name}_mods.xml` – where `{obj_name}` is OSN.

Format: Valid MODS version 3.5 or earlier XML file

Note that MODS 3.6 is not yet supported by DRS2.

Placement:

For use while automatically creating a batch place the file in `{project_dir}/_aux/template/` directory.

Note that the file placed into `{project_dir}/_aux/template/` directory will be moved to the corresponding `_aux` directory for the object `_aux/{batch_name}/{object_name}` after the object
batch is built. The MODS file will be accessed by BB during batch processing (when batch.xml and object descriptor is created).

For use during with manually creating a batch place the file in
{project_dir}/_aux/{batch_name}/{object_name}/ directory
The MODS file will be accessed by BB during batch processing (when batch.xml and object descriptor is created).

Examples of valid MODS 3.x XML files
http://www.loc.gov/standards/mods/mods-guidance.html

Procedure for importing a MODS file

Extracting MODS from HOLLIS or VIA using PRESTO
If there is cataloging for an object in HOLLIS or VIA, you can use PRESTO to extract a MODS version of the record. Since metadata extracted with PRESTO conforms to MODS version 3.5, the MODS file will be accepted as-is by the DRS2 batch loader without additional changes.

1. Identify the ID of the record you want to extract.
2. Construct a PRESTO request url for the record:
   - For HOLLIS: http://webservices.lib.harvard.edu/rest/mods/hollis/{record_id_goes_here}
   - For VIA: http://webservices.lib.harvard.edu/rest/mods/via/{record_id_goes_here}
3. Paste the PRESTO request url into a browser. The MODS XML file for the record will display. If you don't see the XML, view source.
4. Use the browser's "Save As" option to save the xml file to a local directory.
5. Before using the file in Batch Builder, you must rename it to "{obj_name}_mods.xml" – where {obj_name} is the object's owner supplied name (OSN).

Note about VIA: A PRESTO request for VIA will return the record with all components (e.g., a work plus all surrogates). Typically, what you need for object-level description in DRS2 is an individual surrogate description. Before inserting a VIA MODS file into your batch, you may need to edit the file to remove surrogate descriptions that do not apply to the object you are depositing.

Full details about using PRESTO are available in the PRESTO Data Lookup User Guide (http://hul.harvard.edu/ois/systems/webservices/lookup-userguide/).

Creating MODS from scratch using a template
It is easiest to create a MODS file from scratch by starting with a valid MODS template and inserting your descriptions. You can use a MODS full record example from the Library of Congress MODS website: http://www.loc.gov/standards/mods/mods-guidance.html.

1. Create a text file called "{obj_name}_mods.xml" – where {obj_name} is the object's owner supplied name (OSN).
3. Copy the entire LC MODS record and paste into your local MODS file.
4. Add descriptions to the template as needed. Remove elements that are not needed.
5. Save the file.

**Adding a MODS file to the batch**

1. If using the manual object workflow:
   a. Create the batch with objects (Step 5 in the batch procedure). This will generate batch directory structure on disk.
   b. Copy the MODS file into the object directory inside the BB project's auxiliary (_aux) path:
      
      `{project_dir}/_aux/{batch_name}/{object_name}/`

      If you have MODS files for multiple objects in a batch, do the same for each.
   c. Continue with your batch procedure.

2. If using the automatic object workflow:
   a. Add directories to the template and copy content files into those directories (Steps 4-5 in the batch procedure).
   b. Place the MODS file into the template directory in the BB project's auxiliary (_aux) path:
      
      `{project_dir}/_aux/template/`

      If you have MODS files for multiple objects in a batch, place all of them in the template directory.
   c. Continue with your batch procedure.

3. When BB processes the batch, an INFO message displays in the message panel when the MODS file is discovered, e.g.:

   INFO – Imported XML from object-skating_mods.xml
19. Adding Supporting Content

19.1 Depositing supporting content before regular content

19.2 Depositing supporting content together with regular content

19.3 Deposit supporting content after regular content

19.4 Valid content models and roles for rights objects

Overview

In DRS 2, supporting content such as licenses, statutes, risk assessments, Harvard policy, donor agreements, embargo documentation, project documentation, finding aids, thesis certificates, thesis supplements, project methodologies etc., can be deposited along with the regular content and linked to from the regular content. There are three methods for linking regular content to supporting content:

- Deposit supporting content to DRS first, in a separate batch.
  - After supported content is deposited, the supporting object URN, DRS ID, or Object Owner Supplied Name can be used to link it to the regular content. Use the corresponding relationships fields in Batch Builder to link regular objects to supporting content when creating a regular content batch.

- Deposit supporting content to DRS together with regular content with both types of objects being in the same Batch Builder batch.
  - In this case, Object Owner Supplied Name rather than Object URN is used for linking. If placing supporting content and regular content in the same batch, make sure that the supporting objects (the targets of the relationships) are named in such a way that the Object Owner Supplied Name of the supporting object occurs alphabetically before the Object Owner Supplied Name of the object with regular content that is linking to it (the source of the relationship). This is needed because in order for the relationship to be created correctly, the supporting object needs to be ingested into DRS before the regular object.

- Deposit supporting content to DRS after regular content.
  - If depositing supported content after the regular content objects have been deposited to DRS, the relationships between the supporting content objects and regular content objects will need to be created in DRS Web Admin after both types of objects have been deposited. This option is not currently recommended for large volume workflows.

19.1 Depositing supporting content into the DRS before regular content

1. Follow the batch creation procedure in this guide for one of the following DRS content models:
   - Still Image (valid for all rights and supporting documentation objects except THESIS_CERTIFICATE, EMBARGO_DOCUMENTATION and Methodology objects)
   - Document (valid for all rights and supporting documentation objects except Methodology objects)
   - Text (valid for all rights and supporting documentation roles except THESIS_CERTIFICATE and thesis EMBARGO_DOCUMENTATION objects)
   - Audio (only valid for depositing thesis supplements with role “THESIS_SUPPLEMENT” to link to Theses)
   - Opaque (only valid for depositing thesis supplements with role “THESIS_SUPPLEMENT” to link to Theses)
2. **Choose one of the following roles for your supporting objects:**
   - For methodology objects, other project-level documentation such as workflow descriptions, objects documenting reasons for storage restrictions, delivery restrictions and embargos (excluding theses and dissertations embargo documents):
     - Choose role DOCUMENTATION
   - For theses and dissertations embargo documents:
     - Choose role EMBARGO_DOCUMENTATION
   - For theses and dissertations supplements:
     - Choose role THESIS_SUPPLEMENT
   - For theses and dissertations certificates:
     - Choose role THESIS_CERTIFICATE
   - For donor agreements:
     - Choose role DONOR_AGREEMENT
   - For non-OASIS finding aids:
     - Choose role FINDING_AID
   - For Harvard policy documents:
     - Choose role HARVARD_POLICY
   - For license documents:
     - Choose role LICENSE
   - For statute documents:
     - Choose role STATUTE
   - For risk assessment documents:
     - Choose role RISK_ASSESSMENT

3. **Process the supporting content batch and deposit it to the DRS**
4. **Get the object URN from the batch report** (the URN starts with “urn-3:HUL.DRS.OBJECT”).
5. **In Batch Builder project for main content, enter the supporting object URN(s) into the relevant relationship fields**
   - Do this for each individual object in your batch if there are different supporting objects for each main object
   - Do this in object template if the relationships are the same for all objects in the project
6. **Depending on the relationship you need to create enter the following information:**
   - Embargo Rights – Documentation object URN (Embargo Rights block in Content Panel under the Optional tab). Note that Basis value is required when entering the object URN for embargo Documentation object.
     - Select this to link to an object in DRS describing embargo terms
   - Harvard Policy (Other Rights Documentation block in Content Panel under the Optional tab)
Select this to link to an object in DRS that records Harvard Policy
- License (Other Rights Documentation block in Content Panel under the Optional tab)
  - Select this to link to licenses and donor agreements in DRS
- Statute (Other Rights Documentation block in Content Panel under the Optional tab)
  - Select this to link to government statutes in DRS
- Has Documentation (in the Content Panel under the Optional tab)
  - Select this to link to project documentation objects in DRS
- Has Methodology (in the Content Panel under the Optional tab) – methodology object can only be deposited as Content Model “Text.”
  - Select this to link to project methodology objects in DRS
- Has Supplement Object (in the Content Panel under the Optional tab) – for theses only
  - Select this to link to thesis supplement objects in DRS

7. Process your batch and deposit it to the DRS
8. Your objects are now linked to the supporting content

19.2 Depositing supporting content into the DRS together with regular content

When depositing supporting content and regular content in the same Batch Builder batch, the Object Owner Supplied Name rather than Object URN of the supporting content is used for linking regular objects to supporting objects.

1. Create batch that includes regular objects and supporting objects
2. Set file roles for your main content as documented in content model procedures (still image, document, PDS document, etc.)
3. Choose one of the following roles for your supporting objects (The object roles are located in the Batch Builder Content Panel under optional metadata)
   - DOCUMENTATION (select this role for methodology objects, other project-level documentation such as workflow descriptions, objects documenting reasons for storage restrictions, delivery restrictions and embargos)
   - DONOR_AGREEMENT (select this role for rights objects that are donor agreements)
   - EMBARGO_DOCUMENTATION (select this role if depositing an embargo documentation object to link with a thesis)
   - FINDING_AID (select this role for non-OASIS finding aids)
   - HARVARD_POLICY (select this role for rights objects that represent Harvard policy)
   - LICENSE (select this role for rights objects of a type “license”)
   - RISK_ASSESSMENT (select this role for rights objects of a type “risk assessment”)
   - STATUTE (select this role for rights objects of a type “statute”)
   - THESIS_SUPPLEMENT (select this role if depositing a thesis supplement to link with a thesis)
4. **Make sure that the Object Owner Supplied Name of each supporting object** (the target of the relationships) **occurs alphabetically before the Object Owner Supplied Name of the main content object to which it is related** (the source of the relationship).

This is needed because in order for the relationship to be created correctly, the supporting object needs to be ingested into DRS before the regular object and the objects are inserted into batch.xml in alphabetical order.

5. **Enter supporting Object Owner Supplied Names** (as displayed in Project Panel in Batch Builder) **in the following fields in the affiliated regular content objects:**
   - Has Documentation (in the Content Panel under the Optional tab)
   - Has Methodology (in the Content Panel under the Optional tab) – methodology object can only be deposited as Content Model “Text.”
   - Has Supplement Object (in the Content Panel under the Optional tab) – for theses only

6. Process your batch and deposit it to the DRS.
7. You objects are now linked to the supporting content.
8. Deposit supporting content to DRS after regular content.

**19.3 Depositing supporting content to DRS after regular content**

If depositing supported content after the regular content has been deposited to DRS, the relationships between the supporting content objects and regular content objects will need to be created in DRS Web Admin after both types of objects have been deposited. See [section on editing relationship metadata](#) in Web Admin User Guide for instructions. This option is not currently recommended for large volume workflows as relationships in Web Admin can be added only one-at-a-time at present.

**19.4 Valid content models and roles for rights objects**

For any rights objects such as documentation for storage restrictions, delivery restrictions and embargoes as well as donor agreements, Harvard policies, licenses, risk assessments and statutes, an appropriate object role is required.

The following roles apply to rights objects:

“STATUTE,” “LICENSE,” “DONOR AGREEMENT,” “HARVARD POLICY,” “RISK ASSESSMENT,” “EMBARGO DOCUMENTATION,” “DOCUMENTATION.”

The following rights object roles can be assigned based on content models:

- Document object rights roles:
  - Object (may have one or more of the following roles)
    - DOCUMENTATION
    - DONOR AGREEMENT
    - EMBARGO DOCUMENTATION
    - HARVARD POLICY
    - LICENSE
• RISK_ASSESSMENT
• STATUTE

Still Image object rights roles:
  - Object (may have one or more of the following roles)
    - DOCUMENTATION
    - DONOR_AGREEMENT
    - HARVARD_POLICY
    - LICENSE
    - RISK_ASSESSMENT
    - STATUTE

Text object rights roles:
  - Object (may have one or more of the following)
    - DOCUMENTATION
    - DONOR_AGREEMENT
    - HARVARD_POLICY
    - LICENSE
    - RISK_ASSESSMENT
    - STATUTE

When the appropriate role is not specified for the rights objects, the DRS deposit of supporting content will not fail but you will be unable to see the reference to the rights object in rights section of your main object metadata. You will also be unable to add a rights relationship to the rights object in Web Admin.

In the future, validation or rights objects’ roles and rights relationship references on ingest will prevent you from depositing a rights objects without valid roles specified. Currently, the depositor should make sure the role is set correctly before deposit, as ingest validation for rights object roles has not yet been implemented.
20. Uploading Batches to DRS

Batches are loaded to DRS 2 in the same way as in DRS 1.

1. Log on to your DRS 2 SFTP drop box and drag and drop the whole batch directory (the one that has the file `batch.xml` and object directories in it) that BB processed into the “incoming” directory in the dropbox.

2. Disconnect from the drop box to kick-off batch processing.

3. Once the batch is processed you will get a successful load batch report or an error report in the email.

The path to the DRS 2 drop box is: `drs2drop.lib.harvard.edu`.

Access to production DRS 2 drop boxes is provided after a consultation with LTS. Please see Transitioning to the new DRS for more information about getting started.
21. Deleting Batches from DRS

Batches of objects deposited to DRS can be deleted from DRS by a user with a role `content_editor` and permissions to operate in the relevant DRS Owner Code. Batch deletions are performed in DRS Web Admin. Individual objects and files can be also deleted in DRS Web Admin. See Section 5: Managing Content of the DRS Web Admin User Guide for more information. This section describes only batch deletions as these are most relevant to batch deposits.

To delete a batch from DRS, log in to Web Admin: [http://nrs.harvard.edu/urn-3:hul:drs2-admin](http://nrs.harvard.edu/urn-3:hul:drs2-admin). Find your batch using quick search or custom search, and, once you are viewing the batch summary page, click on the “delete this batch” link (if a batch has been deposited over 5 days ago the link will say “request deletion of this batch”).

When batches are deleted, a reason for deletion should always be entered:

When batches are deleted within 5 days of deposit, the deletion is performed automatically once the “delete this batch” link is clicked. The batch summary page displays the “deleted” banner after deletion request is accepted.

**Batch: 17001 (deleted)**
If more than 5 days elapsed since original batch deposit, after a user clicks on “request deletion of this batch” link, the deletion request is forwarded to the DRS content manager for review.

Once the batch is deleted, Object Owner Supplied Names of all objects within the batch are changed according to the following pattern:

\{object_osn\} is changed to \{object_osn\} [deleted_{DRSID}].

For instance, once an object with object OSN ‘obj1’ and DRS ID ‘400000001’ is deleted, the object OSN is changed from ‘obj1’ to ‘obj1 [deleted_400000001]’. The **changed object OSN clearly marks the object as deleted and** allows a depositor to redeposit the same batch without running into the duplicate Object OSN errors on deposit.

When a deleted object is restored, the suffix “[deleted_{DRSID}]” is automatically removed from object OSN. If an object with this OSN already exists (for example, someone deleted an object and then loaded an object with the same object OSN), the object restore function will display a duplicate object OSN error.

Once the batch is deleted it cannot be “undeleted.” Individual objects within the batch can be restored within 60 days of deletion. If all objects within a batch are restored, the batch automatically becomes “undeleted” and the “deleted” banner is removed from the batch summary screen.
22. Interpreting Load Reports

22.1 Successful load reports

Reports of successfully processed batches will be sent to a designated email address or written to the dropbox (or both), based on preferences specified by the <successEmail> and <successMethod> elements in the batch.xml.

- **If delivered by email**, the load report message:
  - Will have a Subject line containing the following information:
    - Subject: DRS LOAD REPORT (owner:{owner_code}, batch dir:{batch_directory_name}, batch:{batch_name} [DB:{batch_id}])
  - Will contain the following sections:
    - Batch Summary
    - File listing
    - File listing text file (attachment)

- **If written to the dropbox**, the load report text file:
  - Will be located in the top-level batch directory with a file name that conforms to the following pattern: LOADREPORT_{batch directory name}.
  - Will contain these sections:
    - Batch Summary
    - File listing

Remember that object descriptor files (descriptor.xml) are part of each batch in DRS2. For every object in the batch there will be a corresponding descriptor file and these files will be included in the load report summary and file listing.

About the batch summary

The **batch summary** section includes summary information about the batch. Contents of this section include:

- Batch directory name
- Batch name
- Depositor
- Batch id
- Owner(s)
- Batch drop off time
• Time waiting to start load
• Loading start time
• Loading end time
• Total load time
• Number of objects deposited
• Number of files deposited
• Batch size
• Number of objects per object type
• Number of files per format

Sample summary for still image object batch
Sample summary for page-turned (PDS) object batch

**About the file listing**

Following the batch summary section, the report lists metadata for each file in the batch, including any object descriptor files (descriptor.xml). The data in this section is tab-delimited, with these metadata headings at the top:

- **OBJ-ID**: DRS ID of the object associated with this file.
- **OBJ-DELIV-URN**: Delivery URN of the object (only PDS Objects have delivery URNs)
- **OBJ-URN**: DRS URN (an alternative internal identifier to DRS ID) of the object associated with this file
- **DEPOSITOR**: First and Last name of depositor responsible for this batch.
- **OBJ-OSN**: Owner supplied name of the object associated with this file.
- **BILLING**: Billing code for this file.
- **OWNER**: Owner code for this file.
- **OBJ-TYPE**: The content model identifier and name (e.g., "STILL IMAGE") for the associated object.
- **OBJ-ROLES**: Lists object roles for each object, if any were specified.
- **FILE-ID**: DRS ID of the file.
- **FILE-URN**: Delivery URN of the file.
- **FILE-FORMAT**: Format of the file.
- **FILE-SIZE**: Byte-size of the file.
• FILE-OSN: Owner supplied name of the file.
• FILE-ORIGPATH: Directory path of the file in the batch.

**Tips and tricks**

**Working with the file list.** Entries in the file list are arranged in the order files were ingested by the loader. If you find it difficult to locate a particular file in the file list, best practice is to import the listing into an application that can sort tabular data, such as MS Excel (if working with the emailed report, import the attachment into MS Excel or another spreadsheet software). In Excel, if you sort by the FILE-ID column, rows associated with a single object will sort together. For page-turned object batches, sorting this way should push the METS file to top of the listing.

### 22.2 Failure load reports

If any errors are detected during a load, the entire batch is rejected and an error report is sent to the email addresses in the `<failureEmail>` element of the batch.xml document. The error message will include dropbox name, batch directory, and batch name along with a message describing the cause of the failure.

All the digital files associated with an error batch are left in the depositor's batch directory, while the batch.xml file and the LOADING file are deleted. To retry the batch, update any corrupt or missing digital files and upload the new batch.xml file. After you disconnect from the SFTP session, your batch will be queued for reloading.

Below are some common batch loader error scenarios and messages:

1. **Error in batch.xml header:** Errors in the header of the batch.xml file can cause processing to fail before the loader can read the failure email addresses. In this case, the loader will report the error only to DRS staff in LTS. If you submit a batch but receive no load report or error, send a message to the DRS2 team in LTS using this form:
   [http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help](http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help).

2. **Couldn't find billing code for id {billing code}**
   Sample: Type of problem: Couldn't find billing code for id HBS.BAKR.KRESS_001
   Cause: The specified billing code is invalid. Correct the billing code in Batch Builder and regenerate the batch.

3. **Owner supplied name {OSN} already exists for owner code {owner code}**
   Sample: Type of problem: Owner supplied name 'randy-pdsobject7' already exists for owner code HUL.TEST
   Cause: The specified owner supplied name has already been defined within the specified owner code. Correct the OSN in Batch Builder and regenerate the batch.

4. **An unexpected problem occurred processing batch {batch ID}**
   Sample: An unexpected problem occurred processing batch 8004. If this problem persists, please contact drs-support@hulmail.harvard.edu, forwarding the entire contents of this message.
   Cause: This error usually indicates an internal DRS issue rather than an error in the batch. In many cases, reloading the same batch will be successful. But if the problem persists, send a message to the DRS2 team in LTS using this form:
   [http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help](http://nrs.harvard.edu/urn-3:HUL.OIS:drs2help).

5. **Object descriptor {path to descriptor.xml} not found**
Sample: Type of problem: Object descriptor
/drs2dev/dropboxes/ois2dev/incoming/DefectiveDescriptorBatch/DontRegenerateTheDescriptor/descriptor.xml not found

Cause: The specified object descriptor file was expected by the loader but not found. Upload the missing descriptor file and the batch.xml file and disconnect from the dropbox.

6. MD5 checksum mismatch for descriptor {path to descriptor.xml}

Sample: Type of problem: MD5 checksum mismatch for descriptor file
/drs2dev/dropboxes/ois2dev/incoming/BadDescriptorChecksum/DontRebuildTheDescriptor/descriptor.xml, services reported 22B5A77B581CCFFE908E535795CDA06A

Cause: MD5 checksum calculated by DRS services does not match the checksum supplied in the batch.

7. File not found: {path to file}

Sample: Type of problem: File not found:
/drs2dev/dropboxes/ois2dev/incoming/MissingDataFile/WhatISaidBefore/image/beethoven3.jpg

Cause: The specified file could not be found in the batch. Upload the missing file, re-upload batch.xml, then disconnect from the dropbox.

8. Batch directory {directory path} contains no objects

Sample: Type of problem: Batch directory
/drs2dev/dropboxes/ois2dev/incoming/DefectiveBatchDotXML contains no objects

Cause: The specified directory is missing from the batch. Re-process in Batch Builder and upload the new batch to the dropbox.

9. Descriptor file failed XML schema validation: {... }

Sample: Type of problem: Descriptor file failed XML schema validation: cvc-complex-type.2.4.a: Invalid content was found starting with element 'amdSecXXXXXXXXXXXXX'. One of '
"http://www.loc.gov/METS/"':metsHdr, "http://www.loc.gov/METS/"':dmdSec,
"http://www.loc.gov/METS/"':amdSec, "http://www.loc.gov/METS/"':fileSec,
"http://www.loc.gov/METS/"':structMap' is expected.

Cause: The specified descriptor.xml file failed schema validation due to invalid content. Re-process in Batch Builder and upload the new batch to the dropbox.

10. Could not parse batch.xml

Sample: Type of problem: Could not parse batch.xml

Cause: This error condition indicates xml in the batch file is not well formed and is usually related to bad character data. Revise the file and upload again.
23. Viewing Your Deposited Objects

In Web Admin

Use Firefox or Chrome web browsers. Internet Explorer is currently not supported.

1. Connect to DRS 2 WebAdmin:
   http://nrs.harvard.edu/urn-3:hul:drs2-admin

2. Enter the object ID from the emailed batch report into the Quick Search field and click on the Quick Search button.

3. Click on the object ID in the search results.

4. You will see an object view page with summarized information about your object.

5. View files in your objects by clicking on files IDs within the file listing table at the bottom of the screen.

For more instructions on searching Web Admin please consult the DRS 2 WebAdmin User Guide.

In DRS public delivery systems

You can view deliverable files from your deposited DRS 2 objects and PDS objects deposited to DRS 2 using the following DRS Delivery Services: IDS, PDS, FDS and SDS (audio streaming delivery). Still Image files are delivered by IDS; PDS Document objects are delivered by PDS; Document files (PDFs), plain text, xml, sgml files and downloadable audio files are delivered by FDS. Streaming Audio files are delivered by SDS. The URNs created by Batch Builder 2 resolve in NRS.

Use the following URLs to view your DRS2 objects:

- To view Still Images in IDS: http://ids.lib.harvard.edu/ids/view/[file_id]
  E.g.: http://ids.lib.harvard.edu/ids/view/1166538

- To view PDS Document objects in PDS: http://pds.lib.harvard.edu/pds/view/[object_id]
  E.g.: http://pds.lib.harvard.edu/pds/view/23010723

To view Document files (PDFs), plain text, xml, sgml and downloadable audio files in FDS:
http://fds.lib.harvard.edu/fds/deliver/[file_id]
E.g.: http://fds.lib.harvard.edu/fds/deliver/13768034

- To view Audio objects in SDS:
  http://sds.lib.harvard.edu/sds/audio/[file_id]
  E.g.: http://sds.lib.harvard.edu/sds/audio/393563

- To view objects using URNs:
  http://nrs.harvard.edu/urn-3:[nrs_authority_path]:[resource_name]
  E.g.: http://nrs.harvard.edu/urn-3:fhcl:loeb:sa14
24. DRS2 Metadata Reference

The full DRS2 Metadata Reference is available in a separate PDF document at this URL: http://hul.harvard.edu/ois/systems/drs/docs/drs2-metadata-reference.pdf